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Revision History

Product |Manual Changes Remarks

version

1.00.xx  |BA017S/04/en/07.02 |Original manual

2.01.xx |BA017S/04/en/11.05 |Complete revision m Software renamed Application Designer

s FOUNDATION Fieldbus operation essential
unchanged, but with additional functions

= PROFIBUS components and operation added

m [EC 61131 hybrid function block programming
added

2.01.xx |BA0175/04/en/03.06 |2.01.xx SP1

No changes, "official" launch with release

2.02.xx |BA017S/04/en/07.06 |Program

FB schedule configured by drag&drop
(Chap 5.4.7,5.5.8,5.7.8)
Incremental download now active
(Chap 5.1.5-5.1.9)

Editorial Update Version and documentation tables

2.03.xx |BA017S/04/en/06.07 |Project File m Pack&Go deleted, Workspace Layout configurable
New Project Packing and Unpacking procedures

Communication Multiple assignment of tags with Assign All Tags

Backup LAS set with Configure Device Class

Project management Device exchange procedures improved
HSE Netwok Setup tool added
Field Controller Web Server added

New Version of FC Tools for firmware download

2.04.xx |BA017S/04/en/12.08 |Project management New alaising function implemented

Copy & paste of project structures

Drawing tool m Drawing tool description added
1/0 Mapping Tool = [/O mapping tool dialogues added
2.05.xx |BA017S/04/en/06.10 |Modbus m Master-slave can be configured and mapped
Upload m Device parameters can now be uploaded online
m Uploaded parameters can be shown or hidden
Web Server m Revised Web server described, Chapter 6.8
Visitor m SFC162 can be used as visitor (with FieldCare)

Product Version

Details of product version and the individual components of Application Designer Suite can be seen
in the About ControlCare dialog:

Start=>Programs=>Endress+Hauser=>ControlCare=>Tools=>About ControlCare

Registered Trademarks

PROFIBUS®
Registered trademark of the PROFIBUS User Organisation, Karlsruhe Germany.

FOUNDATION™ Fieldbus
Trademark of the Fieldbus Foundation, Austin, TX 78759, USA

Microsoft®, Windows®, Windows 2000% ,Windows XP®, Windows 2003 Server®, Windows
2008 Server®,Windows 7®, Windows Vista® and the Microsoft logo are registered trademarks of
the Microsoft Corporation.

Acrobat Reader® is a registered trade mark of the Adobe Systems Incorporated.

All other brand and product names are trademarks or registered trademarks of the companies and
organisations in question
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ControlCare Application
Designer

Technical improvement

Endress+Hauser

1 Safety

1.1  Designated use

ControlCare is a field-based control system comprising hardware and software components. It can
be used to visualize, monitor and control production processes. The approved usage of the
individual units that comprise the system can be taken from the appropriate operating instructions.

ControlCare Application Designer allows the engineering, configuring, commissioning and set-up
of a ControlCare field-based control system comprising SFC162 FOUNDATION Fieldbus and/or
SFC173 PROFIBUS Field Controller together with the associated field instrumentation. It allows
control strategies to be created for FOUNDATION Fieldbus and PROFIBUS 1/O applications using
FF function blocks and the programming of hybrid function blocks with IEC 61131-3 programming
languages.

This manual provides a functional description of the program only. Workflows and practical
examples for the the engineering of FOUNDATION Fieldbus, PROFIBUS, Modbus projects as well
as for the programming of hybrid function blocks are to be found in the appropriate tutorial, see
Table 1.1 in Chapter 1.4,

1.2  Operational Safety

The control system hardware must be installed according to the instructions in the hardware and
device manuals, taking into account all precautions regarding location, operation in hazardous
areas, EMC etc..

[t is recommended that ControlCare Field Controllers and OPC servers are not installed in an office
network, as the large data packets exchanged between office equipment may lead to timeouts and
intermittent communication errors. Ideally, the ControlCare system network should operate within
its own IP domain; if this is not possible it should be separated from other parts of the network by
a managed switch.

Since the system can be accessed and manipulated through ControlCare Application Designer, it is
essential that the persons using the tool are authorised, suitably qualified and fully trained in its use.
[t is also advisable to control access to both the workstation and the folders in which the
configuration is stored. Always make a back-up of the project folder.

Endress+Hauser reserves the right to make technical improvements to ControlCare Application
Designer at any time and without prior notification. Software improvements not relevant to
operation are issued as a Service Pack - the documentation is not changed. If the improvements
effect operation, the product version is incremented at the first or second position. In both cases, a
new version of the operating instructions issued. The product version is to be found on the front
cover of the manual and the changes are recorded in the Revision Index.
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Safety conventions

1.3 Conventions and icons

In order to highlight safety relevant or alternative operating procedures in the manual, the following
conventions have been used, each indicated by a corresponding icon in the margin.

Icon Meaning

>

A note highlights actions or procedures which, if not performed correctly, may indirectly affect operation or
may lead to an instrument response which is not planned

Caution!
Caution highlights actions or procedures which, if not performed correctly, may lead to personal injury or
incorrect functioning of the instrument

Warning!
A warning highlights actions or procedures which, if not performed correctly, will lead to personal injury, a
safety hazard or destruction of the instrument

1.4 ControlCare documents

Table 1.1 indicates the documents, planned and realized, containing safety relevant information,
installation, commissioning and operating instructions for the equipment and software associated
with ControlCare.

All documentation available at the time of release is included on the ControlCare CD-ROM and is

installed in Start=>Programs=>Endress+Hauser=ControlCare=Manuals during set-up.

Component Description Document type |Designation Order No.
System ControlCare System Overview Operating manual |BA016S/04/en 56004883
ControlCare System Design Operating manual |BA039S/04/en |Planned
ControlCare System Specifications Operating manual |BA040S/04/en 56004888
Software Application Designer Overview Operating manual |BA017S/04/en 70104301
Application Designer: Local 1/0O Tutorial Operating manual |BA032S/04/en |71095009
Application Designer: FF Tutorial Operating manual |BA019S/04/en |70101151
Application Designer: PROFIBUS Tutorial | Operating manual |BA036S/04/en |70101152
Application Designer: MODBUS Tutorial Operating manual |BA037S/04/en |70101153
Application Designer: [EC 61131-3 Operating manual |BA038S/04/en |70101386
Ladder Logic Tutorial
Application Designer: [EC 61131-3 Operating manual |BA056S/04/en |71060063
Structured Text Tutorial
Field Control (OPC) Servers Operating manual |BA018S/04/en |71031428
SFC162 Visitor Operation manual |BA069S/04/en |71113457
Field Controller |Hardware Installation Guide Operating manual |BA021S/04/en |56004885
Commissioning and Configuration Operating manual |BA035S/04/en |56004887
Function Blocks | Function Block Manual Operating manual |BA022S/04/en |56004886
Set-Up Getting Started Operating manual |BA020S/04/en |56004884
General FOUNDATION Fieldbus Guidelines Operating manual |BA013S/04/en |70100707
PROFIBUS Guidelines Operating manual |BA034S/04/en 56004242
726, /-7 ControlCare Docunmeniation
Endress+Hauser
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2 Getting Started

2.1 Introduction

ControlCare Application Designer allows the engineering, configuring, commissioning and set-up
of a ControlCare field-based control system comprising SFC162 FOUNDATION Fieldbus and/or
SFC173 PROFIBUS Field Controller together with the associated field instrumentation.

ControlCare Application Designer runs on a number of different Windows versions, see
Chapter 2.2, System Requirements:

® You need to have administrator rights for the installation.

m Application Designer Suite operates with a license protection key. Any licence keys already
used on your computer should be unplugged before the software is installed.

m Download and Online operation procedures require an Ethernet connection between your
computer and the Field Controller SFC162 and/or SFC173.

2.2 System requirements

Operation system |= Windows 2000, Windows XP, Windows Server 2003, Windows Server 2008, Windows 7
and Windows Vista

See Setup program and/or manufacturers instructions for tested service packs

Hardware Processor Type Pentium IV or better, 500 MHz

(recommended) = Main Memory (RAM) 256 MB RAM

Hard-disk (HDD) Capacity |40 GB IDE or Higher,

310 MB free space on the installation directory

300 MB on the system drive

40 MB temporarily in the TEMP folder

= Recommended Monitor 21", SVGA

= Monitor Resolution 1280 x 1024, 64k colours
m Data Updating Cycle 1sec-2sec

u CD-ROM Drive CD-RW 40x/10x/40-IDE

2.3 Installing ControlCare Application Designher

Install ControlCare Application Designer and the associated programs and manuals in accordance
with the instructions in:

m BA020S/04/en: Getting Started or
m BA035S/04/en: Field Controller, Commissioning and Configuration

After successful installation and insertion of the hard key supplied with the software, the program
is started either with the icon on the desktop or from the Start button of Windows, see Fig. 2-1.
Application designer opens with a empty workspace.

If you have no hard key the program runs in demo mode, having full capability but a limited project
size.

% Windows Update @@ Endress+Hauser are » @ Tools »
Microsoft Excel 3 @ Manuals »
[ Fieldbus Foundation v ControlCare Application Designer
Sl ) infoteam OpenPCS 2004 »
a Hogenodat e [T Internet Explorer »
@ RoboHelp Office 3

r“ Programs

¥

Fig. 2-1: Starting Application Designer from the Windows Start button
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2.4  Program suite

2.4.1 ControlCare Application Designer

ControlCare Application Designer allows you to engineer and configure a project off-line, go on-
line, download to a Field Controller and devices as well as to commission, operate and optimise the
system. A project comprises three main components:

m The physical project, or fieldbus view, which maps the "hardware" used in the project, e.g. host
computer, Field Controller, local or remote [/O, measuring instruments and actuators.
For ease of handling, the fieldbus network expands into a HSE network and one or more
Fieldbus and/or Profibus networks

m The logical project or plant view, which is structured according to the ISA S88 model and
devides the plant into areas, process cells and control modules (loops). For ease of handling, the
plant network expands into one or more process cells, each with one or more control modules

m The control strategy, which contains the function blocks and links required to perform the
desired control function. Each control module has its own control strategy, which is
programmed in its own window.

The complete project is contained within a single navigation tree, which is always the starting point
when a project is opened or created.

A project can be engineered from different starting points. For example, it is possible to engineer the
physical project first, creating fieldbus segments, devices and function blocks, then to attach the
function blocks to the logical project in the control strategy window. Alternatively, the logical
project including the control strategy can be created first: the physical project is then created and
the function blocks (previously created in the logical part) are attached afterwards to the Field
Controller and field devices.

When complete, the entire project is downloaded to the Field Controller SFC162 or SFC173. At
this stage the virtual devices in the offline project are connected to their real counterparts in the
plant, and the application is started up. Application Designer can now be used to optimise the
project on-line or to intervene in the process, e.g. by changing setpoints and other parameters.

2.4.2 ControlCare PROFIBUS Configurator

ControlCare PROFIBUS Configurator is an auxiliary program that is invoked from the network view
of a PROFIBUS project. It allows the configuration of the cyclic communication parameters and tags
of virtual PROFIBUS devices connected to the SFC173 PROFIBUS Field Controller. The program
then maps the information into PROFIBUS function blocks, which can then be used to build control
strategies in the normal way. The resulting off-line application is downloaded to the SFC173
controller and the cyclic data is configured in the connected PROFIBUS devices.

More information on ControlCare PROFIBUS Configurator is to be found in the Application
Designer PROFIBUS Tutorial, BAO36S/04/en.

2.4.3 OpenPCS

OpenPCS is an auxiliary program that is called from any hybrid function block created within
ControlCare Application Designer. It allows the programming of the function block in any of the
standard programming languages of IEC 61131-3. This very powerful tool allows logical control
sequences and interlocking to be added to the continuous and discrete control possibilies of standard
FOUNDATION Fieldbus function blocks. The resulting hybrid function blocks can then be used to
build control strategies in the normal way.

More information on OpenPCS is to be found in the Application Designer IEC 61131-3 Tutorial,
BA038S/04/en.

Endress+Hauser
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2.5 User interface

ControlCare Application Designer uses the latest Windows technology to provide simple operation
of the software. In many cases, functions can be called by menu, context menu (right-click on a
program object), double-clicks or a button on the toolbar.

Note!

m ControlCare Application Designer includes a complete tool for drawing control strategies. This is
described in detail in ControlCare Application Designer: Drawing Tool, BA022S/04/en.

2.5.1 Workspace

When you work with the program you will be concerned with six basic elements:

= The menu bar, in which the main menus are called, and which may change according to the
window you are working in.

m The toolbar, which may change according to the window you are working in

m The project window or view, which shows the entire topology of the project

m The process cell window or plant view, which shows the logical project

m The fieldbus window or view, which shows the physical project. Separate windows open for
the HSE network and the each Fieldbus (PROFIBUS DP and/or FOUNDATION Fieldbus H1)

m The control module/strategy window or view, which allows you to build a control strategy by
creating and linking function blocks

In addition, auxilary windows, e.g. live lists, appear when the appropriate function is invoked.

ControlCare Application Designer also uses context menus, which offer the functions relevant for
the object currently selected only.

i ControlCare Application Designer - My FF Project _18 %

Project File Edit View Tools Arrange Options Window Help

el o) 541 le| | mf o] 2] [w A ©l= = =

0| T N NEE
= B My FF Project B 8 Fieldbus 1 - [ Heat Exchanger
E-{3@ Pasteurization £ Gy COI4 =] Temperature contral
“[BP Heat Exchanger HOH] g w0 TTI00-81-1
- fli@ Fieldbus Networks ] FIEIdpus ne‘work - TT100-PID-1
- ) HSE HOST 1 Physmal project - FT101-AL-2
Bl &% HSE Metwork 1 T FCrnz-40-1
£ Gy CO104 T FCvioz-pID-2
&2 Fieldbus 1
i FTI01-RS-1 Process cell
[ FT101-TRD-1 i i
Project T} FTI01-812 Logical project
=83 Fovioe
@ me
i} FB Metso Application
B Temperature control 3 ) ZIE il
Control strategy =~ - - s s LA R o .
ouT
1N
QAUT - --::CAS_IN--- e QUT e CAS-IN-

TT100-A41 & TT00-PID-1 )—x{ FOVIO2PID2 H FCVINZ-ACT ] !
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2.5.2 Menu operation

The menu bar contains the main menus required for engineering, configuring, commissioning and
operating your project. The content changes according to which particular window is activated or
the position in the main project tree. Table 2-1 lists the menus and functions: full details are to found

in Chapter 3.

Name Function

Project File Contains all project management functions, e.g. open, save, print, preferences etc.

Edit Allows the editing of the project, e.g. adding and deleting of bridges, gateways, process cells, control
modules, function blocks, links etc.in the appropriate windows

Search Searches for the item entered in the project tree or control strategy

View Opens the live list in the network window or allows zooming in the strategy window

Export When the plant node (HSE Host) is selected in the project window, updates OPC server, tags etc.

Communication | Allows selection of OPC server in the Project window, and when on-line, the downloading of the
project to the Field Controller in the Project or Network windows

Tools Selects drawing tools and toolbars in the strategy window

Options Allows preferences to be set for the graphical objects used in the strategy window

Window Provides the standard Windows functions for window management in all windows

Help Opens the Controlcare Online Help and About functions in all windows

726, 2-1- Mazin menus and basic. funclions

Open a menu by moving the mouse across the menu name, and if necessary clicking. Menu items
that are not available for the particular element selected are greyed:

i ControlCare Application Designer - Plant

Froject File | Edit Search Communication Window Help

Attribut

Exchange. . =10l

-l Plank

(@ Areal
i@ Fieldbus Networks

(=) v HoST £

(= && HSE Hetwork 1

= G EEEE
&% Fieldbus 1

= Gy Gateway_L
LB Profibus 1

Open context menus by selecting an object and right-clicking. Menu items that are not available for
the particular element selected are greyed:

PR I=TEY
£ E Plant:
(@ Areal

=] Fieldbus Networks
= () HSE HOST 1
&

i Bridge. .
B Gatenay e

& Prof | Bl Tane s
Live List...

Eridge from Template..,
Downiaad...,

Device from Template. ..

Attributes. ..
Delete Fieldbus

Endress+Hauser



ControlCare Application Designer: Overview 2 Getting Started

Other toolbars

Endress+Hauser

2.5.3 Toolbar operation

The toolbar provides short cuts to selected menu functions. When the functions are not available in
a particular window, the buttons become grey. When the cursor is placed on a tool bar button, a
tooltip explaining its function appears. A detailed explanation of the functions that can be called by
from the toolbars is to be found in Chapter 4.

Fig 2-3 shows the general toolbar, which is always active in Application designer.

1] 22| Bs)@s) S210]5e| =] B B o] 3| 2]

g 2<3- General operalion loolbar

Also active by default when the control strategy window is open is the strategy tool bar. This is used
in the creation of the control strategy.

Ix Al @7 g2 =

g 24 Control stralegy loolbar

Four other tool bars, which are associated with the drawing tool, see operating instructions
BA032S/04/en, can be opened by selecting Tools => Tool Boxes => Toobox Name. When
open, a tick appears next to the toolbox name. The toolboxes are closed by reselecting the toolbox
name.

These toolboxes are active only when a graphical element is selected in the strategy window.
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2.6 Documentation

2.6.1 PDFs

The current set of ControlCare documentation is installed as PDFs during the setup procedure at
the default location Endress+Hauser => ControlCare => Manuals => English =>... . They can
be accessed though Start => Programs =>Endress+Hauser => etc.

The manuals with content relevant to the use of Application Designer are as follows:

m BAO19S/04/en — Application Designer: FOUNDATION Fieldbus Tutorial
m BA022S/04/en — Application Designer: Function Blocks

(contains details on the parameters and configuration of function blocks)
m BAQ035S5/04/en — Field Controller: Commissioning and Configuration
(contains details of configuring the local I/0 in Application Designer)
BA036S/04/en — Application Designer: PROFIBUS Tutorial
BA037S/04/en — Application Designer: MODBUS Tutorial
BA038S/04/en — Application Designer: IEC 61131-3 Ladder Logic Tutorial
BA056S/04/en — Application Designer: IEC 61131-3 Structured Text Tutorial
BA062S/04/en — Application Designer: Local I/OTutorial

2.6.2 Online Help

ControlCare Application Designer provides an Online Help which can be called from the Help
menu, by pressing the Contents button 2| or by presssing the Help button in the specific dialog
box.

2.6.3 This manual

This manual describes the various menus and menu items to be found within Application Designer.
It does not attempt to describe practical applications — this is the purpose of the tutorials — but to
provide a function description of every menu point and dialog. To aid clarity, the descriptions have
been devided into the following chapters:

Menus — functional descriptions structured according to menu

Toolbars — functional descriptions structured according to window
Context Menus — functional descriptions structured according to window
Dialogs — dialog descriptions structured according to activity
Trouble-Shooting — Error messages and responses
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3 Menus

This chapter contains descriptions of the main menus and toolbars. The menus available in
Application Designer are Project File, Edit, Search, Export, View, Communication, Window and
Help. The menus change according to which node is selected on the project navigation tree or
which window, project, fieldbus, process cell, strategy, is active. Greyed menu items are not
available for the selected node or window, whereby some are also dependent upon whether a
project is off- or online.

Chapter 3.9 contains a overview of the menus in PROFIBUS Configurator. More details can be
found in Application Designer PROFIBUS Tutorial, BAO36S/04/en and the PROFIBUS Configuror
online help.

3.1 Project File

3.1.1 Opening and closing projects

Menu Button |Function
Project File .1 -] |Creates new project:
=>New=>Project 2 D- m Select Project from menu

“ v =1 |m Inthe Setup New Project Workspace dialog:
— If necessary, browse to folder location
— Enter file name

— Press Save
m A folder containing the project file is created
Project File .1 -] |Creates a new template of the selected type:
=>New=>Strategy Template = D -| |m Select Strategy, Device or Bridge Template from menu
=>Device Template 1 *1 |m In the workspace that opens, create the template
=>Bridge Template — See the appropriate dialogs in Chapter 6

= Close the workspace - you will be asked to store you template
— If necessary, browse to folder location
— Enter file name
— Press Save

m A folder containing the project file is created

Project File Opens an existing project:
=> Open I*FE‘I m [n the Open dialog:
= — Browse to folder location
— Select the project file
— Press Open
m The project is opened

Project File Opens a default device template
=> Open default template m In the Open Default Template dialog

— Select the device manufacturer
— Select the device
— If appropriate select the device revision (default = latest)
— Press OK to open template
m In the Device Default Template dialog
— Make the changes to the template
— Save changes:
Project File => Save As Default Template
— Press X in top righthand corner to close the template
= The modified template will be used everytime a device of this type is
connected to a fieldbus network
Project File Closes current project
=> Close m Pressing X in top righthand corner also closes the project
m [f changes have been made to the project since the last save, you will be
asked whether you want to save them
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3.1.2 Saving projects

Menu

Button

Function

Project File
=> Save

B

Saves the changes in the currently active window

Project File
=> Save As...

Saves a copy of the project

m [n the Save As dialog:
— Browse to folder location
— Select the project file or enter a new file name
— Press Save

The project is opened

Project File

Saves the changes to a device default template when its window is active

=> Save default template EI-‘-
=
Project File Saves all changes to a project made since the last save action
=> Save Entire Project @1
=
3.1.3 Printing
Menu Button |Function

Project File
=> Printer Setup...

Sets up printing properties and selects the printer to be used
m Set up the printing properties in the Page Setup dialog
m Press OK to save the configuration

Project File
=> Print

Starts the printing of the project configuration

= Select the properties to be printed in the Print Configuration dialog
m Press OK to start printing

The project configuration is printed out

Project File
=> Print to File

Prints the project configuration to file

= Select the properties to be printed in the Print Configuration dialog
m Create or select a file (*.txt) for storage in the Save As dialog

m Press OK to start printing

The project configuration is printed to the selected file

Project File
=> Print Preview

Opens a Print Preview

m Select the properties to be printed in the Print Configuration dialog
m Check the layout in the Print Preview dialog

= Press & to start printing

The project configuration is printed out

3.1.4 Exporting and importing projects

Menu Button |Function
Project File Exports the project as an XML file
=>Export » [n the Export Configuration as XML dialog

=> Configuration as XML

— Ifnecessary, browse to folder location
— Enter file name (use default type)
— Press Save

The file is exported

Project File
=> Import
=> Configuration as XML

Imports a project stored as an XML file:

u |n the Import Project from XML dialog:
— Browse to folder location
— Select the XML file
— Press Open

The file is imported and the project opened
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3.1.5 Transporting and commissioning projects

Menu

Button

Function

Project File
=>Pack Missing Device Support

Packs device support files missing at the target computer in response to the
sending of a *.DSM file (Administrator):
» [n the Open dialog:
— Browse to and select the *.dsm file, press Open
= [n the Browse for Folder dialog
— Browse to the folder where the files will be created
— Press OK, the folder "Missing Files" is created
m The folder is sent to the target site: the missing files are imported with
the "Import Device Support" function

Project File
=>Import Device Support

Imports device support files into ControlCare (Administrator):
= [n the Browse to Folder dialog

— Browse to the folder containing the files and press OK
» [n the Import Device Support dialog, press OK
= A message box appears confirming the successful import

Project File
=> Pack Project

Packs the project at the selected folder location

= [n the Pack Project dialog
— Browse to the folder where the files will be created
— Enter the name of the project
— Press Save to save the packed project

m Press OK to close the successful packing message dialog

Project File
=> Unpack Project

Unpacks the project to the selected folder location

= [n the Unpack Project dialog
— Browse to the folder where the packed project is located
— Click on the name of the project
— Press Open to save the packed project

= In the Browse for Folder dialog:
— Browse to the folder where the project is to be installed
— You can create a folder with the Make New Folder button
— Press OK to start upacking, a DOS window opens

m Press OK to acknowledge the successful unpacking of the project

3.1.6 Project preferences

The table below summarizes the ControlCare functions that can be set as preferences for project
engineering. The submenus appear as folders, see Chapter 6.2 for more details

Menu

Button

Function

Project File
=> Preferences
=> Block

Sets the preferences for the naming and handling of function block tags

Project File
=> Preferences
=> Device & Bridge

Sets the preferences for the creation of device and bridge/gateway
function blocks

Project File
=> Preferences
=> Strategy

Sets the preference for the function block shapes in the control strategy

Project File
=> Preferences
=> Workspace Layout

Sets the preferences for the way in which the workspace is tiled and the
project is presented

Project File
=> Preferences
=> Device Support

Sets the default path for the Device Support folder that is called from
"Import Device Support"

Project File
=> Preferences
=> Default Project Path

Sets the preferences for the creation of device and bridge/gateway
function blocks

Endress+Hauser
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3.2

Edit

3.2.1 Project window
Menu Submenu Active for Node |Function
Edit New Process Cell Area Adds a Process Cell to the Area node

m [n the Process Cell dialog
— Enter a procell cell tag
If no tag is entered, default tag is Process Cell n
— Press OK to create the Process Cell

Delete Process Cell

Process Cell

Deletes the selected Process Cell from the Area node
m In the Process Cell confirmation message

— Press Yes to delete

— Press No to cancel the action

New Fieldbus

Bridge

Adds a Fieldbus to the selected Bridge node
m In the New Fieldbus dialog
— Enter the Fieldbus tag
If no tag is entered, default tag is Fieldbus n
— Enter the port to which it is connected (1 —4)
— If appropriate, check the "Is Redundant" box
— Press OK to create the Fieldbus

Delete Fieldbus

Fieldbus

Deletes the selected Fieldbus from the Bridge node
m In the Fieldbusconfirmation message

— Press Yes to delete

— Press No to cancel the action

New PROFIBUS...

Import PROFIBUS

Gateway

Adds a Profibus to the selected Gateway node
m In the New Profibus dialog
— Enter the Profibus tag
If no tag is entered, default tag is Profibus n
— Press OK to create the Profibus

Adds a preconfigured PROFIBUS to the selected Gateway
m [n the PROFIBUS dialog
— Enter a tag name
— Ifno entry is made the tag Profibus_n is assigned
— Press OK
m [n the Importing from PROFIBUS Database dialog
— Browse and select the project file
— Press Open to import the file
= In PROFIBUS Configurator:
— If necessary modify the configuration
— Exit the program
= In the [/O Mapping Table
— If necessary map the data provided by remote [/Os
— Confirm the mapping
The information is mapped to PROFIBUS function blocks
and the PROFIBUS with devices is added to the Gateway

Delete PROFIBUS

Profibus

Deletes the selected Profibus from the Gateway node
= [n the Profibusconfirmation message

— Press Yes to delete

— Press No to cancel the action

Attributes... Area, Bridge, Allows the attributes of the selected node to be viewed
Gateway — Normally the tag can be changed also
Exchange Bridge, Gateway Allows the bridge or gateway to be exchanged
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3.2.2 Process Cell window

Menu

Submenu

Active for Node

Function

Edit

New Control
Module

Process Cell

Adds a Control Module to the selected Process Cell node
= In the Control Module dialog
— Enter the Control Module tag
If no tag is entered, default tag is Control Module n
— Press OK to create the Control Module

Cut Control Module

Copy Control
Module

New Block

Attach Block

Delete Control
Module

Control Module

Cuts selected control module and places it on the clipboard

Copies selected control module and places it on the
clipboard

Adds a function block to the Control Module node
= In the New Block dialog
— Select the Manufacturer, Device Type and
Block Type from the drop-down menu
— Enter a Block Tag
If no tag is entered, the default tag is created
according to the Tag Policy, Chapter 3.1.6
— Press OK to create the new block

Attaches a device block to the Control Module node
= In the Attach Block dialog
— Select the block from the drop-down list
— Press OK to attach the block to the Control Module

Deletes the the selected Control Module node
— Confirm your action with Yes

Off Line
Characterization

Customize
Characterization

Cut Block

Copy Block

Delete Block

Detach Block

<FB Tag>

Allows the properties of the function block to be changed
» [n the Off Line Characterization dialog
— Expand the parameter you wish to change
— Double-click on the "Value" space
— Enter the parameter or select a value from the drop-
down menu
— Press End Edit to store the parameter
m Repeat for all parameters that have to be changed
m Press Close to close the dialog

Allows the user to define block parameters that appear in
the Characterization dialogs
m In the Customization: <Block> dialog

— Select the Tab Default, Type or Tag

— Select the parameters required and move to the

righthand window with the ">>" button

— Press Apply to apply your changes

— Press OK to close the dialog
m Default: Parameters valid for all blocks

Type: Parameters valid for all blocks of the same type,

Tag: Parameters valid for the particular block only
The default parameters are already preconfigured in
ControlCare - they should not be changed.

Cuts selected block and places it on the clipboard
— Not possible for PROFIBUS I/0 blocks

Copies selected block and places it on the clipboard
— Not possible for PROFIBUS 1/0 blocks

Deletes the selected block
— Confirm your action with Yes

Detaches the selected block from the Control Module

— Active only for device blocks that have previously
attached from or to FB VED nodes

— If present, the block is also removed from the Control
Module window

Paste Control

Process Cell

Pastes a cut or copied control module to the selected node

Module Control Module
Paste Block Control Module, Pastes a cut or copied block to the selected node
<FB Tag>
Delete Parameter <Parameter> Deletes selected parameter from the <Funtion Block Tag>

node

Attributes...

Process Cell,
Control Module
<FB Tag>

Allows the attributes of the selected node to be viewed
— Normally the tag can be changed also
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3.2.3 Control Module window

Menu Submenu Active for Object

Function

Edit Cut Bitmap

Copy

Paste

Cuts the selected object (previously copied from the
clipboard) and places it in the clipboard again
— Remains grey if selected object cannot be cut

Copies the selected object (previously copied from the
clipboard) and places it in the clipboard
— Remains grey if selected object cannot be copied

Pastes an object cut or copied from an external application,
e.g. a graphical object, from the clipboard to the Control
Module window

— Remains grey if there is nothing on the clipboard

Rename Parameter name

Creates an alias for the selected block parameter, provided
the alais function has been activated in the Project File =>
Strategy preference dialog, see Chapter 6.2
= [n the Rename dialog

— Type in the alais name you require

— Press OK

— The name is changed in all windows containing a

reference to the parameter

Clear All Workspace
Function Block
Link

Clears the complete control strategy workspace

— The function blocks and links remain attached to the
Control Module node in the Process Cell window

— They can be dragged&dropped into the window again
and the links revealed by using the Show Hidden Links
context menu (links might need separating)

Delete Function Block
Link

Deletes the selected object
» In the Function Block or Link Deletion dialog
— Select Yes or OK to delete the selected object
completely from the project
— Select No to remove the Function Block from the
Control Module window only or to hide the link

Select All Workspace
Function Block
Link

Selects all objects in the Control Module window

Redraw Workspace
Function Block

Link

Redraws all objects according to any change made in the
default drawing properties
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3.2.4 HSE Network window

Menu

Submenu

Active for Node

Function

Edit

New Gateway

New Device

New Bridge

HSE Network

Adds a SFC173 DP gateway to the HSE Network node
= In the New Gateway dialog (Default: SFC173)
— Enter a tag name
If no tag is entered, default tag is Gateway_n
— Press OK to create the gateway

Adds a new HSE device to the HSE Network node
(Currently not possible, because no HSE devices)

Adds a SFC162 bridge to the HSE Network node
» [n the New Bridge dialog (Default: SFC162)
— Enter a tag name
If no tag is entered, default tag is Bridge_n
— Press OK to create the new bridge

Exchange

Bridge

Allows the bridge to be exchanged

New Block

Attach Block

FB VFD

Adds a function block to the FB VFD node
= In the New Block dialog
— Select the Manufacturer, Device Type and
Block Type from the drop-down menu
— Enter a Block Tag
If no tag is entered, the default tag is created
according to the Tag Policy, Chapter 3.1.6
— Press OK to create the new block

Attaches a Control Module block to the FB VFD node
m In the Attach Block dialog
— Select the block from the drop-down list
— Press OK to attach the block to the FB VFD node
— The "?" in the Control Module block icon disappears

Off Line
Characterization

Customize
Characterization

Cut Block

Copy Block

Delete Block

Detach Block

OnlLine
Characterization

<FB Tag>

Allows the properties of the function block to be changed
m [n the Off Line Characterization dialog
— Expand the parameter you wish to change
— Double-click on the "Value" space
— Enter the parameter or select a value from the drop-
down menu
— Press End Edit to store the parameter
m Repeat for all parameters that have to be changed
m Press Close to close the dialog

Allows the user to define block parameters that appear in
the Characterization dialogs
m In the Customization: <Block> dialog
— Select the Tab Default, Type or Tag
— Select the parameters required and move to the
righthand window with the ">>" button
— Press Apply to apply your changes
— Press OK to close the dialog
m Default: Parameters valid for all blocks
Type: Parameters valid for all blocks of the same type,
Tag: Parameters valid for the particular block only

Cuts selected block and places it on the clipboard

Copies selected block and places it on the clipboard

Deletes the selected block
— Confirm your action with Yes

Detaches the selected block from the FB VFD node
— Confirm your action with Yes

Allows the properties of the function block to be changed
on line

Paste Block

FB VFD,
<FB Tag>

Pastes a cut or copied block to the selected node

Delete Parameter

<Parameter>

Deletes selected parameter from the <FB Tag> node
— Confirm your action with Yes

Attributes...

HSE Network,
Bridge, Gateway,
<FB Tag>

Allows the attributes of the selected node to be viewed
— Normally the tag can be changed also
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3.2.5 Fieldbus window

Menu

Submenu

Active for Node

Function

Edit

New Device

Fieldbus

Adds a new (FF H1) device to the Fieldbus node
= [n the New Device dialog
— Select the manufacturer, device and device revisions
— Enter a Device Tag
If no tag is entered, the default tag is created
according to the Tag Policy, Chapter 3.1.6
— Press OK to create the device

Exchange

Bridge, Device

Allows the bridge or device to be exchanged
m See description in Chapter 5.5.6

Delete Device

Device

Deletes the selected device from the Fieldbus node
m In the Device confirmation message

— Press Yes to delete

— Press No to cancel the action

New Block

Attach Block

FB VFD
FB Application

Adds a function block to the FB VFD node
m In the New Block dialog
— Select the Manufacturer, Device Type and
Block Type from the drop-down menu
— Enter a Block Tag
If no tag is entered, the default tag is created
according to the Tag Policy, Chapter 3.1.6
— Press OK to create the new block

Attaches a Control Module block to the FB VFD node
m In the Attach Block dialog
— Select the block from the drop-down list
— Press OK to attach the block to the FB VFD node
— The "?" in the Control Module block icon disappears

Off Line
Characterization

Customize
Characterization

Delete Block

Cut Block

Copy Block

Detach Block

<FB Tag>

Allows the properties of the function block to be changed
m In the Off Line Characterization dialog
— Expand the parameter you wish to change
— Double-click on the "Value" space
— Enter the parameter or select a value from the drop-
down menu
— Press End Edit to store the parameter
m Repeat for all parameters that have to be changed
m Press Close to close the dialog

Allows the user to define block parameters that appear in
the Characterization dialogs
m In the Customization: <Block> dialog
— Select the Tab Default, Type or Tag
— Select the parameters required and move to the
righthand window with the ">>" button
— Press Apply to apply your changes
— Press OK to close the dialog
m Default: Parameters valid for all blocks
Type: Parameters valid for all blocks of the same type,
Tag: Parameters valid for the particular block only

Deletes the selected block
— Confirm your action with Yes

Cuts selected block and places it on the clipboard

Copies selected block and places it on the clipboard

Detaches the selected block from the FB VED node
— Confirm your action with Yes

Program Hybrid
Block

<Hybrid Block Tag>

Opens OpenPCS for programming block

Paste Block

FB VFD
FB Application
<FB Tag>

Pastes a cut or copied block to the selected node

Delete Parameter

<Parameter>

Deletes selected parameter from the <FB Tag> node
— Confirm your action with Yes

Attributes...

Fieldbus, Bridge,
Device,
<FB Tag>

Allows the attributes of the selected node to be viewed
— Normally the tag can be changed also
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3.2.6 PROFIBUS window

The block edit functions New Block, Attach Block, Delete Block and Detach Block apply to the
SFC173 gateway node only. The blocks associated with the PROFIBUS PA and DP field devices are
attached and assigned in the PROFIBUS Configurator tool.

Menu Submenu Active for Node |Function
Edit Modify I/0 Mapping | Profibus Opens the PROFIBUS 1/0 Mapping dialog
— Click on the parameter that is to be modified
— Change the configuration
— Press OK to close the dialog and save the changes
Modify PROFIBUS Opens PROFIBUS Configurator
Configuration — See Chapter 5.6 or BA036s/04/en for more details
New Block FB VFD Adds a function block to the FB VFD node of the gateway
m In the New Block dialog
— Select the Manufacturer, Device Type and
Block Type from the drop-down menu
— Enter a Block Tag
If no tag is entered, the default tag is created
according to the Tag Policy, Chapter 3.1.6
— Press OK to create the new block
Paste Block Pastes a cut or copied block to the selected node
Attach Block Attaches a Control Module block to the FB VFD node
= In the Attach Block dialog
— Select the block from the drop-down list
— Press OK to attach the block to the FB VFD node
— The "?" in the Control Module block icon disappears
Off Line <FB Tag> Allows the properties of the function block to be changed
Characterization m See Chapter 3.2.5
Customize Allows the user to define block parameters that appear in
Characterization the Characterization dialogs
m See Chapter 3.2.5
Delete Block Deletes the selected block from the FB VED node of the
gateway
— Confirm your action with Yes
— Profibus blocks attached to the FB Application node of a
field device cannot be deleted
Cut Block Cuts selected block and places it on the clipboard
— Not possible for PROFIBUS 1/0 blocks
Copy Block Copies selected block and places it on the clipboard
— Not possible for PROFIBUS 1/0 blocks
Detach Block Detaches the selected block from the FB VED node of the
gateway
— Confirm your action with Yes
— Profibus blocks attached to the FB Application node of a
field device cannot be detached
Program Hybrid <Hybrid Block Tag> | Opens OpenPCS for programming block
Block
Paste Block FB VFD Pastes a cut or copied block to the selected node
<FB Tag> — Not possible for PROFIBUS 1/0 blocks
Delete Parameter <Parameter> Deletes selected parameter from the <FB Tag> node
Attributes... Profibus, Gateway, |Allows the attributes of the selected node to be viewed
PROFIBUS Device, |- Normally the tag can be changed also
<FB Tag>
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3.3 Search
Menu Submenu Active for Node |Function
Search Find... Plant (Root) Locates a device or block within the project
Area m In the Find Tags dialog
Fieldbus Network — Select the Device or Block Marker
HSE Host — Select or enter the tag to be found
HSE Network — The location is shown in the Location box
MIB — Press OK
= Application Designer locates the device or block

34

Export

Menu Submenu Active for Node |Function
Export Consolidate OPC Plant (Root) Merges the tag lists from two or more project configuration
Database HSE Host files into a single OPC Database
m In the Consolidate OPC Database dialog:
— Press the Add This button
— Confirm the action with Yes
— The current project tags are added to the database
m Repeat for all other projects involved
m The tag lists of the projects displayed are merged
Update OPC Updates the OPC database
Database — Quit the OPC Database Update message box with OK
Export Tags... Exports the project tags to the OPC database
— Quit the Export Tags message box with OK
Export Exports the project configuration to a file data source
Configuration... (shared with other machines) or to a machine data source
(machine-specific), e.g. Excel.
m In the Select Data Source dialog
— Select a file or data source or
create a new data source
— Click OK to make the connection
= Application Designer exports the configuration to the
selected data source
3.5 View
Menu Submenu Active for Node |Function
View Expand Process Cell Opens corresponding window
Control Module
HSE Network
Fieldbus
Profibus
Live List HSE Network Opens corresponding Live List dialog
Fieldbus
Profibus
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3.6 Communication

Device Class

Menu Submenu Active for node |Function
Communication |Settings Fieldbus Networks |Selects the OPC server to which to process data are exported
» In the Communications Settings dialog
— Select the OPC server from the pull-down menu
— Press OK to make the connection
Assign All Tags |HSE Network, When online and after the all Device IDs have been set in their
Bridge, Fieldbus Attributes Dialog, downloads the tag hames used in the project
to the corresponding field devices
m Press the Online button to put the project online
m Call the Attributes context menu of every HSE and FF device
and in the Device Attribute dialog:
— Select the Device ID from the drop-down menu
— Press OK to implement changes
— Wait until the red cross at the side of the device icon
disappears
m Call the Assign All Tags menu
— A progress dialog appears
— After some time, the each Device Tag changes
Update HSE Network, When online, updates the configuration database in the Field
Bridge, Gateway, |Controller for the devices connected to the selected node
Device (FF)
Download... HSE Network When online, downloads the project or partial project to the
Fieldbus, Profibus, |Field Controller SFC162 and/or SFC173
Bridge, Gateway m Establish connection to the Field Controller
m Press the Online button
m In the Download - Fieldbus Networks dialog:
— Press Start to begin the download
— After a successful download the dialog closes,
otherwise error messages are displayed in a log at the
bottom of the screen
The parameters downloaded depend on the node selected when
the download is started:
m HSE Network: entire project
m Fieldbus/Profibus: all parameters for devices connected to
the Fieldbus or Profibus network node
m Bridge/Gateway: all parameters for the devices connected to
the bridge/gateway node
Download Bridge Downloads the bridge parameters only
Bridge only — Required, e.g., if the bridge has to be exchanged,
— For procedure see above
Configure Fieldbus When online, allows a device to be selected as backup LAS

m Press the Online button
m Select the Fieldbus, then Configure Device Class
m [n the Device Class dialog,
— Select the device(s) you want as backup LAS
— Press >> to move them to the righthand pane
For devices with no LAS capability, an error message
appears
— Press Apply to download the Device Class and Traffic
Schedule to the devices
LAS backup devices can also be selected offline, however, they
do not assume the function until selected in online mode.l
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Menu

Submenu

Active for node

Function

Communication

Assign Tag

Bridge, Gateway,
<FB Tag>

When online and after the Device ID has been set in the
Attributes Dialog, downloads the Tag name used in the project
to the selected field device
m Press the Online button to put the project online
= Call the Attributes context menu and in the Device
Attribute dialog:
— Select the Device ID from the drop-down menu
— Press OK to implement changes
— Wait until the red cross at the side of the device icon
disappears
m Call the Assign Tag menu
— A progress dialog appears
— After a short period of time, the Device Tag changes

On Line Char-
acterization

<FB Tag>

Allows the properties of the device function block to be
characterized and observed in online mode
» [n the On Line Characterization dialog

— Set MODE_BLK.TARGET to OOS
Expand the parameter you wish to change
Double-click on the "Value" space
Enter the parameter or select a value from the drop-down
menu

— Press End Edit to store the parameter
= Repeat for all parameters that have to be characterized
m Set MODE_BLK.TARGET back to its original state
m Press Close to close the dialog

3.7 Window

Menu Submenu Active for node Function
Window Smart Tile All nodes Tiles all open windows (tiling algorithm)
Cascade All nodes Cascades all open windows
Tile All nodes Tiles all open windows (equal area)
Arrange Icons | All nodes Arranges iconic windows along the bottom edge of the framee
Close All All nodes Closes all open windows
— You will be asked to save any changes
Active All nodes Lists open windows: selecting a window actives it

3.8 Help

Menu Submenu Active for node |Function
Help Contents All Opens the Online Help
Using help All Tells you how to use the Online help
About All Tells you about your version of Application Designer
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3.9 Drawing Tool

Application Designer has a drawing tool, which is used to create the strategy in the Control Module
workspace. The following submenus are active when the workspace is open.

3.9.1 Tools

The Tool Boxes submenu places toolbars at the side and above the workspace to increase efficiency
in the creation of the control strategy. Details of the toolbars themselves are to be found in
Chapter 4.3.

Menu Submenu Option Function

Tools Tool Boxes Drawing Activates or hides the drawing toolbox, see Chapter 4.3.1
Alignment Activates or hides the alignment toolbox, see Chapter 4.3.2
Ordering Activates or hides the ordering toolbox, see Chapter 4.3.3
Copy Attributes Activates or hides the copy attributes toolbox, see Chapter 4.3.4
Strategy Activates or hides the strategy toolbox, see Chapter 4.2

The Drawing submenu provides a number of objects which can be used to produce drawings and
legends within the workspace.

Menu Submenu Option Function

Tools Drawing Select When active (ticked) allows an object to be selected and if

necessary be modified

m To select several objects at once, keep the SHIFT key pressed

» To modify, select a handle and pull in the desired direction

Drawing modify When active (ticked), allows an the length, breadth and

orientation of arcs, lines and pipes etc. to be modified

m Select a handle and pull in the desired direction

Rectangle When active (ticked), allows a rectangle to be drawn

= Move the cursor to the start point (top left hand corner)

m With the right mouse button depressed, drag across to the
end point (lower right hand corner)

m Release mouse button

To draw squares, drag with the SHIFT key depressed

Rounded Rectangle | When active (ticked), allows a rounded rectangle to be drawn

= Move the cursor to the start point (top left hand corner)

= With the right mouse button depressed, drag across to the
end point (lower right hand corner)

m Release mouse button

To draw rounded squares, drag with the SHIFT key depressed

Ellipse When active (ticked), allows an ellipse to be drawn

= Move the cursor to the start point

= With the right mouse button depressed, drag across to the
end point

m Release mouse button

To draw circles, drag with the SHIFT key depressed

Arc When active (ticked), allows ©/2 radians of an arc to be drawn

= Move the cursor to the start point

m With the right mouse button depressed, drag across to the
end point

m Release mouse button

To draw circular arcs, drag with the SHIFT key depressed

To extend or reduce the arc:

m Select the drawing modify tool

m Select a handle

m With the right mouse button depressed, drag the handle to
the desired position

= Release mouse button
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Menu

Submenu

Option

Function

Tools

Drawing

Pie

When active (ticked), allows 7/2 radians of a pie to be drawn

= Move the cursor to the start point

= With the right mouse button depressed, drag across to the
end point

m Release mouse button

To draw circular pies, drag with the SHIFT key depressed

To extend or reduce the pie:

m Select the drawing modify tool

m Select a handle

= With the right mouse button depressed, drag the handle to
the desired position

m Release mouse button

Chord

When active (ticked), allows rt/2 radians of a chord to be drawn

= Move the cursor to the start point

= With the right mouse button depressed, drag across to the
end point

m Release mouse button

To draw circular chords, drag with the SHIFT key depressed

To extend or reduce the chord:

m Select the drawing modify tool

m Select a handle

= With the right mouse button depressed, drag the handle to
the desired position

= Release mouse button

Ring

When active (ticked), allows ©/2 radians of a ring to be drawn

= Move the cursor to the start point

= With the right mouse button depressed, drag across to the
end point

m Release mouse button

To draw circular rings, drag with the SHIFT key depressed

To extend or reduce the ring:

m Select the drawing modify tool

m Select an outer handle

= With the right mouse button depressed, drag the handle to
the desired position

m Release mouse button

To increase or reduce the thickness of the ring:

m Select the drawing modify tool

m Select an inner handle

= With the right mouse button depressed, drag the handle to
the desired position

m Release mouse button

Line

When active (ticked), allows a line to be drawn
= Move the cursor to the start point
— To draw a 45° line, drag with the SHIFT key depressed.
— To draw a horizontal or vertical line, keep the CTRL key
depressed
= With the right mouse button depressed, drag across to the
end point
m Release mouse button
To change the length or orientation of the line, drag any handle
to the required position
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Menu

Submenu

Option

Function

Tools

Drawing

Pipe

When active (ticked), allows a pipe to be drawn
= Move the cursor to the start point
— To a pipe at a 45° angle, drag with the SHIFT key
depressed
= With the right mouse button depressed, drag across to the
end point
m Release mouse button

To extend or reduce the pipe:

m Select the drawing modify tool

m Select an outer handle

m With the right mouse button depressed, drag the handle to
the desired position

m Release mouse button

To change the orientation of the pipe:

m Select the drawing modify tool

m Select an inner handle

= With the right mouse button depressed, drag the handle to
the desired position

m Release mouse button

Polyline

When active (ticked), allows a multiple line to be drawn
— To draw a 45° line, drag with the SHIFT key depressed.
— To draw a horizontal or vertical line, keep the CTRL key
depressed
= Move the cursor to the start point and right click
m Move to the required points and right click at each
m Left click to finish the line

To maniulate the line as a whole:

m Select a handle

m With the right mouse button depressed, drag the handle to
the desired position

m Release mouse button

To cahnge the position of an individual point in the line:

m Select the drawing modify tool

m Select the point

= With the right mouse button depressed, drag the point to the
desired position

m Release mouse button

Polygon

When active (ticked), allows a polygon to be drawn

= Move the cursor to the start point and right click
— To draw a 45° line, keep the SHIFT key depressed.
— To draw a horizontal or vertical line, keep the CTRL key

depressed

= Move to the required points and right click at each

m Left click to finish the polygon - the last point is automatically
joined to the first point and the enclosed area shaded

To manipulate the polygon as a whole:

= Select a handle

m With the right mouse button depressed, drag the handle to
the desired position

= Release mouse button

To change the position of an individual point in the line:

m Select the drawing modify tool

m Select the point (or click to make a point)

m With the right mouse button depressed, drag the point to the
desired position

m Release mouse button

Text

When active (ticked), allows text to be written

m Font size, fill etc. can be changed by a right-click on the text
box and a click on the context menu Properties

m The changes are actived by clicking on Apply then OK
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Menu Submenu Option Function
Tools Drawing Bitmap When active (ticked), allows a bitmap to be placed in the
workspace
m Click with the cursor on the position where the bitmap is to
be placed
» [n the Open dialog, browse to the folder and select the file
m Press Open to position the bitmap
Alignment The Alignment submenu allows objects in the Control Module workspace to be aligned in various
ways. All options function as follows:
1 Select the object to be aligned with the select tool
— Several objects can be selected at once by using the SHIFT key or
— dragging the selection cursor across them
2 Select the alignment option required
3 Click on the object to which the selected object is to* be aligned
Menu Submenu Option Function
Tools Alignment Left When active (ticked), aligns the lefthand side of the first object
selected to the lefthand side of the second object selected
Center When active (ticked), horizontally aligns the centre of the first
object selected to the centre of the second object selected
Right When active (ticked), aligns the righthand side of the first object
selected to the righthand side of the second object selected
Top When active (ticked), aligns the top of the first object selected to
the top of tsecond object selected
Middle When active (ticked), vertically aligns the centre of the first
object selected to the centre of second object selected
Bottom When active (ticked), aligns the bottom of the first object
selected to the bottom side of second object selected
Center Points When active (ticked), aligns the center point of the first object
selected to the centre point of second object selected
Evenly Spaced - When active (ticked), spaces the centres of the selected objects
Horizontal evenly in the horizontal plane
Evenly Spaced - When active (ticked), spaces the centres of the selected objects
Vertical evenly in the vertical plane
Ordering The Ordering submenu allows overlapping objects to be viewed in a particular order, i.e. determines

30

which object is to be seen fully and which objects are partially covered.

Menu Submenu Option Function
Tools Ordering To Front When active (ticked), brings the selected object to the front of
the pile
To Back When active (ticked), sends the selected object to the back of
the pile
Forward One When active (ticked), brings the selected object one position

forward in the pile

Backward One

When active (ticked), sends the selected object one position
backward in the pile

In Front Of When active (ticked), places the selected object in front of a
target object (next click)
Behind When active (ticked), places the selected object behind a target

object (next click)

Reverse Order

When active (ticked), reverses the viewing order to two selected
objects
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The Copy Attributes submenu allows the properties of a target object to be imposed on a selected
object

1 Select the object, the attributes of which are to be changed with the select tool

— Several objects can be selected at once by using the SHIFT key or
— dragging the selection cursor across them

2 Select the copy attributes option required

3 Click on the object, the attributes of which are to be copied

Menu Submenu Option Function
Tools Copy Same Width When active (ticked), imposes the width of the second object
Attributes selected on the first object selected
Same Height When active (ticked), imposes the height of the second object

selected on the first object selected

Same Dimensions

When active (ticked), imposes the dimensions of the second
object selected on the first object selected

Same Pen & Brush

When active (ticked), imposes the drawing attributes of the
second object selected on the first object selected

Same Font & Colors

When active (ticked), imposes the font and fill attributes of the
second object selected on the first object selected

Same Text When active (ticked), imposes the text attributes of the second
Attributes object selected on the first object selected

Set Attributes As When active (ticked), takes the color and fill of the selected
Default Ones object as the default settings for all newly created objects

The Strategy submenu allows function blocks links etc. to be created within the Control Module
workspace, see also Chapter 4.2.

Menu

Submenu

Option

Function

Tools

Strategy

Function Block

When active (ticked), opens the New Block dialog when a click
is made in the Control Module workspace

Link When active (ticked), allows a link to be made between two
function blocks whan a click is made on the source block

Import Strategy When active (ticked), opens the dialog for the importation of a

Template previously stored strategy template

Export Selected When active (ticked), opens the dialog for storing the selected

Strategy Template |strategy as a template

Strategy Modify When active (ticked), allows changes to be made to the shape of

objects and link lines in the strategy

Forward Path
Definition

No used

On Line Monitoring

When active (ticked), allows control strategy values to be
monitored, provided that the project on-line
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3.9.2 Options

The Options menu allows the properties of selected objects and the Control Module workspace to
be set. In each case the corresponding dialog is opened and the properties can be set.

Menu

Submenu

Tab

Function

Options

Object
Properties

General

Allows the position and size of one or more selected objects to
be changed

m Enter the desired position and/or size

= Press Apply to make the changes affective

Line

Allows the line thickness, style and color to be changed

m Enter the thickess and/or set the style and color

m Press Apply to make the changes affective

= If no object is selected, the changes are used as default
settings for all objects created afterwards

Fill

Allows the fill type, style and color to be changed

m Set the fill type, style and/or color

= Press Apply to make the changes affective

If no object is selected, the changes are used as default settings
for all objects created afterwards

Text Attributes

Allows the text attributes of an object to be changes

= Set the text attributes

m Press Apply to make the changes affective

If no object is selected, the changes are used as default settings
for all objects created afterwards

Drawing
properties

General

Sets the logical unit/pixel ratio and extent of the workspace
m Set the attributes
m Press Apply to make the changes affective

Colors

Sets the background and grid colours of the workspace
m Set the attributes
m Press Apply to make the changes affective

Helper Tools

Sets the grid attributes and zoom factor of the workspace
m Set the attributes
m Press Apply to make the changes affective

Background Image

Allows a background image to be imported into the workspace
= Browse to the folder containing the image

m Select the file and press Open

m Set the background image attributes

m Press Apply to make the changes affective

Function Block
Icon

Rectangle

When ticked, causes all function blocks to be created in the
workspace as rectangles

Rounded Rectangle

When ticked, causes all function blocks to be created in the
workspace as rounded rectangles

Ellipse

When ticked, causes all function blocks to be created in the
workspace as ellipses
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3.10 PROFIBUS Configurator

PROFIBUS Configurator has an online help. Please refer to this for more details of the functions
offered that are not described in detail below or in Application Designer: PROFIBUS Tutorial,
BA036S/04/en

3.10.1 File
The menu items displayed depend on which device is selected in the PROFIBUS tree.

Menu Submenu Function
File New Creates new project: not used with Application Designer!
Open Opens existing project: not used with Application Designer!
Close Closes project: not used with Application Designer!
Save Saves changes to project
Save As.. Saves project under another name
Export... DBM: Exports project configuration to DBM file (master selected)

PDD: Exports selected project (master selected) or slave (slave selected) to file
(it is recommended that a PDD folder is created for these files)
m Select the predefined device, then call the menu or press the PDD button
= In the Open dialog

— Enter a a file name with PDD extension, press Open
m In the Predefined Devices dialog,

— Select the information you want to save

— Press OK to create the file

— Press OK to acknowledge the subsequent message

CSV: Exports project configuration to a CSV file (master selected)
— Save the project prior to Export

Copy GSD Copies the GSD of a missing devices into the program library
— GSD files can be found at www.profibus.org

Print Prints project details

Print Preview Previews print pages

Print Setup Sets up paper and printing

Recent Lists last four projects opened

Exit Closes PROFIBUS Configurator and calls the PROFIBUS 1/0 Mapping
dialog
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3.10.2 Edit

Menu Submenu Function
Edit Cut Cuts selected device from bus
Copy Copies selected device
Paste Pastes device from clipboard onto the bus
— Paste with the Paste menu or Ctrl V
— Move the "M" or "S" cursor to the desired position
— Left-click and confirm with OK
Delete Deletes the selected device
Confirm your action with Yes
Replace Replaces a device with another
— Confirm the action, select the replacement device and press OK
Optimize Buslayout |Optimizes bus layout

3.10.3 View

Menu Submenu Function
View Device Table Calls the Device Table dialog, which lists all devices in the project together
with the associated information
Address Table Calls the Address Table dialog, which list all devices in the project together
with the associated [/O address information
Logical Network Toggles to logical network view
View
Toolbars Shows/hides toolbars, see also Chapter 4.4
m Standard: File management buttons
m Fieldbus: Device insertion buttons
Status Bar Shows/Hides status bar

3.10.4 Insert

Menu Submenu Function
Insert Master Inserts Master
— Move the "M" cursor to the location on the bus and mouse-click
Slave Inserts Slave

— Move the "S" cursor to the location on the bus and mouse-click

Predefined Slave

Inserts Slave from file (also PDD button)

— Browse to and select the PDD file with the predefined device
— Press Open

— Move the cursor to the location on the bus and mouse-click
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3.10.5 Online

The Online menu offers many advanced functions relevent to debugging a PROFIBUS project. For
ControlCare users, the most important are:

m Debug Mode, which shows whether the bus is functioning or not

m Set Slave Address, which allows a slave address to be changed online, provided the selected
device is configured to accept it.

m Live List, which shows all devices available online

For all other diagnostic functions, please refer to the PROFIBUS Configurator online help. The menu
items displayed depend on which device is selected in the PROFIBUS tree.

Menu Submenu Function

Online Download Downloads project to Field Controller SFC173
— Do not use: Downloads should be made from Application Designer

Start Debug Mode | Shows status of devices connected to selected master

Firmware Download | Downloads firmware to Field Controller SFC173
— Do not use: Firmware downloads should be made from Application

Designer

Image Download Downloads the selected process image

— Do not use
Extended Device Shows current diagnostic messages received from the devices
Diagnostic
Global State Field | Shows the cyclic status and bus condition of the selected device
Live List Shows the live list of the devices connected to the Field Controller SFC173
[/0 Monitor Displays the first 32 bytes of the process data image

— Output data can the written by entering a value and pressing Update

Message Monitor | Allows access to the mailbox of the selected device

Automatic Network |Scans the network for connected devices

Scan — Do not use: accepting the configuration leads to conflicts in the PROFIBUS
/0 mapping

Set Slave Address | Opens the Slave Configuration dialog where the address can be set

Start Starts communication on the bus

Communication

Stop Stops communication on the bus

Communication

Device Info Display information about the selected device

Activate Driver Activates the selected driver

Read Project Reads the information stored in the Project Information dialog

Information

Activate Bootstrap | Do not use: will cause the program to crash
Loader
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3.10.6 Settings

Menu

Submenu

Function

Settings

Device Assignment

Selects driver for PROFIBUS
— CIF Serial Driver: for communication via COM port
— CIF TCP/IP Driver: for communcation via Ethernet port

Bus Parameter

Sets PROFIBUS DP parameters:
m For the SK2 power link, in the Bus Parameters dialog:
— Select the baudrate from the drop-down menu
— Select Standard
— Press OK
m For applications requiring parameter tuning, e.g. SK1 coupler, 2 masters,
in the Bus Parameter dialog:
— Select By User
Select Edit
Edit the bus parameters in the Edit Bus Parameters dialog
Press OK to exit the dialog
Press OK to store your changes

Master Settings

Calls the DP Master Settings dialog for configuration of the master
— The Master Settings are preconfigured for the Field Controller SFC173
when PROFIBUS Configurator is invoked from Application Designer

Master
Configuration

Sets the Tag name and PROFIBUS address of the master

m In the Master Configuration dialog:
— Enter a tag (no spaces allowed, use underscore) in the description field
— Enter a DP address (SFC173 has 1 by default)
— Press OK to save the changes and close the dialog

Group Membership

Acts as a filter for the Sync and Freeze global commands
» In the Group Membership dialog:
— Name and set up and configure the groups
— Press the Group Assignment button to open the corresponing dialog
— Assign the DP slaves to the groups
— Press OK to return to the Group Membership dialog
— Press OK to close the dialog and save the changes

Slave Settings

Not active

Slave Configuration

Sets up the selected DP slave
m In the Slave Configuration dialog

— Enter the slave address

— Enter the slave tag (no spaces allowed, use underscore) in the

description field

— Insert the data modules for cyclic communication: use
EMPTY_MODULE/FREE_SPACE to fill in gaps left by unused modules
Press the DPV1 Settings button and check that the DPV1 Activated
box is not checked: press OK to save the setting
Press OK to close the dialog and save the settings

Parameter Data

Opens the Parameter Data dialog for the selected slave
— Required for Remote /O, information supplied by manufacturer

Project Information

Opens the Project Information dialog
— Stores descriptive data about the current project

Path

Selects default directory for GSD and Project files

Language

Selects language of user interface
— The program must be restarted to effect the change
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3.10.7 Tools

Menu

Submenu

Function

Tools

GSD Viewer

Allows the contents of GSD files to be viewed
= In the Open dialog

— Select the GSD file you want to view

— Press Open
m The GSD Viewer dialog opens

3.10.8 Window

Menu Submenu Function
Window Cascade Cascades all open windows
Tile Tiles all open windows
Active Lists open windows: selecting a window actives it
3.10.9 Help
Menu Submenu Function
Help Help Topics Opens the Online Help
About Tells you about your version of PROFIBUS Configurator
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4.1 General toolbar

The general toolbar allows functions such as opening and saving of files, printing and putting the
project online to be done at the touch of a button. Which buttons are active depends upon the
window that is currently active. When the mouse cursor is place on a button, a tooltip with
explanation appears.

Button |Name Where active |Function
] |New Project Depending on selection in context menu, creates a hew:
= D - Network* m Project File
i Process Cell m Strategy template
Strategy m Device template

m Bridge template
After creation of a template, it can be stored with the save button

Open Project Opens a new Project File.
I"EI Network* Any active project must be closed before a new project can be opened
= ) Process Cell
Strategy
FE"I Save Project Saves the content of the window in which you are operating
3 Network* The button greys after it has been pressed
. | Process Cell
Strategy
Save entire Project Saves the entire configuration of the project
@1 configuration Network* The button greys after it has been pressed
E Process Cell
Strategy
Print Project Click over this button to print the project configuration, or the drawing
ﬂ Strategy objects at the Strategy window.
Print Preview Project Click over this button to see how your project will look when you print
Strategy it. You can change the print configuration, and select the objects you
e want to print
Online Mode Project Click over this button to toggle between the Online and Offline
I Network* operation mode. If the button is depressed, you are in Online mode.
) Process Cell
Log Window Project Click over this button to open the Error Log window
Network*
Process Cell
Details Project Click over this button to show or hide detailed information about Blocks
Network* types, Blocks Parameters, Devices types and Fieldbus Macrocycle.
Process Cell
Check Project Click over this button to check whether the project configuration can be
Network handled by the resources declared in the capability files
Process Cell — An system capability control message is output
Strategy — Press the Details button in the message dialog to learn more
Contents Project Click over this button to open the ControlCare Online Help
Network
Process Cell
Strategy

* Network = HSE Network, Fieldbus Network, Profibus as well as subsiduary windows such as Live Lists and Block Lists
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4.2

Strategy toolbar

The Strategy toolbar is used in connection with the Control Strategy window. It is activated by
default, and can also be switched on and off from Tools => Tool Boxes => Strategy. More details
on the creating strategies are to be found in the Application Designer Tutorials BAO19S/04/en,
BA035S/04/en, BAO36S/04/en, BAO37S/04/en and BA038S/04/en.

First select the object, click over any handle, then drag the mouse until the new shape is

Button |Name Function

Cut Cuts an object pasted into the strategy window from an external program, e.g. from Word
%l or a graphics program

Copy Copies an object pasted into the strategy window from an external program, e.g. from
E]-I-ﬂl Word or a graphics program

Paste Pastes an object into the strategy window from an external program, e.g. from Word or a
graphics program, or placed on the clipboard by the Cut or Copy function

Select Activates the Select tool..

h Click on the object you require. To select more than one object, either hold down the Shift
el key and click each object or drag the mouse across the objects while holding down the left
mouse button.

I',i‘ Strategy Modify Activates the Modify tool.

obtained. For labels, the texts can be modified after being clicked.

=-
wm
(m]

Function Block

Creates new Function Blocks.

Just click over the drawing area and the Function Block Characterization dialog box will
show up. Choose the Block attributes and it will be automatically draw after you click the
OK button.

Link Creates Links between the Function Blocks.
HE’% Click over one of the Blocks, choose the Output Parameter, then click over another Block,
et choosing the Input Parameter.
l"'EI Import Strategy Adds a Template to your Strategy window.
rE‘I | Template An Open dialog box appears. Select the file that contains the Template you want and click
Open. The Template will be automatically added to your Strategy window..
El 3 Export Selected Creates a Template file.
Ell Strategy as Select the Blocks and Links that will be part of your Template, and select this button. A
Template Save dialog box will show up. Type a name for your Template file and click Save.
sy |On Line Puts the control strategy into on line mode.
- Monitoring The project must also be put on line before the button can be used.

39



4 Toolbars

ControlCare Application Designer: Overview

40

4.3

Drawing Tool toolbars

The drawing toolbars provide a quick means of drawing and formatting objects in the Control
Strategy window.

4.3.1

Drawing

The Drawing toolbar allows objects to be drawn in the Control Module workspace

Button

Name

Function

-

Select

Activates the Select tool..

Click on the object you require. To select more than one object, either hold down the Shift
key and click each object or drag the mouse across the objects while holding down the left
mouse button.

Drawing Modify

Activates the Modify Drawing tool.
First select the object, click over any handle, then drag the mouse until the new shape is
obtained. For labels, the texts can be modified after being clicked.

Rectangle

Creates a rectangle.
Click at the position of the top lefthand corner and drag&drop to the lower righthand
corner. Hold down the Shift key to create a square.

Rounded Rectangle

Creates a rounded rectangle
Click at the position of the top lefthand corner and drag&drop to the lower righthand
corner.Hold down the Shift key to create a rouinded square.

Ellipse

Creates an ellipse.
Click at the start position and drag&drop to the end position. Hold down the Shift key to
create a circle.

Creates an arc (/2 radians)
Click at the start position and drag&drop to the end position. Hold down the Shift key to
create a circular arc. Use the Drawing Modify cursor to extend or reduce the arc.

Pie

Creates a pie (n/2 radians)
Click at the start position and drag&drop to the end position. Hold down the Shift key to
create a circular pie. Use the Drawing Modify cursor to extend or reduce the piec.

Chord

Creates a chord (n/2 radians)
Click at the start position and drag&drop to the end position. Hold down the Shift key to
create a circular chord. Use the Drawing Modify cursor to extend or reduce the chord.

Ring

Creates a ring (/2 radians)
Click at the start position and drag&drop to the end position. Hold down the Shift key to
create a circular ring. Use the Drawing Modify cursor to extend or reduce the ring.

Line

Creates a line
Click at the start position and drag&drop to the end position. Hold down the Shift key to
create a 45° line. Hold down the CTRL key to create a horizontal or vertical line.

Pipe

Creates a pipe
Click at the start position and drag&drop to the end position. Hold down the Shift key to
create a 45° pie. Hold down the CTRL key to create a horizontal or vertical pipe.

Polyline

Creates a multiple line
Left click at all nodes the and right click to create the line. Hold down the Shift key to
create a 45° line. Hold down the CTRL key to create a horizontal or vertical line.

Polygon

Creates a polygon
Left click at all nodes the and right click to create the polygon. Hold down the Shift key to
create a 45° line. Hold down the CTRL key to create a horizontal or vertical line.

Rz NdoldD ol®|m > |

Text

Creates text
Click at the start position, then after entering the tect, left click to create the text box.

«
1

Bitmap

Loads a bitmap into the Strategy window
Left click at the position where the bitmat is to start, browse to the folder containg the fiel,
then press Open to create the bitmap.
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4.3.2 Alignment

The Alignment toolbar allows objects in the Control Module workspace to be aligned in various

ways:
Button |Name Function
Left Aligns the lefthand side of the first object selected to the lefthand side of the second object
selected. Hold down the SHIFT key to select several objects.
Gz, Center Horizontally aligns the centre of the first object selected to the centre of the second object
i selected. Hold down the SHIFT key to select several objects
Right Aligns the righthand side of the first object selected to the righthand side of the second
object selected. Hold down the SHIFT key to select several objects
Top Aligns the top of the first object selected to the top of tsecond object selected. Hold down
the SHIFT key to select several objects
Middle Vertically aligns the centre of the first object selected to the centre of second object
selected. Hold down the SHIFT key to select several objects
Bottom Aligns the bottom of the first object selected to the bottom side of second object selected.

Hold down the SHIFT key to select several objects

Center Points

Aligns the center point of the first object selected to the centre point of second object
selected. Hold down the SHIFT key to select several objects

Evenly Spaced - | Spaces the centres of the selected objects evenly in the horizontal plane. Hold down the
Horizontal SHIFT key to select several objects
P Evenly Spaced - Spaces the centres of the selected objects evenly in the vertical plane,. Hold down the
m || | Vertical SHIFT key to select several objects
=
4.3.3 Ordering

The Ordering toolbar allows the order of objects in the Control Module workspace to be changed:

select both objects

Button |Name Function
r To Front Brings the selected object to the front of the pile
’J To Back Sends the selected object to the back of the pile
Ll-' Forward One Brings the selected object one position forward in the pile
‘ Backward One Sends the selected object one position backward in the pile
...";I
! In Front Of Places the selected object in front of a target object (next click)
! Behind Places the selected object behind a target object (next click). Hold down the SHIFT key to

Reverse Order

Reverses the viewing order to two selected objects.
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4.3.4 Copy Attributes

The Copy Attributes toolbar allows the properties of an objects in the Control Module workspace
to be transferred to others:

Button |Name Function
Same Width Imposes the width of the second object selected on the first object selected. Hold down the
= )
= SHIFT key to select several objects.
Same Height When active (ticked), imposes the height of the second object selected on the first object

selected. Hold down the SHIFT key to select several objects.

i
i
T

Same Dimensions

When active (ticked), imposes the dimensions of the second object selected on the first
object selected. Hold down the SHIFT key to select several objects.

&

Same Pen & Brush

When active (ticked), imposes the drawing attributes of the second object selected on the
first object selected. Hold down the SHIFT key to select several objects.

for all newly created objects. Hold down the SHIFT key to select several objects.

GEC Same Font & When active (ticked), imposes the font and fill attributes of the second object selected on
;EE Colors the first object selected. Hold down the SHIFT key to select several objects.
copy] |Same Text When active (ticked), imposes the text attributes of the second object selected on the first
E_Ilig Attributes object selected. Hold down the SHIFT key to select several objects.
A Set Attributes As | When active (ticked), takes the color and fill of the selected object as the default settings
E iB: Default Ones
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4.4

Characterization toolbar

The characterization toolbar allows you to filter and display parameters according to their function.
[t appears at the top of both the On Line Characterization and Off Line Characterization dialog

4.4.1

Parameter display filters

Parameter display filters show or hide particular parameter types

Button |Name Function
Input Shows/hides all input parameters of the block available with the selected customization
ﬂ filter
Output Shows/hides all output parameters of the block available with the selected customization
o filter
Contained Shows/hides all contained parameters of the blocks available with the selected
{:}'- customization filter
Dynamic Shows/hides all dynamic parameters of the block available with the selected
% customization filter
) Diagnostic Shows/hides all diagnositic parameters of the block available with the selected
E! customization filter
Service Shows/hides all service parameters of the block available with the selected customization
({Q filter
Operate Shows/hides all operational parameters of the block available with the selected
@ customization filter
Alarm Shows/hides all alarm parameters of the block available with the selected customization
Tune Shows/hides all tuning parameters of the block available with the selected customization
H filter
H Local Shows/hides all local parameters of the block available with the selected customization
filter

4.4.2 Edit confirmation

Edit confirmation confirms a change in parameter

Button

Name

Function

=

Confirmed Edit

m [f this button is pressed, parameter changes are confirmed by the End Edit button or by
pressing the Enter key on the keyboard

= f this button is not pressed, parameter changes are confirmed by the End Edit button,
by pressing the Enter key on the keyboard or by clicking on any other parameter

Endress+Hauser
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4.4.3 Column display

Colum display hides or displays particular columns

Button |Name Function
= Column Relative | Shows/hides the Relative Index column
=+ | |Index
’ Column Handling |Shows/hides the Handling column
==
aLiRel | Column Standard | Shows/hides the Standard Parameter Name column when aliases are in use
&:I.r' Parameter Name

4.4.4

Customization filters

Customization filters determines which parameters are shown in the characterization dialogs

Button |Name Function

Hij No Customization | When no parameter filter is active, displays all available block parameters

OEF Customization by | When no parameter filter is active, displays all available block parameters that are defined
ﬂ Type (Default) by Application Designer as active by default

1vpE | | Customization by | When no parameter filter is active, displays all available block parameters that have been
ﬂ Type defined by the user

TRE Customization by | When no parameter filter is active, displays all available block parameters that have been
ﬂ Tag defined by the user

4.4.5 Value filters

Value filters determine how particular values are to be displayed

Button

Name

Function

v

=

Mark to Save

m This button is only available in the On Line Characterization Toolbar.
m (Click to save a parameter value even if it was not edited.
— The parameter will be marked with a V in the Changed column.
— The user can also use the button to unmark a parameter that changed value but the
changes are not to be saved

Show Value as

Toggles between hexadecimal and decimal representation of the parameter value.

=
S

EF Symbol — Can be used to display strings such as those in status or mode block information as
[P hexadecimal values or to enter values via SCADA/HMI
@ Show/Hide DD Shows/hides the DD online help text to the selected parameter (appears at foot of dialog)
Help
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4.5

Device Exchange Deviations toolbar

The Device Exchange Deviations toolbar allows you to display and classify differences between
parameters and blocks of an existing and exchange device. It is used when a device is exchanged
for a new device via the "Exchange" function.

If there are no differences between the devices to be exchanged, the toolbar does not appear.

Button |Name Function
i El Refresh Nodes Displays all nodes
By
&% Expand Nodes Expands the nodes of the device at the point of selection
¥
r' wa | | Collapse Nodes Collapses the nodes of the device at the point of selection
fg OK Accepts the exchange and closes the dialog
6 Cancel Cancels the exchange
? Help Opens the appropriate page of the Online Help
L=
Not Apply Severity | m As icon: Attribute is compliant with the old device.
Filter m As key: Display all non-critical parameters in righthand pane, starting at selected node

Low Severity Filter

m Asicon: Attribute is not compliant with the old device, but the information will not be
lost.
m As key: Display all low severity parameters in righthand pane, starting at selected node

High Severity Filter

m Asicon:Attribute is not compliant with the old device
— The information must be converted or, if this is not possible, will be lost
m As key: Display all high severity parameters in righthand pane, starting at selected node

All Severity Filter

Displays all attributes in righthand pane, starting at selected node
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4.6 PROFIBUS Configurator toolbar

The toolbar in the PROFIBUS Configurator program allows you to add masters and slaves to the
PROFIBUS create, open and save projects should the program be opened independent of Application

Designer.

Button |Name Function
New Creates a new project
Open Opens an existing project
Save Saves the project

- Not used with Application Designer

About Opens the About window of PROFIBUS Configurator

Insert Master Inserts a master device in the PROFIBUS
— Press on the button, move the "M" cursor to the position on the bus, then right-click

Insert Slave Inserts a slave in the PROFIBUS
Press on the button, move the "S" cursor to the position on the bus, then right-click

- Not used with Application Designer

& e [ (= ¢ D R (O

Insert Slave from | Inserts a slave in the PROFIBUS based on a PDD file

PRO[ | PDD File
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5 Context Menus

The context menus are decribed with reference to the default names assigned to the nodes in the
plant tree by Application Designer as the project is created and bridges, gateways etc. added. The
chapter is subdived into seven sections each describing a particular window.

5.1 Project window

The Project window is the entry point of every project and contains both the logical and physical
projects in one navigation tree. The various auxiliary windows can be opened by double-clicking
on the Process Cell, HSE Network, Fieldbus and Profibus nodes or using the Expand... context

menu.

=
E-(@ Areal
BP Process Cell 1
- fli Fisldbus Networks
= () HSE HOST 1

=T

- && HSE Netwark 1
=) &g Bridgs_1
&% Fieldbus 1
- G Gateway_1
LB Profibus 1

Fig. 5-1: Project window showing project "Plant" with bridge, gateway, Fieldbus and Profibus added

5.1.1 Plant node

Node Context menu Function
Plant Consolidate OPC Merges the tag lists from two or more configuration files into a single
Database OPC Database

» In the Consolidate OPC Database dialog:

— Press the Add This button

— Confirm the action with Yes

— The current project tags are added to the database
m Repeat for all other projects involved
m The tag lists of the projects displayed are merged

Update OPC Database

Updates the OPC database
— Quit the OPC Database Update message box with OK

Export Tags... Exports the project tags to the OPC database
— Should be done before every on-line operation unless automatic
export of tags has been set in Preferences
— Quit the Export Tags message box with OK
Export Configuration... |Exports the project configuration to a file data source (shared with other

machines) or to a machine data source (machine-specific), e.g. Excel.
= In the Select Data Source dialog
— Select a file or data source or
create a new data source
— Click OK to make the connection
= Application Designer exports the configuration to the selected data
source

Attribute...s

Allows the attributes of the Plant node to be changed
= In the Plant dialog:

— Enter an plant tag name

— Press OK to save the changes
m The plant name is changed
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5.1.2 Areanode

Node Context menu Function

Area New Process Cell Adds a new Process Cell to the Area node
m In the Process Cell dialog
— Enter a Process Cell tag name
If no name is entered, default tag is Process Cell n
— Press OK to create the Process Cell
Attributes... Allows the tag name of the Area node to be changed:
m In the Area dialog
— Enter an area tag name
— Press OK
m The area name is changed

5.1.3 Process Cell node

Node Context menu Function
Process Cell Expand Opens Process Cell window (logical project)
Delete Process Cell Deletes the selected Process Cell from the Area node

m In the Process Cell confirmation message
— Press Yes to delete
— Press No to cancel the action

5.1.4 Fieldbus Networks node

Node Context menu Function

Fieldbus Networks | Communication Settings |Selects the OPC server to which to process data are exported
m In the Communications Settings dialog

— Select the OPC server from the pull-down menu

— Press OK to make the connection
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5.1.5 HSE Network node

Node

Context menu

Function

HSE Network

Expand

Opens HSE Network window (physical project)

New => Bridge

Adds a new (FF H1) bridge to the HSE Network node
= In the New Bridge dialog (Default: SFC162)
— Enter a tag name
If no tag is entered, default tag is Bridge_n
— Press OK to create the new bridge

New =>Gateway

Adds a new (PB DP) gateway to the HSE Network node
» [n the New Gateway dialog (Default: SFC173)
— Enter a tag name
If no tag is entered, default tag is Gateway_n
— Press OK to create the gateway

New =>Device

Adds a new HSE device to the HSE Network node
(Currently not possible, because no HSE devices available)

New => Bridge from
Template

Adds a new (FF H1) bridge from a template to the HSE Network node
= In the Open dialog, browse to and select the bridge template file

— Click Open to confirm the selection

— Click OK to import the template
n In the Tag Table dialog

— Right click on "Bridge" to rename, is required

— Press OK to add the bridge to the HSE Network

New => Device from
Template

Adds a new HSE device from a template to the HSE Network node
(Currently not active because no HSE devices are available)

Assign All Tags

When online and after the all Device IDs have been set in their
Attributes Dialog, downloads the tag names used in the project to the
corresponding field devices
= Press the Online button to put the project online
= Call the Attributes context menu of every HSE and FF device and in

the Device Attribute dialog:

— Select the Device ID from the drop-down menu

— Press OK to implement changes

— Wait until the red cross at the side of the device icon disappears
m Call the Assign All Tags menu

— A progress dialog appears

— After some time, the each Device Tag changes

Live List...

When online, generates the HSE live list in a separate window

Download

When online, downloads the project to the Field Controller SFC162 or
SFC173
m Establish connection to the Field Controller
m Press the Online button
= In the Download - Fieldbus Networks dialog:
— If appropriate, check Incremental Download and Compare
Parameters to download changes to strategy
(unaffected local I/0 retain last value during download)
— Press Start to begin the download
After a successful download the dialog closes,
otherwise error messages are displayed at the bottom of the screen

Attributes...

Allows the HSE Network attributes to be changed
= In the Fieldbus Attributes dialog

— Change the tag name of the fieldbus or

— If online, change the Schedule

— Press OK to implement the changes
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5.1.6 Bridge node

Node

Context menu

Function

Bridge

New Fieldbus...

Adds a new H1 fieldbus to the Bridge node
m In the Fieldbus Attributes dialog
— Enter a tag name
If no tag is entered, default tag is Fieldbus_n
— Enter the port on the SFC162 to which the fieldbus is connected
— Press OK to attach fieldbus to bridge

Delete Bridge

Deletes the selected bridge from the Fieldbus node
» In the Bridge confirmation message

— Press Yes to delete

— Press No to cancel the action

Assign All Tags

When online, assigns all tags on the fieldbus to the appropriate devices
For details see Chapter 5.1.5

Update

When online, updates the configuration database in the Field Controller
for the device connected to the bridge

Download

When online, downloads the partial project starting at the selected
bridge to the Field Controller SFC162
— If the bridge has HSE links, download from HSE Network only
m Establish connection to the Field Controller
m Press the Online button
» In the Download - Fieldbus Networks dialog:

— If appropriate, check Incremental Download and

— Compare Parameters to download changes to strategy

(unaffected local /0 retain last value during download)

— Press Start to begin the download
After a successful download the dialog closes, otherwise error messages
are displayed in a log at the bottom of the screen

Download Bridge Only...

When online, downloads the bridge configuration only to the Field
Controller SFC162, see Download above.

FB Schedule Download...

When online, downloads the FB Cycle Time after:
m optimization of execution time of hybrid block function
m change in the order of execution of the function blocks, see 5.4.7

Attributes...

Allows the tag name of the bridge and FB cycle time to be changed and
when on-line, the Device ID to be assigned
» In the Bridge Attributes dialog:
— Enter the new bridge tag
— Select the bridge Device ID from the drop-down menu
— Press OK to implement changes
m When the Device ID is assigned, the red cross at the side of the icon
disappears

Exchange...

When Offline, allows the bridge type to be exchanged:
m Select the bridge and call the Exchange context menu
m In the Exchange dialog
— Edit the bridge attributes and click OK.
— On successful exchange, press OK to close the message
m If the Incompatibilities dialog appears
— Press Yes to automatically update the project or
— Press No to manually update the project - the Device Exchange
Deviations dialog appears
— On successful exchange, press OK to close the message
When Online, allows exchange with a bridge of the same type
m Select the bridge and call the Exchange context menu
m In the Exchange dialog
— Select the Device ID from the drop-down menu and click OK.
— On successful exchange, press OK to open the Assign Tag and
Download dialog
— Press Start to start the download
— On successful completion press Close to close the dialog
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5.1.7 Gateway node

Node Context menu Function
Gateway New PROFIBUS Starts Profibus Configurator and adds a Profibus to the Gateway node,
see Chapter 5.6 and Application Designer: PROFIBUS Tutorial,
BA036S/04/en
» In the PROFIBUS dialog:
— Enter a tag name
— If no entry is made the tag Profibus_n is assigned
— Press OK
m In Profibus Configurator:
— Add the devices to the PROFIBUS network
— Assign the PROFIBUS addresses
— Configure the cyclic communication
— Configure the bus parameters and exit the program
» In the PROFIBUS 1/0 Mapping Table
— If necessary map the data provided by remote 1/Os
— Confirm the mapping
= The information is mapped to PROFIBUS function blocks and the
PROFIBUS with devices is added to the Gateway
Import PROFIBUS Project | Adds a preconfigured PROFIBUS to the Gateway node

= In the PROFIBUS dialog
— Enter a tag name
— If no entry is made the tag Profibus_n is assigned
— Press OK
m In the Importing from PROFIBUS Database dialog
— Browse and select the project file
— Press Open to import the file
= In PROFIBUS Configurator:
— If necessary modify the configuration
— Exit the program
= In the PROFIBUS Mapping Table
— If necessary map the data provided by remote 1/Os
— Confirm the mapping
m The information is mapped to PROFIBUS function blocks and the
PROFIBUS with devices is added to the Gateway

Delete Gateway

Deletes the selected Gateway from the Profibus node
= In the Gateway confirmation message

— Press Yes to delete

— Press No to cancel the action

Download

When online, downloads the partial project starting at the selected
gateway to the Field Controller SFC173
— If the gateway has HSE links, download from HSE Network only
m Establish connection to the Field Controller
m Press the Online button
= In the Download dialog:
— If appropriate, check Incremental Download and Compare
Parameters to download changes to strategy
(unaffected local /0 retain last value during download)
— Press Start to begin the download
After a successful download the dialog closes, otherwise error messages
are displayed in a log at the bottom of the screen

FB Schedule Download...

When online, downloads the FB Cycle Time after:
m optimization of execution time of hybrid block function
= change in the order of execution of the function blocks, see 5.4.7

Attributes...

Allows the tag name of the bridge and FB cycle time to be changed and
when on-line, the Device ID to be assigned
= In the Gateway Attribute dialog:
— Enter the new gateway tag
— Select the gateway Device ID from the drop-down menu
— Press OK to implement changes
= When the Device ID is assigned, the red cross at the side of the icon
disappears

Exchange...

Allows the Gateway to be exchanged, see 5.1.6
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5.1.8 Fieldbus node

Node Context menu Function
Fieldbus Expand Opens Fieldbus window
Assign All Tags When online, assigns all tags on the fieldbus to the appropriate devices
For details see Chapter 5.1.5
Download Downloads the partial project starting at the selected fieldbus to the

Field Controller SFC162
m Establish connection to the Field Controller
m Press the Online button
m In the Download dialog:
— If appropriate, check Incremental Download and Compare
Parameters to download changes to strategy
(unaffected local /0O retain last value during download)
— Press Start to begin the download
After a successful download the dialog closes,
otherwise error messages are displayed in a log at the bottom of the
screen

Configure Device Class

When online, allows a device to be selected as backup LAS
m Press the Online button
m Select the Fieldbus, then Configure Device Class
» [n the Device Class dialog,
— Select the device(s) you want as backup LAS
— Press >> to move them to the righthand pane
For devices with no LAS capability, an error message appears
— Press Apply to download the Device Class and Traffic Schedule to
the devices
LAS backup devices can also be selected offline, however, they do not
assume the function until selected in online mode.l

Delete Fieldbus

Deletes the selected Fieldbus from the Bridge node
m In the Fieldbus confirmation message

— Press Yes to delete

— Press No to cancel the action

5.1.9 Profibus node

Node

Context menu

Function

Profibus

Expand

Opens Profibus window

Download

When online, downloads the partial project starting at the selected
fieldbus to the Field Controller SFC173
m Establish connection to the Field Controller
m Press the Online button
» In the Download dialog:
— If appropriate, check Incremental Download and Compare
Parameters to download changes to strategy
(unaffected local I/0 retain last value during download)
— Press Start to begin the download
After a successful download the dialog closes,
otherwise error messages are displayed in a log at the bottom of the
screen

Delete Profibus

Deletes the selected Profibus from the Gateway node
m In the Profibus confirmation message

— Press Yes to delete

— Press No to cancel the action
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5.2 Process Cell window

The Process Cell window contains the logical project and includes the Control Modules and the
function blocks available or already used to construct the control strategies. Every Control Module
is associated with a Strategy window, which is opened by a double-click on the node or the
Strategy... context menu. Since the Strategy window takes the tag of the associated Control
Module by default, it is referred to as the "Control Module window" throughout this manual.

=

Process Cell 1
e

Control Module 1
Control Module 1_PID_1

E--Th Profibus_Device_1_PA_AI_L

< MODE_BLK

< PLINPUT_YALUE_OFFSET

< PLINPUT_STATUS_OFFSET
Control Module 1_A0_1

£ 3-2r Frocess Cell window S/owing Control Module withz 2 Olock crezred for e feld Controller SFCI7S and
Melso valve as well as & block allacied j7om @ FPROHBUS device. 77e "?" in tre block icon mndicales thar e
Olock fias St lo be allaclied lo tre plyiscal device in e Frofious network

5.2.1 Process Cell node

Node

Context menu

Function

Process Cell

New Control Module

Adds a new Control Module to the Process Cell node

= In the Control Module dialog
— Enter a Control Module tag
— If no entry is made the tag Control Module n is assigned
— Press OK to create the new module

Paste Control Module

Pastes a cut or copied control module to the selected node

Attributes

Allows the tag of the Process Cell to be changed

5.2.2 Control Module node

Node

Context menu

Function

Control Module

Strategy

Opens the Control Module window

New Block

Adds a function block to the Control Module node
= [n the New Block dialog
— Select the Manufacturer, Device Type and
Block Type from the drop-down menu
— If appropriate, enter a Block Tag
— Ifno tag is entered, the Block is created with its generic tag
according to the settings of the Block Preferences, Chapter 3.1.6
m The new block is added to the Control Module node

Paste Block

Pastes a cut or copied block to the selected node

Attach Block

Attaches a device block to the Control Module node
= In the Attach Block dialog

— Select the block from the drop-down list

— Press OK to attach the block to the Control Module
m The block is attached and renamed as appropriate

Cut Control Module

Cuts selected control module and places it on the clipboard

Copy Control Module

Copies selected control module and places it on the clipboard

Paste Control Module

Pastes a cut or copied control module to the current node

Delete Control Module

Deletes the the selected Control Module node
— Confirm your action with Yes

Attributes...

Allows the attributes of the Control Module to be changed

— Tag: the tag of the control mdule

— Stale Count: number of macrocycles that may elapse in the link
publisher before a signal is sent indicating that there has been no
update of the link data.
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5.2.3 <FB Tag> node

Node

Context menu

Function

<FB Tag> node

Off Line Characterization

Allows the properties of the device function block to be characterized
m In the Off Line Characterization dialog
— Expand the parameter you wish to change
— Double-click on the "Value" space
— Enter the parameter or select a value from the drop-down menu
— Press End Edit to store the parameter
m Repeat for all parameters that have to be characterized
m Press Close to close the dialog

Customize
Characterization

Allows the user to define block parameters that appear in the
Characterization dialogs
» [n the Customization: <Block> dialog
— Select the Tab Default, Type or Tag
— Select the parameters required and move to the righthand window
with the ">>" button
— Press Apply to apply your changes
— Press OK to close the dialog
m Default: Parameters valid for all blocks
Type: Parameters valid for all blocks of the same type,
Tag: Parameters valid for the particular block only

Cut Block

Cuts selected block and places it on the clipboard
— Not possible for PROFIBUS 1/0 blocks

Copy Block

Copies selected block and places it on the clipboard
— Not possible for PROFIBUS 1/0 blocks

Paste Block

Pastes a cut or copied block to the current node

Delete Block

Deletes the selected block from the Control Module node
— Confirm your action with Yes in the message box that appears
— Not applicable to PROFIBUS function blocks

Detach Block

Detaches the selected block from the Control Module node
— The block is still present in the control strategy
— The block is still present in the device

On Line Characterization

Allows the properties of the device function block to be characterized
and observed in online mode
m In the On Line Characterization dialog
— Set MODE_BLK.TARGET to OOS
— Expand the parameter you wish to change
Double-click on the "Value" space
Enter the parameter or select a value from the drop-down menu
— Press End Edit to store the parameter
m Repeat for all parameters that have to be characterized
m Set MODE_BLK.TARGET back to its original state
m Press Close to close the dialog

Attributes

Allows the block attributes to be viewed and the Block Tag to be
changed
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5.2.4 <Hybrid FB Tag> node

Node Context menu Function
<Hybrid FB Tag> Map [/0Os to Hybrid Opens the [/0O Mapping tool dialogue
node Block = See Chapter 6.5.14 and 6.11

Program Hybrid Block

Allows the Hybrid Function Block to be programmed
= Create the block and/or strategy
m Activate the menu by attaching the block to both a Control Module
node and a Bridge or Gateway node
= In the Hybrid 1/0 block Attributes dialog
— Select the [EC 61131-3 programming language
— Tick whether the a FF datat structure mapping is required
= Right click and select Program Hybrid Block
= In Open PCS
— Program the block in accordance with the Ladder Logic Tutorial
BA038S/04/en, Structured Text Tutorial BAO56S/04/en
or the instructions in the OpenPCS manual
m After connecting to the Field Controller
— Download the project from Application Designer
— Download the block configuration from Open PCS
Close OpenPCS

Off Line Characterization

See Chapter 5.2.3

Customize See Chapter 5.2.3

Characterization

Cut Block Cuts selected block complete with [EC 61131 programming and places
it on the clipboard

Copy Block Copies selected block complete with IEC 61131 programming and
places it on the clipboard

Paste Block Pastes a cut or copied complete with IEC 61131 programming block to
the current node

Delete Block See Chapter 5.2.3

Detach Block See Chapter 5.2.3

On Line Characterization

See Chapter 5.2.3

Attributes

Allows the block attributes to be viewed and the Block Tag to be
changed, sets programming language and data mapping

5.2.5 <Parameter> node

Node

Context menu

Function

<Parameter>

Rename

Creates an alias for the block parameter, provided the alais function has
been activated in the Project File => Strategy preference dialog, see
Chapter 6.2
= In the Rename dialog

— Type in the alais name you require

— Press OK

— The name is changed in all windows containing a reference to the

parameter

Delete Parameter

Deletes the selected parameter
— Confirm your action with Yes in the message box

5.2.6 Drag&Drop

Node

Context menu

Function

<FB Tag> node

Drag&Drop

m Creates the selected function block in the Control Module window
— Drag the block to the Control Module window and drop it
Assigns the selected function block to a device in the physical project
— Drag the block from the Control Strategy window to the Fieldbus,
Profibus (controller only) or HSE Network window

Place it on the FB VFD node of the target device and drop it
Depending on your tag haming policy the hame will change in the
Control Module window

— The question mark in the block icon disappears
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5.3 Control Module window

In comparison to the other windows, the Control Module window has no navigation tree, but a
graphical workspace for the contruction of control stategies. Most users will be happy to use the
toolbar keys to create their strategies, see Chapter 4.2, but there are a number of context menus
and other functions that can also be called from the graphical elements themselves: these are
described here.

The drawing functions are described in Chapters 3.9 and 4.3. These affect only the colors, shapes,
font, alignment etc. and have no relevance to the project itself.

[ Control Madule 1 Lo =l

Control Module 1_AI_1 |

ouT |
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PR Control Module 1_PID_1
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|»

BKCAL OUT ™ CAS N

our : out
Profibus_Device_1_PA_Al_T  [---c-mmmmome-2 Control Module 1_PID_ 2 |--nreoomeooed r= Control Module 1_AQ_1
N CAS-IM
BKCAL IN- + " BKCAL_OUT
< | * 4

A 3=3: Control Module window skowing tie workspace, £iniclion Llocks and Furclion Block ks

5.3.1 Workspace

Element Context menu Function
Workspace Object Properties - Sets the default line thickness, fill colour and text attributes of the
Default graphical objects
— See Chapters 3.9 and 4.3
Drawing Properties Sets the drawing properties of the workspace (grid, colors, background
image etc.)
— See Chapters 3.9 and 4.3
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5.3.2 Function Block

Element

Context menu

Function

Function block
object

Delete

Deletes the selected block

u [n the Function Block Deletion dialog

— Select Yes to delete the block completely

— Select No to delete the block from the drawing only

Off Line Characterization

Allows the properties of the device function block to be characterized
= In the Off Line Characterization dialog
— Expand the parameter you wish to change
— Double-click on the "Value" space
— Enter the parameter or select a value from the drop-down menu
— Press End Edit to store the parameter
= Repeat for all parameters that have to be characterized
= Press Close to close the dialog

Show Hidden Links

Restores any links "deleted" with OK in the Link Deletion dialog

Same Width and Height

Redraws the function block object as a square, a square with rounded
corners or a circle

Show Info

Adds the block desciption to the block tag

Properties

Allows the line thickness, fill colour and text attributes of the function
block object to be changed
— See Chapters 3.9 and 4.3

5.3.3 Function Block link

Element

Context menu

Function

Function Block link
object

Delete

Deletes the selected link
u [n the Link Deletion dialog
— Select OK to delete the link completely

Labels

Sets the labels to be shown in the strategy
= Show Output Parameter
= Show Input Parameter

Properties

Allows the line thickness, fill colour and text attributes of the function
block object to be changed
— See Chapters 3.9 and 4.3

5.3.4 Function Block Link label

Element

Context menu

Function

Function Block link
label

Rename

Creates an alias for the block parameter (= link label), provided the alais
function has been activated in the Project File => Strategy preference
dialog, see Chapter 6.2
= In the Rename dialog

— Type in the alais name you require

— Press OK

— The name is changed in all windows containing a reference to the

parameter

Delete

Deletes the selected link
m [n the Link Deletion dialog
— Select OK to delete the link completely

Properties

Allows the line thickness, fill colour and text attributes of the function
block object to be changed
— See Chapters 3.9 and 4.3
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5.4 HSE Network window

The HSE Network window opens when the HSE Network node in the Project window is
double-clicked or the Expand... command is called from the View or context menu. It can be used
to engineer and/or configure all HSE devices in the project, i.e. bridges, gateways and HSE
equipment. To this end, it gives access to the function blocks and parameters associated with the
bridges and gateways and allows additional devices and blocks to be added to the project. The
chapter is structured according to the navigation tree hierarchy and starts with the HSE Network
node.

=

HEE HOST 1
£ g Bridge_1
@ ms

- [@ Feap

Bridge_1_RS_1

[ Bridge_1_TRDIDSH_L
O Bridge_t_HC_L
[0 Eridge_1_DIAG_1
£ 4 Bridge_1_PID_1
© PV_SCALE
& OUT_SCALE
£ Gy Gateway_1
@ ms
- [@ Feap
Gateway_1_RS_1
[ Gateway_1_PETRD_I
[ Gateway_1_DIAG_L
@ [ Gateway_1_HC_1

Fig. 5-1: HSE window showing project HSE network, bridge, gateway nodes with associated blcoks and parameters

5.4.1 HSE Network node

The context menus offered by the HSE Network node are identical to those described in
Chapter 5.1.5.

Node Context menu Function
HSE Network New => Bridge Creates a new bridge for a FOUNDATION Fieldbus network

For details see Chapter 5.1.5

New =>Gateway Creates a new gateway for a PROFIBUS DP network
For details see Chapter 5.1.5

New =>Device Creates a new HSE device
For details see Chapter 5.1.5

New => Bridge from Creates a new bridge from a bridge template

Template For details see Chapter 5.1.5

New => Device from Creates a new HSE device from a HSE device template

Template For details see Chapter 5.1.5

Assign All Tags When online, assigns all tags on the fieldbus to the appropriate devices
For details see Chapter 5.1.5

Live List... When online, generates the HSE live list in a separate window

Update When online, updates the configuration database in the Field Controller
for the devices connected to the HSE Network

Download When online, downloads the project to the Field Controller SFC162 or
SFC173
For details see Chapter 5.1.5

Attributes... Allows the HSE Network attributes to be changed
For details see Chapter 5.1.5
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5.4.2 Bridge node

The context menus offered by the Bridge node in the HSE Network window are, with the exception
of Delete Bridge (not available) and Assign Tag, the same as those described in Chapter 5.1.6.

Node

Context menu

Function

Bridge

Assign Tag

When online and after the Device ID has been set in the Attributes
Dialog, downloads the Tag name used in the project to the field device
= Press the Online button to put the project online
m Call the Attributes context menu and in the Bridge Attributes dialog:

— Select the Device ID from the drop-down menu

— Press OK to implement changes

— Wait until the red cross at the side of the bridge icon disappears
m Call the Assign Tag menu

— A progress dialog appears

— After a short period of time, the Bridge Tag in the HSE Live List

and Network windows changes

Download

When online, downloads the partial project starting at the selected
bridge to the Field Controller SFC162
For details see Chapter 5.1.6

FB Schedule Download...

When online, downloads the FB Cycle Time after:
m optimization of execution time of hybrid block function
= change in the order of execution of the function blocks, see 5.4.7

Attributes...

Allows the tag name of the bridge to be changed and when on-line,
the Device ID to be assigned. For details see Chapter 5.1.6

Exchange...

Allows the bridge to be exchanged. For details see Chapter 5.1.6

5.4.3 Gateway node

The context menus offered by the gateway node in the HSE Network are, with the exception of
Delete Gateway (greyed) and Assign Tag, the same as those described in Chapter 5.1.7.

Node Context menu Function
Gateway Assign Tag When online and after the Device ID has been set in the Attributes
Dialog, downloads the Tag name used in the project to the field device
= Press the Online button to put the project online
= Call the Attributes context menu and in the Gateway Attributes
dialog:
— Select the gateway Device ID from the drop-down menu
— Press OK to implement changes
— Wait until the red cross at the side of the gateway icon disappears
m Call the Assign Tag menu
— A progress dialog appears
— After a short period of time, the Gateway Tag in the HSE Live List
and Network windows changes
Download When online, downloads the partial project starting at the selected
gateway to the Field Controller SFC173
For details see Chapter 5.1.7
FB Schedule Download... | When online, downloads the FB Cycle Time after:
= optimization of execution time of hybrid block function
= change in the order of execution of the function blocks, see 5.4.7
Attributes... Allows the tag name of the gateway to be changed and when on-line,
the Device ID to be assigned. For details see Chapter 5.1.7
Exchange... Allows the gateway to be exchanged. For details see Chapter 5.1.6
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5.4.4 FBAP node

Node

Context menu

Function

FBAP

New Block

Adds a new block to the Bridge, Gateway or HSE device node
» In the New Block dialog
— Select the Block Type from the drop-down menu
— If appropriate, enter a Block Tag
— If no tag is entered, the Block is created with its generic tag
according to the settings of the Block Preferences, Chapter 3.1.6
m The new block is added to the FB VFD node of the bridge/gateway

Paste Block

Pastes a cut or copied block to the selected node

Attach Block

Attaches a block from the Control Module node to a bridge or gateway
» In the Attach Block dialog

— Select the block from the drop-down list

— Press OK to attach the block to the bridge/gateway
m The block is attached an renamed as appropriate

Block List

When online, lists in the Block List dialog, the blocks that are
instantiated in the delected device

5.4.5 <FB Tag> node

Node

Context menu

Function

<FB Tag> node

Off Line Characterization

Allows the properties of the device function block to be characterized
» [n the Off Line Characterization dialog
— Expand the parameter you wish to change
— Double-click on the "Value" space
— Enter the parameter or select a value from the drop-down menu
— Press End Edit to store the parameter
m Repeat for all parameters that have to be characterized
m Press Close to close the dialog

Customize
Characterization

Allows the user to define block parameters that appear in the
Characterization dialogs
m In the Customization: <Block> dialog
— Select the Tab Default, Type or Tag
— Select the parameters required and move to the righthand window
with the ">>" button
— Press Apply to apply your changes
— Press OK to close the dialog
m Default: Parameters valid for all blocks
Type: Parameters valid for all blocks of the same type,
Tag: Parameters valid for the particular block only

Cut Block

Cuts selected block and places it on the clipboard

Copy Block

Copies selected block and places it on the clipboard

Paste Block

Pastes a cut or copied block to the current node

Delete Block

Deletes the selected block from the Bridge or Gateway node
— Confirm your action with Yes in the message box that appears

Detach Block

Detaches the selected block from the Bridge or Gateway node
— The block is still present in the control strategy

On Line Characterization

Allows the properties of the device function block to be characterized
and observed in online mode
m In the On Line Characterization dialog
— Set MODE_BLK.TARGET to OOS
— Expand the parameter you wish to change
— Double-click on the "Value" space
— Enter the parameter or select a value from the drop-down menu
— Press End Edit to store the parameter
m Repeat for all parameters that have to be characterized
m Set MODE_BLK.TARGET back to its original state
m Press Close to close the dialog

Attributes

Allows the block attributes to be viewed and the Block Tag to be
changed
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5.4.6 <Hybrid FB Tag> node

Node Context menu Function
<Hybrid FB Tag> Map [/0Os to Hybrid Opens the [/0O Mapping tool dialogue
node Block = See Chapter 6.5.14 and 6.11

Program Hybrid Block

Allows the Hybrid Function Block to be programmed, see Chapter 5.2.4

Off Line Characterization

See Chapter 5.4.5

Customize See Chapter 5.4.5

Characterization

Cut Block Cuts selected block complete with [EC 61131 programming and places
it on the clipboard

Copy Block Copies selected block complete with IEC 61131 programming and
places it on the clipboard

Paste Block Pastes a cut or copied complete with IEC 61131 programming block to
the current node

Delete Block Deletes the selected block from the Bridge or Gateway node
— Confirm your action with Yes in the message box that appears

Detach Block See Chapter 5.4.5

On Line Characterization

See Chapter 5.4.5

Attributes

See Chapter 5.4.5

5.4.7 <Parameter> node

Node

Context menu

Function

<Parameter>

Rename

Creates an alias for the block parameter (= link label), provided the alais
function has been activated in the Project File => Strategy preference
dialog, see Chapter 6.2
= In the Rename dialog

— Type in the alais name you require

— Press OK

— The name is changed in all windows containing a reference to the

parameter

Delete Parameter

Deletes the selected parameter
— Confirm your action with Yes in the message box

5.4.8 Drag&Drop

Node

Context menu

Function

<FB Tag> node

Drag&Drop

m Creates the selected function block in the Control Module window
— Drag the block to the Control Strategy window and drop it
— A Function Block object is created in the Control Module window
— The block is added to the associated Control Module node in the
Process Cell window
= Assigns the selected function block to a Control Module
— Drag the block to the Process Cell window
— Drop it on the target Control Module node
— The block is attached to the Control Module
= Repositions the selected function block of a bridge or gateway to
determine the order of execution (Al blocks first)
— Drag the block to the required position
— Schedule can be checked with the File=>Print preview option
= Ifablock is repositioned after the project has been downloaded to the
bridge or gateway
— If necessary, go on-line
— Click on on the bridge or gateway note and open the FB Schedule
Download contect menu
— Press Yes to download the new schedule
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5.5

Fieldbus window

The Fieldbus window opens when the Fieldbus node in the Project window is double-clicked
or the Expand... command is called from the View or context menu. It can be used to engineer
and/or configure all FOUNDATION Fieldbus H1 devices in the project, i.e. measuring devices,
actuators etc. To this end, it gives access to the function blocks and parameters associated with the
fieldbus devices and allows additional devices and blocks to be added to the project. The chapter is
structured according to the navigation tree hierarchy and starts with the Fieldbus node.
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5.5.1 Fieldbus node
Node Context menu Function
Fieldbus New => Device Adds a new (FF H1) device to the Fieldbus node

» In the New Device dialog
— Select the manufacturer, device and device revisions
— Enter a Device Tag
If no tag is entered, the default tag is created according to the Tag
Policy, Chapter 3.1.6
— Press OK to create the device

New => Device from
Template

Adds a new (FF H1) device from a template to the Fieldbus node
= In the Open dialog

— Browse to and select the device template (*.dtp)

— Press Open to create the device

— In the Importing Device Template message click OK

— In the Tag Table dialog, rename tags if required, the press OK
m The device is created with the associated blocks

Assign All Tags

When online, assigns all tags on the fieldbus to the appropriate devices
For details see Chapter 5.1.5

Configure Device Class

When online, allows a device to be selected as backup LAS
For details see Chapter 5.1.81

Live List...

When online, generates the Fieldbus live list in a separate window

Update

When online, updates the configuration database in the Field Controller
for the devices connected to the Fieldbus

Upload

When online, uploads configuration of all connected devices

m Right-click on node and select Upload

m Press OK to confirm the upload

m After successful upload, right-click on plant node and select
Export Tags

Download

Downloads the partial project to the Field Controller SFC162
m Establish connection to the Field Controller
m Press the Online button
m In the Download - Fieldbus Networks dialog:
— Press Start to begin the download
After a successful download the dialog closes, otherwise error messages
are displayed in a log at the bottom of the screen

Attributes...

Allows the Fieldbus attributes to be viewed and changed
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5.5.2 Bridge node

The context menus offered by the Bridge node in the Fieldbus window are, with the exception of
Delete Bridge (not available) and Assign Tag, the same as those described in Chapter 5.1.6.

Node

Context menu

Function

Bridge

Update

When online, updates the data base in the selected bridge
— May help if a download cannot be made to particular devices

Download

When online, downloads the partial project starting at the selected
bridge to the Field Controller SFC162
For details see Chapter 5.1.6

FB Schedule Download...

When online, downloads the FB Cycle Time after:
m optimization of execution time of hybrid block function
= change in the order of execution of the function blocks, see 5.4.7

Attributes...

Allows the tag name of the bridge to be changed and when on-line,
the Device ID to be assigned
For details see Chapter 5.1.6

Exchange

Allows the bridge to be exchanged
For details see Chapter 5.1.6

Assign Tag

When online and after the Device ID has been set in the Attributes
Dialog, downloads the Tag name used in the project to the field device
= Press the Online button to put the project online
= Call the Attributes context menu and in the Bridge Attribute

dialog:

— Select the Device ID from the drop-down menu

— Press OK to implement changes

— Wait until the red cross at the side of the bridge icon disappears
m Call the Assign Tag menu

— A progress dialog appears

— After a short period of time, the Bridge Tag in the HSE Live List

and Network windows changes

5.5.3 Device node

Node

Context menu

Function

Device

Update

When online, updates the data base in the selected bridge
— May help if a download cannot be made to particular devices

Upload

When online, uploads configuration of all connected devices
m For procedure see Chapter 5.5.1

Show all parameters
Hide parameters

Shows or hides the function block parameters beneath the <FB Tag>
node in the Fieldbus and Process Cell windows

Download

When online, downloads the partial project starting at the selected
device to the Field Controller SFC162
m Select the device and call the Download menu

— Press Start to start the download

Attributes...

Allows the tag name of the device to be changed and when on-line,
the Device ID to be assigned

Exchange

Allows the device to be exchanged for one of the same type
= In the Device Exchange Deviations dialog
— Check the severity of the device deviations
— Press OK if you decide to proceed with the exchange
— Confirm your decision with Yes to exchange the device
= (all the Device Attributes dialog and update the Device ID
» Make any adjustments to the project engineering necessitated by the
exchange

Delete Device

Deletes the selected device from the Fieldbus node
m In the Device confirmation message

— Press Yes to delete

— Press No to cancel the action

Assign Tag

When online and after the Device ID has been set in the Attributes
Dialog, downloads the Tag name used in the project to the field device
m See description in Chapter 5.5.2
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5.5.4 FBAP/FB VFD

Node Context menu Function
FBAP New Block Adds a function block to the bridge or fieldbus device
FB VFD = I|n the New Block dialog

— Select the Manufacturer, Device Type and
Block Type from the drop-down menu

— Enter a Block Tag
If no tag is entered, the default tag is created according to the Tag
Policy, Chapter 3.1.6

— Press OK to create the new block

Paste Block

Pastes a cut or copied block to the selected node

Attach Block

Attaches a Control Module block to the bridge or fieldbus device.
The order in which blocks are attached determines the sequence in
which they are executed.
= In the Attach Block dialog
— Select the block from the drop-down list
— Press OK to attach the block to the bridge or fieldbus device
— The "?" in the Control Module block icon disappears

Block List

When online, lists in the Block List dialog the blocks that are
instantiated in the delected device as well as the sequence in which
they will be executed

5.5.5 <FB Tag> node

Node

Context menu

Function

<FB Tag> node

Off Line Characterization

Allows the properties of the device function block to be characterized
» [n the Off Line Characterization dialog
— Expand the parameter you wish to change
— Double-click on the "Value" space
— Enter the parameter or select a value from the drop-down menu
— Press End Edit to store the parameter
m Repeat for all parameters that have to be characterized
m Press Close to close the dialog

Customize
Characterization

Allows the user to define block parameters that appear in the
Characterization dialogs
m [n the Customization: <Block> dialog
— Select the Tab Default, Type or Tag
— Select the parameters required and move to the righthand window
with the ">>" button
— Press Apply to apply your changes
— Press OK to close the dialog
m Default: Parameters valid for all blocks
Type: Parameters valid for all blocks of the same type,
Tag: Parameters valid for the particular block only

Cut Block

Cuts selected block and places it on the clipboard

Copy Block

Copies selected block and places it on the clipboard

Paste Block

Pastes a cut or copied block to the current node

Delete Block

Deletes the selected block from the FB VED node
— Confirm your action with Yes in the message box that appears

Detach Block

Detaches the selected block from FB VFD node
— The block is still present in the control strategy

On Line Characterization

Allows the properties of the device function block to be characterized
and observed in online mode
» [n the On Line Characterization dialog
— Set MODE_BLK.TARGET to OOS
Expand the parameter you wish to change
— Double-click on the "Value" space
— Enter the parameter or select a value from the drop-down menu
— Press End Edit to store the parameter
m Repeat for all parameters that have to be characterized
n Set MODE_BLK.TARGET back to its original state
= Press Close to close the dialog

Attributes

Allows the block attributes to be viewed and the Block Tag to be
changed
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5.5.6 <Parameter> node

Node

Context menu

Function

<Parameter>

Rename

Creates an alias for the block parameter (= link label), see Chapter 5.4.6
and 6.2

Delete Parameter

Deletes the selected parameter
— Confirm your action with Yes in the message box

5.5.7 <Hybrid FB Tag> node

Node

Context menu

Function

<Hybrid FB Tag>
node

Map 1/0s to Hybrid Opens the 1/0 Mapping tool dialogue
Block = See Chapter 6.5.14 and 6.11
Program Hybrid Block Allows the Hybrid Function Block to be programmed, see Chapter 5.2.4

Off Line Characterization

See Chapter 5.5.5

Customize See Chapter 5.5.5

Characterization

Cut Block Cuts selected block complete with IEC 61131 programming and places
it on the clipboard

Copy Block Copies selected block complete with IEC 61131 programming and
places it on the clipboard

Paste Block Pastes a cut or copied complete with [EC 61131 programming block to
the current node

Delete Block See Chapter 5.5.5

Detach Block See Chapter 5.5.5

On Line Characterization

See Chapter 5.5.5

Attributes

See Chapter 5.5.5

5.5.8 Drag&Drop

Node

Context menu

Function

<FB Tag> node

<Parameter>

Drag&Drop

m Creates the selected function block in the Control Module window
— Drag the block to the Control Strategy window and drop it
— A Function Block object is created in the Control Module window
— The block is added to the associated Control Module node in the
Process Cell window
m Assigns the selected function block to a Control Module
— Drag the block to the Process Cell window
— Drop it on the target Control Module node
— The block is attached to the Control Module
= Repositions the selected function block of a bridge or gateway to
determine the order of execution (Al blocks first)
— Drag the block to the required position
— Schedule can be checked with the File=>Print preview option
m If a block was repositioned after the project was downloaded:
— If necessary, go on-line
— Click on on the device and open the Download context menu
— Press Yes to download the new configuration

m Changes the order of the function block parameters in the block list
— This is occasionally needed when the parameters are characterized
in the wrong order for a proper download
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5.6 PROFIBUS Configurator window

PROFIBUS Configurator is invoked when the context menus New PROFIBUS... is called from the
Gateway node in the Project window or Modify PROFIBUS Configuration is called from the
Profibus node in the Profibus window.

PROFIBUS Configurator is used to configure the bus parameters of the PROFIBUS Field Controller
SFC173 as well as the slave addresses and cyclic communication parameters of the PROFIBUS

slaves. The resulting configuration is mapped into PROFIBUS function blocks, which can be used to
build control strategies in combination with other blocks in Application Designer.

The use of PROFIBUS Configurator is described in the Application Designer PROFIBUS Tutorial,
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5.6.1 Master node

Node Context menu Function
Master Cut Cuts selected device from bus
Copy Copies selected device
Paste Pastes device from clipboard onto the bus

— Paste with the Paste menu or Ctrl V

— Move the "M" cursor to the desired position
— Left-click and confirm with OK

Delete Deletes the selected device

Confirm your action with Yes

Replace Replaces a device with another
— Confirm the action, select the replacement device and press OK
Master Settings Calls the DP Master Settings dialog for configuration of the master

— The Master Settings are preconfigured for the Field Controller
SFC173 when PROFIBUS Configurator is invoked from Application
Designer

Master Configuration Sets the Tag name and PROFIBUS address of the master
» In the Master Configuration dialog:

— Enter a tag

— Enter a DP address (SFC173 has 1 by default)

— Press OK to save the changes and close the dialog

Group Assignment Acts as a filter for the Sync and Freeze global commands
= In the Group Membership dialog:
— Name and set up and configure the groups
— Press the Group Assignment button to open the corresponing
dialog
— Assign the DP slaves to the groups
— Press OK to return to the Group Membership dialog
Press OK to close the dialog and save the changes

5.6.2 Slave node

Node Context menu Function
Slave Cut Cuts selected device from bus
Copy Copies selected device
Paste Pastes device from clipboard onto the bus

— Paste with the Paste menu or Ctrl V

— Move the "S" cursor to the desired position
— Left-click and confirm with OK

Delete Deletes the selected device

Confirm your action with Yes

Replace Replaces a device with another
— Confirm the action, select the replacement device and press OK

Slave Configuration Sets up the selected DP slave
m In the Slave Configuration dialog

— Enter the slave address

— Enter the slave tag (no spaces allowed, use underscore)

— Insert the data modules for cyclic communication: use
EMPTY_MODULE/FREE_SPACE to fill in gaps left by unused
modules

— Press the DPV1 Settings button and check that the DPV1

Activated box is not checked: press OK to save the setting
Press OK to close the dialog and save the settings

Parameter Data Opens the Parameter Data dialog for the selected slave
— Required for Remote I/O, information supplied by manufacturer
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5.7 Profibus window

The Profibus window opens when the Profibus node in the Project window is selected and the
Expand... command is called from the View or context menu. It can be used to engineer and/or
configure the cyclic communication of all PROFIBUS devices in the project, i.e. measuring devices,
actuators etc. To this end, it gives access to the function blocks and parameters associated with the
PROFIBUS DP/PA devices and allows the devices and blocks to be added to the project. The chapter
is structured according to the navigation tree hierarchy and starts with the Profibus node.

loix
= && Profibus 1
-Gy CO104
@ me
=@
CO104_RS_1
[0 coto4_PETRD_L
O cotos Ho_t
[0 coto4 DIaG_t
1 coln4_TIC100
-1 COo04_FIC10L
FT101
= {& F& application
- FTI01-PA_AIL
=] FCH102Z
= & B application
T FOVI02-PA_AO_L
B 00
= {& F& application
- TT100-DP_MAIL

R

L 54 Frofibus window S/iowing Frofbus, Galeway and Device nodes with associaled blocks and paramelers

5.7.1 Profibus node

Node Context menu Function

Profibus Modify I/0O Mapping Opens the PROFIBUS 1/0 Mapping dialog

— Click on the parameter that is to be modified

— Change the configuration

— Press OK to close the dialog and save the changes

Modify Profibus Opens PROFIBUS Configurator

Configuration — See Chapter 5.6 or BA0O36s/04/en for more details

Live List... When online, generates the Profibus live list in a separate window
Download Downloads the partial project to the Field Controller SFC173

m Establish connection to the Field Controller
m Press the Online button
» In the Download - Fieldbus Networks dialog:
— Press Start to begin the download
After a successful download the dialog closes, otherwise error messages
are displayed in a log at the bottom of the screen

Attributes... Allows the Profibus attributes to be viewed and changed
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5.7.2 Gateway node

The context menus offered by the gateway node in the Profibus are, with the exception of Delete
Gateway (greyed) and Assign Tag, the same as those described in Chapter 5.1.7.

Node Context menu Function

Gateway Assign Tag When online and after the Device ID has been set in the Attributes
Dialog, downloads the Tag name used in the project to the field device
= Press the Online button to put the project online
= Call the Attributes context menu and in the Gateway Attributes

dialog:

— Select the gateway Device ID from the drop-down menu

— Press OK to implement changes

— Wait until the red cross at the side of the gateway icon disappears
= Call the Assign Tag menu

— A progress dialog appears

— After a short period of time, the Gateway Tag in the HSE Live List

and Network windows changes

Download When online, downloads the partial project starting at the selected
gateway to the Field Controller SFC173

For details see Chapter 5.1.7

FB Schedule Download... | When online, downloads the FB Cycle Time after:

= optimization of execution time of hybrid block function

= change in the order of execution of the function blocks, see 5.4.7

Attributes... Allows the tag name of the gateway to be changed and when on-line,
the Device ID to be assigned. For details see Chapter 5.1.7
Exchange Allows the gateway to be exchanged. For details see Chapter 5.1.6

5.7.3 PROFIBUS device node

Node Context menu Function
Device Attributes... Allows attributes of the PROFIBUS device to be view

— Changes can be made in the PROFIBUS /0 Mapping and Slave
Configuration dialogs (PROFIBUS Configurator) only

5.7.4 FBAP node (Gateway)

Node Context menu Function

FBAP New Block Adds a new block for to gateway
= In the New Block dialog

— Select the Block Type from the drop-down menu

— If appropriate, enter a Block Tag

— Ifno tag is entered, the Block is created with its generic tag

according to the settings of the Block Preferences, Chapter 3.1.6

= The new block is added to the FB VFD node of the bridge/gateway
Paste Block Pastes a cut or copied block to the selected node

Attach Block Attaches a Control Module block to gateway.
The order in which blocks are attached determines the sequence in
which they are executed.
= [n the Attach Block dialog

— Select the block from the drop-down list

— Press OK to attach the block to the gateway

— The "?" in the Control Module block icon disappears
Block List When online, lists in the Block List dialog, the blocks that are
instantiated in the delected device
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5.7.5 <FB Tag> node

Node Context menu Function

<FB Tag> node Off Line Characterization | Allows the properties of the device function block to be characterized
m In the Off Line Characterization dialog
— Expand the parameter you wish to change
— Double-click on the "Value" space
— Enter the parameter or select a value from the drop-down menu
— Press End Edit to store the parameter
m Repeat for all parameters that have to be characterized
m Press Close to close the dialog

Customize Allows the user to define block parameters that appear in the On Line
Characterization Characterization and Off Line Characterization dialogs
» [n the Customization: <Block> dialog
— Select the Tab Default, Type or Tag
— Select the parameters required and move to the righthand window
with the ">>" button ("<<" moves them back again)
— Press Apply to apply your changes
— Press OK to close the dialog
m Type parameters are valid for all blocks of the same type,
Tag parameters are valid for the particular block only

Cut Block Gateway only: Cuts selected block and places it on the clipboard
Copy Block Gateway only: Copies selected block and places it on the clipboard
Paste Block Gateway only: Pastes a cut or copied block to the current node
Delete Block Deletes the selected block

— Confirm your action with Yes in the message box that appears
— Not applicable to PROFIBUS devices

Detach Block Detaches the selected block from FB VFD node

— The block is still present in the control strategy

— Not applicable to PROFIBUS devices (FB Application)

On Line Characterization | Allows the properties of the device function block to be characterized
and observed in online mode
m In the On Line Characterization dialog
— Set MODE_BLK.TARGET to OOS
— Expand the parameter you wish to change
— Double-click on the "Value" space
— Enter the parameter or select a value from the drop-down menu
— Press End Edit to store the parameter
m Repeat for all parameters that have to be characterized
m Set MODE_BLK.TARGET back to its original state
m Press Close to close the dialog

Attributes Allows the block attributes to be viewed and the Block Tag to be
changed

5.7.6 <Hybrid FB Tag> node (Gateway)

Node Context menu Function
<Hybrid FB Tag> Map [/Os to Hybrid Opens the [/0O Mapping tool dialogue
node Block m See Chapter 6.5.14 and 6.11

Program Hybrid Block Allows the Hybrid Function Block to be programmed, see Chapter 5.2.4
Off Line Characterization |See Chapter 5.7.5

Customize See Chapter 5.7.5

Characterization

Cut Block Cuts selected block complete with [EC 61131 programming and places
it on the clipboard

Copy Block Copies selected block complete with IEC 61131 programming and
places it on the clipboard

Paste Block Pastes a cut or copied complete with IEC 61131 programming block to
the current node

Delete Block See Chapter 5.7.5

Detach Block See Chapter 5.7.5

On Line Characterization |See Chapter 5.7.5

Attributes See Chapter 5.7.5
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5.7.7 <Parameter> node

Node

Context menu

Function

<Parameter>

Rename

Creates an alias for the block parameter (= link label), see Chapter 5.4.6
and 6.2

Delete Parameter

Deletes the selected parameter
— Confirm your action with Yes in the message box

5.7.8 Drag&Drop

Node

Context menu

Function

<FB Tag> node

Drag&Drop

m Creates the selected function block in the Control Module window
— Drag the block to the Control Strategy window and drop it
— A Function Block object is created in the Control Module window
— The block is added to the associated Control Module node in the
Process Cell window
m Assigns the selected function block to a Control Module
— Drag the block to the Process Cell window
— Drop it on the target Control Module node
— The block is attached to the Control Module
= Repositions the selected function block of a bridge or gateway to
determine the order of execution (Al blocks first)
— Drag the block to the required position
— Schedule can be checked with the File=>Print preview option
m If a block was repositioned after the project was downloaded:
— If necessary, go on-line
— Click on on the device and open the Download context menu
— Press Yes to download the new configuration

<Parameter>

m Changes the order of the function block parameters in the block list
— This is occasionally needed when the parameters are characterized
in the wrong order for a proper download
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5.8 Live Lists

5.8.1 HSE Live List

Node

Context menu

Function

Device Tag node

Assign Tag

Allows a device tag to be assigned to the selected device
m In the Assign Tag dialog
— Enter the desired Tag
— Press OK to confirm the entry
— The device tag is downloaded to the device
(this may take several minutes)

5.8.2 Fieldbus Live List

The context menus are active only when the Device ID of one of the devices has not yet been

assigned.

ControlCare Application Designer automatically assigns H1 addresses to the field devices. The
context Set H1 Address is intended only for cases where Application Designer is being used as a
maintenance tool to set address of devices for later operation in systems requiring fixed addresses,

e.g. for Emerson or Yokogawa systems.

Node

Context menu

Function

Device Tag node

Assign Tag

Allows a device tag to be assigned to the selected device
m In the Assign Tag dialog
— Enter the desired Tag
— Press OK to confirm the entry
— The device tag is downloaded to the device
(this may take several minutes)

Configure Device Class

Allows the device class of the selected device to be changed
m In the Device Class dialog
— Select the device class from the drop-down menu
— Press Change to start the download to the device
— The device class is downloaded to the device
(this may take several minutes)

Set H1 Address

Allows a H1 address to be assigned to the selected device
m [n the Set Address dialog
— Select an address that is not used by any other device and is not in
the "unused address range"
— Press Change to start the download to the device
— The H1 address is downloaded to the device
(this may take several minutes)

First unused address assignment)
node address

Node addresses

non-visitor addresses visitor addresses
i.e.default addresses for temporary
of devices requiring (handheld) devices

0. 100 ) ST  OUT F8....... FB FC....... FF
l Il I1 I1 |
| | | [

standard, global usable No. of unused usable

and flat addresses node addresses addresses

node addresses
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6 Dialogs

This Chapter is structured according to the function of the dialog, i.e. project management,
preferences, building the logical project, building the physical project, building the control strategy,
configuring the function blocks, going on line. The dialogs in each section are listed in alphabetical

order.

6.1 Project management

6.1.1 Browse for Folder

Browses to the folder in which a file is to be stored.

Browse for Folder.

Browse For Folder

Choose directory where the project files will be saved:

2]

=nks

i

er

J My Network Places
# Recycle Bin

Make New Folder | ok |

Cancel

A

Property/Button Attribute Function/Action

Workspace - Browse to folder in which project is to be saved
Make New Folder - Create a new folder in the navigation tree

OK - Save file at position selected and close dialog
Cancel - Close dialog without saving file
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6.1.2 Export Configuration as XML
Exports the entire project into an XML file.

Export Configuration as XML...

Save in | ) My FF Project | « @ ef -

|2 My FF Project. xml

File name: My FF Project.sm Save |

Save as type: [HML Files["sml) =] Cancel
Property/Button Attribute Function/Action
Save in - Browse to folder in which project is to be saved
File name - Enter name under which project is to be saved
Save as type - Enter type of file (use default stting here)
Save - Close dialog and export configuration
Cancel - Close dialog without exporting configuration

6.1.3 Import Device Support

Imports new or missing DD, CF and GSD files into the project.

Import Device Support

Import Device Support x|

Please, confim the data of the device to be imported:

Manufacturer  Metso Automation

Device Type:  NDBOOFF

File:s:

03mot_cff

oK Cancel

Property/Button Attribute Function/Action
Manufacturer - Indicates manufacturer of device
Device Type - Indicates device type ID of device
Files - Lists the files contained in the folder

— Ifnot all files are required, select the ones you require
OK - Import the files

— A message box confirms the successful import
Cancel - Close dialog without importing device support
Help - Open the the corresponding online help page
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6.1.4

Import Project from XML

Imports and opens a previously exported project from an XML file.

Import Configuration as XML
21|
Loak jn; [ 53 My Profibus project R R e =
My Profibus project. zml

2] Profibus 1_3.xml

File pame: — [My Prafibus project sl Dpen |

Files of type:  [<ML [*.xml) =l Cancel
Property/Button Attribute Function/Action
Look in - Browse to folder in which XML file is to be found
File name - Enter name of file

= A double-click on the file located in look in fills this property

Files of type - Accept default setting
Open - Inports the selected configuration
Cancel - Close dialog without importing selected configuration

6.1.5 Open

Opens an existing project.

open E

Open

Look in: [ 3 Prajects

J R e N =

My FF Project

My FF Projsct 1

25 My Modbus Project
LZ)My Modbus Slave Project
)My Profibus project
)My Project

My Sample Project
I)Plant

() ProjectFiles
IC5econd by

) Test

) Westbrook East

Fie name: |

Open I

Files of type:  [Proiect " 1fp)

j Cancel

il

Property/Button

Attribute

Function/Action

Look in

Browse to folder in which project is to be found

File name

Enter name of project
= A double-click on on the file located in look in fills this property

Files of type

Applies filter to file type:

= Project files: *.ffp

= Strategy templates: *.fft
m Device templates: *.dtp
= Bridge templates: *.btp

Open

Open the selected file

Cancel

Close dialog without opening selected file
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6.1.6 Open Default Template

Opens a default template.

Open Default Template
x|

LELFERVERY Fieldbus Foundation

Device Type : [Standard Bl

Device Rev.: |00 =

0K | Caned | Hep |

Property/Button Attribute Function/Action

Manufacturer - Select the manufacturer from the drop-down menu

Device Type - Select the device type from the drop-down menu

Device Rev. - Select the device revision from the drop-down menu
m The latest revision is shown by default

OK - Close dialog and save changes

Cancel - Close dialog without saving changes

Help - Call the on-line help for this dialog

6.1.7 Pack Project

Packs a project ready for portation to the site computer

Pack Project
2]
Sweps [Pt -] « EICFED-
I$ENNE
Fiename: [ Save |
Save as ype: Ipatkedpvmacls[‘pcc] = | Cancel
Property/Button Attribute Function/Action
Save In Browse to folder in which project is to be saved
m Aclick on £F allows a new folder to be created
File Name Enter the name under which the project is to be packed
Save as type Apply filter to file type (in this case .pcc only)
Save - Close dialog and save changes
Cancel - Close dialog without saving changes
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6.1.8 Page Setup

Sets up a margins, size etc. for project printouts.

Page Setup
&
| Paper
Size: [as =l
Source | Automatically Select =l
| Diientation Margins [milmeters) |
& Portrait Left 4.95 Right:  [433
© Londscape | | o [455 Bottom: [4.09
[k | cancel | pine |

Property/Button Attribute Function/Action
Paper Size Select paper size from drop-down menu
Source Select paper source from drop-down menu
Orientation Portrait Check the radio button for portrait printing
Landscape Check the radio button for landscape printing
Margins Left, Right Set up the width of each margin in millimeters
Top, Bottom
Printer - Select printer (other printer functions can be accessed from here)
OK - Close dialog and save changes
Cancel - Close dialog without saving changes
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6.1.9 Print Configuration

Sets up the items to be included in a project printout.

Print Configuration

Print Configuration E

¥ Piocess Conirol Configualr | | Device Lis = ]
¥ General Irf
P | o
I FB Link: W General Information
[ T — ¥ Parameter Valuss _te |
™ FE Links
™ Multi Link Topalogw
¥ Fieldbus Carfiguration [¥ FB Link List
[V General Information ™ General Information
¥ Blocks ¥ Connected Paramete:
I FEB Links
[~ Dther Components ¥ Scheduls
Property/Button Attribute Function/Action
Process Control General Information Lists the logical project (Plant view) objects
Configuration Blocks m Tick the properties required in the printout
FB Links
Other Components
Multi Link Topology |— Prints the control strategy and lists the project links

m Tick if required in the printout

Fieldbus Configuration

General Information
Blocks

FB Links

Other Components

Lists the physical project (Network view) objects
m Tick the properties required in the printout

Device List - Lists all devices in the project with IDs and addresses
m Tick if required in the printout
Block list General Information Lists all blocks in the project together with atttributes
Parameter Values m Tick the properties required in the printout
FB Links
FB Link List General Information Lists all the function block links in the project
Connected Parameter m Tick the properties required in the printout
Schedule - Lists all objects involved with function block execution together
with the associated schedule
» Tick if required in the printout
OK - Close dialog and save changes
Cancel - Close dialog without saving changes
Help - Call the on-line help for this dialog
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6.1.10 Print Preview

Previews the project printout

Print Preview

ControlCare Application Designer - My FF Project (Preview) o [ o3}

4|y l QIQ |Pag9523nd3 él Close

Button Function

Displays the previous page

Displays the next page

. Displays the entire page on the screen

Displays two pages at the same time on the screen

Activates the Zoom tool.

Deactivates the Zoom tool.

Page... |Shows the page(s) that are being visualized at the moment

| Prints your job: When the Print Configuration dialog opens, press OK

Close Closes the Preview window and returns to the ControlCare Application Designer
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6.1.11 Save As

Saves a copy of the current project under a new name.
Save As...
savers 2| x]
Savein [ ) Projects R = = e
My FF Project [ProjectFiles
)My FF Project 1 (5)5econd try
)My Modbus Project CDTest

)My Modbus Slave Project [ Westbrook East
My Profibus projsct
-5)My Project.

File name: | Save I

Sawe as type: | Project [%fip) =l Cancel v
Property/Button Attribute Function/Action
Save in - Browse to folder in which project is to be saved
File name - Enter name under which project is to be saved
Save as type - Enter type of file (use default setting here)
Save - Close dialog and save the copy
Cancel - Close dialog without saving a copy

6.1.12 Setup New Project Workspace

Opens a new project with preliminary navigation tree.

Setup New Project Workspace

Savegn'l\-;) Projects j - £F B8

() My FF Project I ProjectFiles
)My FF Project 1 (C5econd by

My Modbus Project [Test

)My Modbus Slave Project (2] Westbrook East
()M Profibus project

My Project

File name: ] Save |

Save as ype: [Project(*fip) = Cancl
Property/Button Attribute Function/Action
Save in - Browse to folder in which project is to be saved
File name - Enter name under which project is to be saved
Save as type - Enter type of file (use default stting here)
Save - Close dialog and set up new project
Cancel - Close dialog without setting up new project
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6.1.13 Unpack Project

Unpacks a project to the selected folder of the site computer

Unpack Project
2]

okis[OParetmart =] + B ok @

Fie name:  [packed plant poc =

Fis of ype: [packed projects [ pec] B
Property/Button Attribute Function/Action
Look In Browse to folder in which project is to be found
File Name Enter the name under which the project is to be packed
Files of type Apply filter to file type (in this case .pcc only)
Open - Open the selected file and start the unpacking procedure
Cancel - Close dialog without saving changes
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6.2 Project Preferences

6.2.1 Block

Sets the preferences for the naming and handling of function block tags:

m [f a new block is created in the control strategy and the user does not define a tag, the block
tag will be generated based on the strategy tag since the block is not yet attached to any device.
m If the block is moved from one device to another, its tag will be automatically updated to that
of the destination device.
m If the user changes the device tag, the tag of all blocks attached to it will be updated.

Preferences: Block

Device Support | Default Project Path | Workspace Layout
Block Device & Bridge | Shrateqy
" Defaul

™ Update Block Tag
™ &pply Template TagInstead of Block Type Mnemanic

[ Tag Policy | Tag Compostion | Communication | Export Tag |

0K | Cancel | Heb |

Property/Button Attribute Function/Action
Tag Policy Default Sets the automatic tag format for new blocks
Device m Default: Blocks attached to a strategy or device are assigned the
Strategy tag format ['block" + separator + id number]
m Device: Blocks attached to a device are assigned the tag format
|device tag + separator + block mnemonic + id number]
m Strategy: Blocks attached to a stategy are assigned the tag format
[strategy tag + separator + block mnemonic + id number|
Update Block Tag Causes the block tag to be updated as per the tsg policy:
m when the block is moved to another device or control module
m when the device tag or the control module tag is changed
Apply Template Tag... Causes the block tag from the template file to be used instead of the

block mnemonic, when a Device, Bridge or Strategy template is
imported

Tag Composition

Mnemonic Separator

Determines the separator used in the block tag
— If hybrid function blocks are used, underscore

won

is mandatory

Use Device or Stategy...

Sets the position of the device or strategy tag
m Prefix: Device or Strategy tag is prefixed to the block tag
m Suffix: Device or Strategy tag is suffixed to the block tag

Communication Block List Events Causes Application Designer to compare the blocks attached to a
virtual device to those attached to its counterpart in in the field, for
all devices in the Fieldbus windows that are open. If the option is
not selected, the comparison is made when Block List is opened.

Export Tag Manual s Manual: Export Tags must be used to update the tag database

Automatic » Automatic: Export Tags is excuted automatically every time a
relevant online procedure requires the tag to be exported
Path Shows the location of the tag database file

OK - Close dialog and save preferences

Cancel - Close dialog and discard changes

Help - Open the the corresponding online help page
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6.2.2 Default Project Path
Sets the default project path (Setting: Endress+Hauser\ControlCare\Projects).

Preferences: Default Project Path

Block | Device & Bridge | Shrateqy
Device Support Defauit Project Path | warkspase Layout

Default Project Path

Project Path

D \apps\Endress#Hauser\ContiolCare'Prole | [ Biowse |

ok | Cancel | He
Property/Button Attribute/Subfolder | Function/Action
Deafult Project Path Project Path Type in or browse to the default path for the project
— If the path is changed during operation, the new path is taken as
default
Browse Press to browse your computer
OK Close dialog and save preferences
Cancel Close dialog and discard changes
Help Open the the corresponding online help page

6.2.3 Device & Bridge

Sets the preferences for the creation of device/bridge/gateway resource and transducer blocks.

Device Support | Defaul Froject Path | Workspace Lapout
Block Device & Bridge Strategy

Preferences: Device & Bridge

[ Cigation based on Default Template

IV Create Resource Elock

[¥ MODE_BLK TARGET Parameter /bt

[V Create Transducer Blocks

¥ MODE_BLK TARGET Parameter |Aute :I‘

0K | Cancel | Helo

Property/Button Attribute/Subfolder |Function/Action
... Default Template - Creates new devices and bridges/gateways using default templates
— Default setting, when selected the other options are grey
— If no template found, creates Resource and Transducer block
Create Resource Block |Create... Creates resource block

MODE_BLK.TARGET

Adds MODE_BLK.TARGET as selected from drop-down menu

Create Transducer
Block

Create....

Creates transducer block

MODE_BLK.TARGET

Adds MODE_BLK.TARGET as selected from drop-down menu

OK

Close dialog and save preferences

Cancel

Close dialog and discard changes

Help

Open the the corresponding online help page
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6.2.4 Device Support

Sets the default path for importing device support files (DD and CF). This is required when the
device or DD revision is not in the standard ControlCare library.

Preferences: Device Support

Block | Device & Bridge | Shrateqy
Device Support | Diefault Project Path | ‘workspace Lapout
Impor
Source Files Path e
ok | Cancel | He
Property/Button Attribute/Subfolder | Function/Action
Import Source Files Path Type in or browse to the default path for Device Support imports
— If the path is changed during operation, the new path is taken as
default
Browse - Press to browse your computer
OK - Close dialog and save preferences
Cancel - Close dialog and discard changes
Help - Open the the corresponding online help page

6.2.5 Workspace Layout

Determines how the workspace for the project is managed.

Preferences: Workspace Layout

Block | Device & Biidge | Strategy |
Device Support | Default Project Path Wiorkspace Layout
SmartTil
’VHe:a\:u\ate Iayout when any window ¥ fpens ¥ Closes
¥ Enable workspace saving
™ sk to sawve altered lapout if project is unchanged
¥ Load last used project at application startup
0K | Cancel | Hel
Property/Button Attribute/Subfolder |Function/Action
Smart Tile Recalculate layout when |Recalculates layout when checkbox ticked:
any window m Opens: recalculates when window opened
m Closes: recalculates when window closed
Persistence - Click appropriate box to:
m Enable saving of workspace
m Have program ask whether changed layout should be changed
m Have the last project used loaded on program start-up
OK - Close dialog and save preferences
Cancel - Close dialog and discard changes
Help - Open the the corresponding online help page
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6.2.6 Strategy

Determines the default shape of the function block icons in the control strategy and activates the
alias function for block parameters.

Preferences: Strategy

Device Support | Default Project Path | workspace Layout |
Black. Device & Bridge Stratey
- Function Block Ison
© Rectangle

" Elipse

& Rounded Rectangls

i~ Link.

[¥ Aliss Input Dislog Box

0K | Cancel | Helo

Property/Button

Attribute/Subfolder

Function/Action

Function Block Icon

Rectangle
Rounded Rectangle
Ellipse

Sets the shape of the function block icon used in the control strategy

Alias Input Dialog Box

When ticked enables dialog box for alias renaming during link
creation

OK - Close dialog and save preferences
Cancel - Close dialog and discard changes
Help - Open the the corresponding online help page
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6.3 Logical project

6.3.1 Area
Area
area
Tag:
[areat
Cancel Help
Property/Button Attribute/Subfolder | Function/Action
Tag - Enter the Tag Name of the Area selected
— Default: Area n, where n is a consecutive number

OK - Close dialog and save changes
Cancel - Close dialog and discard changes
Help - Open the the corresponding online help page

6.3.2 Control Module

Control Module
Tag: [Cortrol Moduls 1
Stale Count :
Property/Button Attribute/Subfolder |Function/Action
Tag - Enter the Tag Name of the new control module
— Default: Control Module n, where n is a consecutive number
Stale Count - Enter the number of macrocycles that may elapse in the link
publisher before a signal indicating that there has been no update of
the link data is sent (= bad communication)
OK - Close dialog and save changes
Cancel - Close dialog and discard changes
Help - Open the the corresponding online help page

6.3.3 Function Block Deletion

Function Block Deletion

Function Block Deletion 3 X|
4 | Doyou want b remowe Control Moduls 1_AT_1 from the Application?
\.‘/

Ta do 50, click Yes.

To remave it from the current drawing only, but not from the Application, dlick Mo,
Tin abort deletion dlick Cancel.

Property/Button Attribute/Subfolder |Function/Action
Yes - Close dialog and remove block completely from the application
No - Close dialog and remove the block from the Control Module
window only
— The block with its links remains connected to the Control
Module and, if attached, the FB VED node
Cancel - Close the dialog and do not delete the block
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6.3.4 Link Deletion

Link Deletion

Link Deletion. i x|

:‘) Do you wartt to remove the link from the Application?
-

To Remove, diick Yes.
To abort deletion click Canicel.

cancel
Property/Button Attribute/Subfolder | Function/Action
Yes - Close dialog and remove link completely from the application
No - Close dialog and hide the link in the Control Module window only
— The link can be shown with "Show Hidden Links"
Cancel - Close the dialog and do not delete the link
6.3.5 Plant
Plant
plant
Tag
Plant
Cancel Help
Property/Button Attribute/Subfolder | Function/Action
Tag - Enter the Tag Name of the plant
— Default: Name used when project created
OK - Close dialog and save changes
Cancel - Close dialog and discard changes
Help - Open the the corresponding online help page

6.3.6 Process Cell

Process Cell

Tag

[
Property/Button Attribute/Subfolder | Function/Action
Tag - Enter the Tag Name of the new process cell

— Default: Process Cell n, where n is a consecutive number

OK - Close dialog and save changes
Cancel - Close dialog and discard changes
Help - Open the the corresponding online help page
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6.3.7 Rename

Rename

Rename

Alias parameter tag :

oK I Cancel I Help |

Property/Button Attribute/Subfolder | Function/Action

Alias parameter tag - Enter the alias name for the selected link parameter
OK - Close dialog and assign alias to parameter name
Cancel - Close dialog without assigning alias to parameter name
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6.4  Physical project

6.4.1 Bridge Attributes

Genersl | FB Sohedule |

Bridge

Manufacturer |EnduesuHauser GmbH

Devies Type: [SFCTE2

Device Rev.: 02 DD Rev. : |03 CF Rev.: [01

IZ | Feflap the Latest DD and OF Hevisions ‘

Device Id

Device Tag IBndgEJ |
Device Class © [Brdze =
Upstream Port: | =l
Property/Button Attribute/Subfolder | Function/Action
General tab Manufacturer Shows manufacturer
Device Type Shows device type
Device Revision Shows device revision
Follow the latest DD | When checked, always selects the latest DD and CF file for the
and CF revisions selected device
Device ID Selected from the drop-down menu after going online
— Can be entered off-line if known
Device Tag Enter tag name for bridge
— If no name is entered, Bridge n is assigned,
whereby n is a consecutive number
Device Class Shows Device Class (SFC162 = Bridge)
Upstream Port Not used
OK Close dialog and create bridge
Cancel Close dialog and do not create bridge
Help Open the the corresponding online help page
FB Schedule Tab Unscheduled Time Time in ms allocated to unscheduled traffic

= To impose a Unschedule Time:
— Type in new value
— Press Override to calculate Schedule Duration and FB Cycle
Time
— Download with FB Schedule Download... or Download

FC Schedule Duration

Time calculated offline to complete function block execution
process

FC Cycle Time

Time calculated offline to execute complete project

Override Calculates Schedule Duration and Unscheduled Time for new FB
Cycle Time
Default Restores the schedule default values
— Download with FB Schedule Download... or Download
OK Close dialog and create bridge
Cancel Close dialog and do not create bridge
Help Open the the corresponding online help page
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6.4.2 Configure Device Class

Configure Device Class
Link Master <] change |

Status:

Elapsed Time: 0000

Property/Button Attribute/Subfolder |Function/Action
Drop-down menu - Select required device class for device
Change - Press to start download of device class to device
Download progess Status Shows status of download to device
Elapsed Time Show time download has been running
Abort Breaks off the download without the change being made

6.4.3 Device Attributes

Device

Device Attributes

Manufacturer : |Endress+Hauser GmbH

Device Type : |Eeraha| 5

Device Rev. . 05 DD Rev. : 02 CF Rev. : 02

‘ I Fallovs the Latest DD and CF Revisions ‘

Device |d

Device Tag |Device_1 j

Device Class [ =l

ok | cancel | Hep |

Property/Button Attribute/Subfolder | Function/Action

Manufacturer - Shows manufacturer

Device Type - Shows device type

Device Revision - Shows device revision

Follow the latest DD When checked, always selects the latest DD and CF file for the
and CF revisions selected device

Device ID - Selected from the drop-down menu after going online

— Can be entered off-line if known

Device Tag - Enter tag name for device
— If no name is entered, device n is assigned,
whereby n is a consecutive number

Device Class - Shows device class (Basic, Link master)

OK - Close dialog and create bridge

Cancel - Close dialog and do not create bridge

Help - Open the the corresponding online help page
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6.4.4 Device Class

Device Class - Fieldbus 1

Basic

Device 1

Device Class

Backup LAS

Property/Button

Attribute/Subfolder

Function/Action

Panes

Basic

Devices, identified with device tag, with device class basic

Backup LAS

Devices, identified with device tag, with device link master

>>

Moves selected devices from Basic to Backup LAS pane

<<

Moves selected devices from Backup LAS to Basic pane

Apply

Stores any changes in configuration and applies them to the project
— If off-line, the new Device Class is stored in the project, which
must be downloaded at a later date for the change to take effect
— If on-line, the Device Class and FB Schedule time are download
to the controller and devices (this may take some time)
— When the Device Class is downloaded, the device is restarted.
This normally occurs automatically, but for some devices it
may be necessary to restart the device manually.

Cancel

Close dialog and do not create bridge
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6.4.5 Device Exchange Deviations

This dialog appears only if a bridge, gateway or Foundation Fieldbus device is exchanged and there
are incompatibilities between it and its replacement. In this case, the user may chose to accept the
deviations automatically, in which case only unresolved deviations will appear, or manually.

m [f the exchange is made offline, it might be possible that even severe deviations can be worked
around by changing the project engineering

m [f the exchange is made online, at present only devices of the same manufacturer and type can
be exchanged

The decision to exchange depends upon the severity of the deviation and use of the blocks:

m Non-critical level requires no further action on the part of the user, other than to update the
Device ID after exchange (every FOUNDATION Fieldbus Device has a unique ID).

m A low severity level means a mismatch in device type or manufacturer, but also the absence of
a specific block. The user must decide whether he has used the missing blocks before
exchanging the device

m A high severity level means in addition the absence of specific parameters. The user must
decide whether he has used the missing parameters or whether there is a work around before
exchanging the device

Device Exchange Deviations

Device Exchange Deviations - [ Device_5 ]
JEd] plofefe]
| [ atibute [ Current [ Atemative: [ Severity
U Block Type SERV ot Found Low
o] 9 Manufscturer 0x452848 0452848 [
=48 FBVFD ¥ Device Tupe 0x1057 041058 Low
=8 @ Device 5_RS_1 ¥ Devics Revision  Dul1 0001 Nk
1o MODE_BLK 9 DD Revision 0w 001 [
[0 Device 5_TRD_1 ® CF Revision 0x02 0:02 W&
=80 Device 5TAT_1 ? DDlemid OwD00Z00E 7 Kot Found High
1o MODE_BLK T Profile 0x8209 Wot Found High
= 80 Devie 5TOT.2 ¥ Puofie Revision 040001 Mot Found High
9o MODE_BLK
t [0 Deviee5_FLOW_COMP_
t 0 Deviee 5_ADV_DIAG_1
B 90 Deviee 5_DISF_1
9<¢  MODE_BLK
B 90 Device 5_DIAG_1
9 MODE_BLK
10 A
0f Deviee 5 ALT
0 Deviee 5412
Kl |3 KX i ml
0K | Cacel | Hep |

Property/Button Attribute/Subfolder | Function/Action

Toolbar - See Chapter 4.4 and mouse-over tip for function

Deviations pane - Shows blocks and parameters of exchange device with severity level
of deviation:

— Green: no deviation

— Yellow: deviation of low severity, information will not be lost

— Red: deviation of high severity, information must be converted or
will be lost

Attributes pane Attribute Atribute under comparison together with severity icon
— Use the "I" buttons to filter according to severity

Current Value of attribute of current device
Alternative Value of attribute in exchange device
Severity Severity level of deviation

OK - Close dialog and complete the exchange

Cancel - Close dialog and do not exchange

Help - Open the the corresponding online help page
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6.4.6 Exchange

Allows the off and online exchange of a bridge, a gateway or Foundation Fieldbus device in a project.

m Offline: devices of a different type can be selected and if necessary the control strategy modified

and downloaded

m Online: the exchange would normally be for a device of the same type, and only the device ID
and perhaps device revision need be changed.

Exchange

Manufacturer [

Device Type: [SFCi62 =

Device ld:

Device Rev.: [02

| DDRev Ju3 ] CFRev: [ -]

IV Fallows the Latest DD and CF Revisions |

|4SZE4EZDT OE+H-5FC162: 71003024030

|
Device Tag: [ 7 el
7]

Device Class 1 [Hidoe

0K | Concel | Hep |

Property/Button

Attribute/Subfolder

Function/Action

Exchange

Manufacturer

Select manufacturer from drop-down menu

Device Type

Select device type from drop-down menu

Device Revision

Follow the Latest DD and CF Revisions
m Ticked: the latest version is shown by default
= Unticked: select the various revisions from the drop-down menus

Device ID

Selected from the drop-down menu after going online
— Can be entered off-line if known

Device Tag

Indicates device tag

Device Class

Read only

OK

Close dialog and start the exchange
= Application Design checks the compatibility of the current device
and its replacement
— No incompatibilities found: Press OK to close the dialog and
when online start the download of the configuration.
— Otherwise the Incompatibities dialog appears, see below

Cancel

Close dialog and do not invoke exchange

Help

Open the the corresponding online help page

Incompatibilities x|

Incompatibilities

Q

There are several blacks andfor parameters which must be reconfigured
before the exchange process can cantinde.

The most probable cause of this problem is that these blocks/parameters
may be sither partially or totally not supported by the new
revision i.e. Data types, names, etc. might have changed.

Do you wish to let ControlCare automatically delete any

incompatible blocks, parameters, and/or inks [es], or would you like
ta manually perform the exchange [No?

Ho Cancel

Yes

Automatic exchange invoked

otherwise as OK above

— Any incompatibilities are remapped or if not possible deleted,

No

Incompatibilities resolved manually in Device Exchange
Deviations dialog, see Chapters 4.4 and 6.4.5

Cancel

Close dialog and do not invoke exchange
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6.4.7 Fieldbus Attributes

Fieldbus Attributes
retdbus
Type: EE =
Tag:
Upstream Part .|1 =

Maciocycle: 250
Foreground Traffic: |30
Backaround Traffic: |160

[yermide. Default

Cancel Help

Property/Button

Attribute/Subfolder

Function/Action

Type

Indicates type of fieldbus

Tag

Enter the Tag Name of the Fieldbus selected
— Default: Fieldbus_n, where n is a consecutive number

Upstream Port

Indicates upstream port

Schedule

Macrocycle

When online, time to execute complete project
m To impose a macrocycle:
— Type in new value
— Press Override to calculate fore- and background traffic
m To return to default values:
— Press the Default button
m Call Download to download the new values to the system

Foreground traffic

Time to complete function block execution process

Background traffic

Time allocated to background traffic

Override

Calculates fore- and background traffic for new macrocycle value

Default

Restores the Schedule default values

OK

Close dialog and accept changes
— If a new macrocycle has been set, make a Bridge download to
implement the changes in the Field Controller

Cancel

Close dialog and discard changes

Help

Open the the corresponding online help page

6.4.8 Fieldbus Live List

Fieldbus Live List

e

e

G

i FF HI Live List - Fieldbus 1 (Bridge_1 Port 1) =10 x|
Device Tag Device Class Device Address _| Device 1d Manufacture Id [ rype1d [vev. rev. [ooRev. [
Devite_1 Basic 24 (018} 452648100F-6301 200 L0 452648 (Enchess+Hauser GrbH)  LOCF (Micropilot M) 03 o
Device_2 Basic 25 (019) 452B481009-821784018CC 452648 (Encress+Hauser GrbH) 1009 {Dekabar 5 05 it
TTi0L Basic 34 (Dx2z) 452B4810CC-62005F04223 452648 (Encress+Hauser GrbH)  10CC (TMT162) o1 ot
TG DEFALLT 1535 R ER 243 (04F3) 4528481007-5DY0196 452848 (Endass+Hauser GmbH) 1007 (Cersbar 5) 0 o
5 Lvz03 SR 247 (0xF7) 4526481057-79061802000 452648 (Endress+Hauser GmbH) 1057 (Prowirl 73) 01 01
@ % Bridge_{ g“::?“;z:”‘fe Class... 16 (010} 452B482010E+H-5FCH62: 71003024030 452848 (Enchess+Hauser GmbH) 2010 (SFC162) i 04
et ress

Property/Button Attribute Function/Action

Device Tag - Measuring point identification

Device Class - Device class as per FF specifications (Basic, Link, Bridge)
Device Address - Device IP address in hexadecimal notation

Device ID - Device ID as per FF specification (Manufacturer, Type, Serial No.)
Manufacturer ID - Manufacturer ID as per FF specification

Type ID - Type ID of device, where appropriate with device name
Dev. Rev. - Revision of device

DD Rev. - Revision of device description (DD)

Context Menu Assign Tag Calls the Assign Tag dialog, see Chapter 5.9.2

Device Tag Configure Device Class | Calls the Device Class dialog, see Chapter 5.9.2

Set H1 Address

Calls the Set Address dialog,see Chapter 5.9.2
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6.4.9 Gateway Attributes

General | FB Schedule |

Gateway

Manufacturer ‘EndresvH auser GmbH

Device Type ‘SFCT 73

Device Rev.: 02 DD Rew. : 04 CFRev.: 02

[V Follow the Latest DD and CF Revisiors

Device Id I 4528482030F +H-SFC173:76000F 24039 j

Device Teg . [Gatenay1 =

Device Class - [

Upstieam Part: | =1
Property/Button Attribute/Subfolder | Function/Action
General tab Manufacturer Shows manufacturer
Device Type Shows device type
Device Revision Shows device revision
Device ID Selected from the drop-down menu after going online
— Can be entered off-line if known
Device Tag Enter tag name for gateway
— Ifno name is entered, Gateway n is assigned,
whereby n is a consecutive number
Device Class Gateway
Upstream Port Not used
OK Close dialog and create gateway
Cancel Close dialog and do not create gateway
Help Open the the corresponding online help page
FB Schedule Tab Unscheduled Time Time in ms allocated to unscheduled traffic

m To impose a Unschedule Time:
— Type in new value
— Press Override to calculate Schedule Duration and FB Cycle
Time
— Download with FB Schedule Download... or Download

FC Schedule Duration

Time calculated offline to complete function block execution
process

FC Cycle Time

Time calculated offline to execute complete project

Override Calculates Schedule Duration and Unscheduled Time for new FB
Cycle Time
Default Restores the schedule default values
— Download with FB Schedule Download... or Download
OK Close dialog and create bridge
Cancel Close dialog and do not create bridge
Help Open the the corresponding online help page
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6.4.10 HSE Live List

[Bi HSE Live List - HSE Network 1 [ ]

Device Id Marnufacturs Id [ Type1d [Dev. Rev. [DDRev. |

Device Class Device Address

HSE Live List

HSE HOST 1

Hast 10.125,35.200

000000000 L:FF-HSE HOST:000000001

Q= CCOPOR2 Gateway 10.1 176 H-SFC173: 452848 (Endress-+Hauser Gmbi) 2030 (SFC173) 03 05
& i REtn hetrirasmiin eeegemn RO BB
Property/Button Attribute Function/Action
Device Tag - Measuring point identification
Device Class - Device class as per FF specifications (Basic, Link, Bridge)
Device Address - Device address in hexadecimal notation
Device ID - Device ID as per FF specification (Manufacturer, Type, Serial No.)
Manufacturer ID - Manufacturer ID as per FF specification
Type ID - Type ID of device, where appropriate with device name
Dev. Rev. - Revision of device
DD Rev. - Revision of device description (DD)
Context Menu Assign Tag Calls the Assign Tag dialog , see Chapter 5.9.1
Device Tag

6.4.11 Importing from PROFIBUS Database

Importing from PROFIBUS Database

2x|
Look jr: [ (3 Plant [ N = e ez
File pame:  [Profibus 2_6 P8 Open |
Files of type: | SyconDiatabasel* pb) =l Cancel
Property/Button Attribute Function/Action
Look in - Browse to folder in which project is to be found
File name - Enter name of project
m A double-click on on the file located in look in fills this property
Files of type - Applies filter to file type:
m PROFIBUS database: *.pb
Open - Open the selected file
— Profibus Configurator is started automaticially
Cancel - Close dialog without opening selected file
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6.4.12 New Bridge

New Bridge
Bridge | Advanced Options |
Manufacturer : [Endress+Hauser GmbH |
Device Type: [SFC162 Bl

Device Rev.+ [0z

= ooRev:[03 ] crRewfor =]

[¥ Follows the: Latest DD and CF Revisions ‘

Devieeld: |

Device Tag: |

Upstream Port: |

Concel | Hep |

Property/Button

Attribute/Subfolder

Function/Action

Bridge

Manufacturer

Select manufacturer from drop-down menu

Device Type

Select device type from drop-down menu

Device Revision

Follow the Latest DD and CF Revisions
m Ticked: the latest version is shown by default
= Unticked: select the various revisions from the drop-down menus

Device ID

Selected from the drop-down menu after going online
— Can be entered off-line if known

Device Tag

Enter tag name for bridge
— If no name is entered, Bridge n is assigned,
whereby n is a consecutive number

Upstream Port

Not used

Advanced Options
(Default settings as in
Preferences)

... Default Template

Creates new bridge using default templates
— Default setting, when selected the other options are grey
— If no template found, creates Resource and Transducer block

Create Resource Block

Create...
Creates resource block

MODE_BLK.TARGET
Adds MODE_BLK.TARGET as selected from drop-down menu

Create Transducer Block

Create....
Creates transducer block

MODE_BLK.TARGET
Adds MODE_BLK.TARGET as selected from drop-down menu

OK

Close dialog and create bridge

Cancel

Close dialog and do not create bridge

Help

Open the the corresponding online help page
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6.4.13 New Device

New Device

Device | advanced Options |

Manufactuer : [Endiess+Hauser GmbH =

Device Type: [|EVELFLEX M &

DeviceRev.: [03  »| DDRev.: [03 =] CFRev: [z =]

[¥ Follows the: Latest DD and CF Revisions |

Device ld: I
I

Devics Tag:

ik | cencel | Hep

Property/Button Attribute/Subfolder |Function/Action

Device Manufacturer Select manufacturer from drop-down menu
Device Type Select device type from drop-down menu
Device Revision Follow the Latest DD and CF Revisions

m Ticked: the latest version is shown by default
m Unticked: select the various revisions from the drop-down menus

Device ID Selected from the drop-down menu after going online
— Can be entered off-line if known

Device Tag Enter tag name for device
— Ifno name is entered, Device n is assigned,
whereby n is a consecutive number

Advanced Options ... Default Template Creates new device using default templates
(Default settings as in — Default setting, when selected the other options are grey
Preferences) — If no template found, creates Resource and Transducer block

Create Resource Block | Create...

Creates resource block

MODE_BLK.TARGET

Adds MODE_BLK_TARGET as selected from drop-down menu
Create Transducer Block |Create....

Creates transducer block

MODE_BLK.TARGET

Adds MODE_BLK.TARGET as selected from drop-down menu

OK - Close dialog and create device
Cancel - Close dialog and do not create device
Help - Open the the corresponding online help page

6.4.14 New Fieldbus

New Fieldbus
Type: EE =
Tag: |
Upstream Port:[ 2 |
Cancel Help
Property/Button Attribute/Subfolder |Function/Action
Type - Indicates the type of Fieldbus (FOUNDATION Fieldbus H1)
Tag - Enter tag name for fieldbus
If no name is entered, Fieldbus_n is assigned,
whereby n is a consecutive number
Upstream Port - Enter fieldbus port number (1, 2, 3 or 4)
OK - Close dialog and create bridge
Cancel - Close dialog and do not create bridge
Help - Open the the corresponding online help page
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6.4.15 New Gateway

New Gateway

Gateway | Advanced Options |

New Gateway

Manufacturer : [Endress+Hauser GmbH |

Device Typs: [5FC173 |

Device Fiev. : |02

| oDRev.: [0 x] cFRev:Jor -]

[V Fallow the Latest DD and CF Revisions ‘

Device |d I
I

Device Tag

[k ]| cancel | Hep

Property/Button

Attribute/Subfolder

Function/Action

Gateway

Manufacturer

Select manufacturer from drop-down menu

Device Type

Select device type from drop-down menu

Device Revision

Follow the Latest DD and CF Revisions
m Ticked: the latest version is shown by default
= Unticked: select the various revisions from the drop-down menus

Device ID

Selected from the drop-down menu after going online
— Can be entered off-line if known

Device Tag

Enter tag name for gateway
— Ifno name is entered, Gateway n is assigned,
whereby n is a consecutive number

Upstream Port

Not used

Advanced Options
(Default settings as in
Preferences)

... Default Template

Creates new gateway using default templates
— Default setting, when selected the other options are grey
— If no template found, creates Resource and Transducer block

Create Resource Block

Create...

Creates resource block

MODE_BLK.TARGET

Adds MODE_BLK.TARGET as selected from drop-down menu

Create Transducer Block

Create....

Creates transducer block

MODE_BLK.TARGET

Adds MODE_BLK.TARGET as selected from drop-down menu

OK

Close dialog and create gateway

Cancel

Close dialog and do not create gateway

Help

Open the the corresponding online help page

6.4.16 New PROFIBUS

New PROFIBUS

Tag

Property/Button Attribute/Subfolder |Function/Action
Tag - Enter tag name for PROFIBUS
— If no name is entered, Profibus_n is assigned,
whereby n is a consecutive number
OK - Close dialog and open Profibus Configurator
Cancel - Close dialog and do not create Profibus
Help - Open the the corresponding online help page
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6.4.17 PROFIBUS Attributes

PROFIBUS Attributes

Configuration File: |rofibus 2 5 oo

Tag

Cancel Help

Property/Button

Attribute/Subfolder

Function/Action

Configuration File

Shows configuration file name

Tag

Enter tag name for PROFIBUS
— If no name is entered, Profibus_n is assigned,
whereby n is a consecutive number

OK

Close dialog and create new Profibus network

Cancel

Close dialog and do not create new Profibus network

Help

Open the the corresponding online help page

6.4.18 Profibus Live List

Profibus Live List
[ profibus ve st Profibusiccop oy 1o x|
Device Tag Device Class Device Address | Device Id Manufacture Id [ Type1d [Dev. Rev. [DDRew. |
PT200 PA Slave 10 {(Dx0A) DeviceldentNr: 1541-Adr:010 Endress + Hauser 0x1541 (Cerabar 5 N.A, M.A.
LTz00 PA Slave 12(0x0C) Deviceldentiri 1522-Adr:012 Endress + Hauser 0x1522 (Micropilot M) N.A H.A
AB_RIO DP Slave: 21(0x15) Deviceldentnr: 05D3-Adr 021 Allen Bradiey 0x503 (1794-APB/B) A, A
CC_DP_02 Gateway 1{0x01) 452B482030E+H-5FC173:76000F24039 452648 (Endress+Hauser GmbH) 2030 (SFC173) o3 05
Property/Button Attribute Function/Action
Device Tag - Measuring point identification
Device Class - Device class as per FF specifications (Basic, Link, Bridge)
Device Address - Device address in decimal and hexadecimal notation
Device ID - Device ID as per FF specification (Manufacturer, Type, Serial No.)
Manufacturer ID - Manufacturer ID as per FF specification
Type ID - Type ID of device, where appropriate with device name
Dev. Rev. - Revision of device
DD Rev. - Revision of device description (DD)
6.4.19 Rename
Rename

Alias parameter tag :

oK I Cancel I Help |

Property/Button

Attribute/Subfolder

Function/Action

Alias parameter tag

Enter the alias name for the selected link label or parameter

Yes

Close dialog and remove link completely from the application

No

Close dialog and hide the link in the Control Module window only
— The link can be shown with "Show Hidden Links"

Cancel

Close the dialog and do not delete the link
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6.4.20 Tag Table

Tag Table
=
New Tag [ OldTag ]
@ Bridge_3 «<Bridge from template>
Bridge_3 RS_1 <Bridge from templats_R
[ Bridge_3_TRDIDSH_1  <Bridge fiom template_T...
O Bridge_3_HC_1 <Bridge from templats_H
[ Bridge_3_DIAG_1 «<Bridge from template_DI...
[ Bridge_3_TEMP_1 <Bridge fram templats_T
Property/Button Attribute/Subfolder  |Function/Action
Tag Table - Shows list of tags for device, bridge or strategy that will be imported
into the project
= To rename:
— Right-click on tag and click on Rename
— Rename tag and press Enter
OK - Close dialog and import template into the project
Help - Open the corresponding online help page
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6.5 PROFIBUS Configurator

PROFIBUS Configurator is invoked when the context menus New Profibus... is called from the
Gateway node in the Project window or Modify PROFIBUS Configuration is called from the
Profibus node in the Profibus window.

PROFIBUS Configurator is used to configure the bus parameters of the PROFIBUS Field Controller
SFC173 as well as the slave addresses and cyclic communication parameters of the PROFIBUS
slaves. The resulting configuration is mapped into function blocks, which can be used to build
control strategies in Application Designer.

The use of PROFIBUS Configurator is described in the Application Designer PROFIBUS Tutorial,
BA036S/04/en. This chapter restricts itself to a brief description of the most important program
dialogs.

6.5.1 Address Table

Address Table
|
o (e e ] ]
+ oames Bech  DPSime i Dovee 2
j
Property/Button Attribute/Subfolder |Function/Action
Address Table Address PROFIBUS DP address assigned to device in project
— A double-click opens the corresponding Slave Configuration
dialog

Slot Slot number of device parameter

Index Index of device parameter

Device Device name (from device description)

Module Cyclic communication data module

Symbol name Symbolic name of module

[ type Type of input data

[ address Address offset of input data module

[ length Length of input data module

O type Type of output data

O address Address offset of output data module

O length Length of output data module
Sort .... Station - Sorts information according to station address
Sort .... Data - Sorts information according to data module address
Address Overview - Calls Address Overview dialog with details of data addresses used in

the input and output process images

OK - Closes dialog
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6.5.2 Bus Parameter

zl

Baud rate

Optirmize

93,75 KBits/s = Cancal |

Bus Parameter

oK

[By User |

Property/Button Attribute/Subfolder | Function/Action
Baudrate - Select DP baudrate from dropdown menu
Optimize Standard Sets standard bus parameters for P+F SK2 power link
By User Allows bus parameters to be set individually
— Required for SK1, Siemens coupler, applcations with Class 2
Master etc.
Edit - Opens Edit Bus Parameters dialog for parameter viewing and editing
OK - Closes dialog and saves changes
Cancel - Closes dialog and discards changes

6.5.3 Device Table

Device Table
|
Addr, | Device [1dent number [ Type [ Deseription <] [aeq
T ConolCae SFCI73 01547 DF Master | Giateway_SFC173 |
3 PROMAG 53 P4 01527 DP Slave Profibus_Device_1

4 ND3000PA

0x0BCA DP Slave Profibus_Device_2

=l
Property/Button Attribute/Subfolder | Function/Action
Device Table Address PROFIBUS DP address assigned to device in project
— A double-click opens the corresponding Slave Configuration or
Master Configuration dialog
Device Device name (from device description)
Ident Number PROFIBUS identity number
— Use this to open the device GSD file in GSD Viewer
Type Role of device on bus (master or slave)
Description Tag assigned to the device in project
OK - Closes dialog
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6.5.4 DP Master Settings

The Master Settings are preconfigured for the Field Controller SFC173 when PROFIBUS
Configurator is invoked from Application Designer.

DP Master Settings
x|

r~ Parameter to user interfar

& Hitomatic release of the communication by the device Lancel

Startup behaviour after system inilialisation
’7 " Controlled release of the communication by the application progran

" User program monitoring

“Watchdog time 1000 me ‘

- Parameter to process data interfac:
Addiessing mode
Lﬁ‘ Byteaddiesses.

o addresses

Starage format (word module) —
% Big Endian (MSE-LSE]
¢ Litfle Endian [LSEHSE]

Handshake of the process data
€ Bus synchionous, deviee centrolled
 Bulfered, device vontrolled
€ Ho consistence, Ursenicled
& Bulfered, host controlled
€ Bus synchionous, host controlled
' Bulfered, evtended host contralied

Hardware parametes
’V 2 kB duliport memor. & BIkE duglportmemon. €0 18 KB duslport memany
Property/Button Attribute/Subfolder | Function/Action

Parameter to user
interface

Start-up behaviour

Sets how communication is started up (use default value)

User program monitoring

Sets Watchdog time (use default value)

Parameter to process |Addressing mode Sets master addressing format

data interface Storage format Sets master storage format
Handshake Sets master handshake format

Hardware Sets master memory type

OK - Closes dialog and saves changes

Cancel -

Closes dialog and discards changes

6.5.5 DPV1 Extended Settings

DPV1 Extended Settings
£

- Additional Slave Function

[~ Auto Clear o I

- Cyelic connection
& o Abort if slave ot responding
€ Abort if slave is not responding

 Process the Autoclear function Lancel

" Ignare the Autoclear function

- Fail Safe Suppor
0 Datais sent in CLEAR mode
£ Mo Datais sent in CLEAR mode

Diagnostic Update Delay  [3

™ DPYT activatedt

= Blave Function:

Iawimum Channel Data Length |74 I awiraurn Alarm POL Length |41

OEC Syl
M e active Alamms 1 Alaim of each type b2

Eviia Alaim Servive Aroess Poir
’7(‘ Waster Alamnacknon=dae SAPE]

& iaster Alamacknowledas S4P50

& Gorfiguiation Dista of EN 50170

Corfiguiation Data conventior
’7(‘ Corfiquration Dats of DFY

= Enabled Alarm

I=| Pull Plug Alarm
I~ Process Alarm
I¥| Diagnostic &l

= | Manufzcturer Alarm
I~ | Status Az
™| Update Al

Property/Button

Attribute/Subfolder

Function/Action

Additional Slave
Functions

Cyclic Connection

Fail Safe Support

Auto Clear

Diagnostic Update
Display

DPV1 Activated

Activates DPV 1 alarming function (not supported by SFC173)
— Check that this box is not ticked

Greyed when DPV1 Activated not ticked

OK

Closes dialog and saves changes

Cancel

Closes dialog and discards changes
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6.5.6 Edit Bus Parameter

PROFIBUS parameters are usually dictated by the coupler or linking device used and are to be found
in the corresponding device instructions. PROFIBUS Configurator is programmed to offer the
standard settings for the Pepperl+Fuchs SK2 power link that are recommended for the set baudrate.
These parameters must be optimized if additional masters, e.g. a Class 2 master such as FieldCare
through Fieldgate FXA720, are to be found on the bus, or another coupler/link is used.

Edit Bus Parameter

£
93.75 kBits/:
Baud rate . its/s ¥ = =
Shot Time 00 8t Terget Rotation Time o
Min. Station Delay of Responders 11 1Bt Target Rotation Time 14.4427 .
Max, Station Delay of Responders B0 Bit GAP Actualization Factor 10
Quiet Time 0 tBit ax Retry Limit 1
Setup Time 1 iBit Highest Station Address 3
Tidl 37 B Pol Tineout 0 ms
Tid2 &0 Bt Data Control Time 1200 ms
e Min Slave Interval 000 ms
& Auto clear mode DFF e ==
" Auto clear made 0N
Property/Button Attribute/Subfolder | Function/Action
Baudrate Select DP baudrate from dropdown menu
— Parameters automatically adjust to corresponding SK2 values
Slot time Use value recommended by Coupler/Link manufacturer

Min. Station Delay

Use value recommended by Coupler/Link manufacturer

Max. Station Delay

Use value recommended by Coupler/Link manufacturer

Quiet Time

Use value recommended by Coupler/Link manufacturer

Setup Time

Use value recommended by Coupler/Link manufacturer

Target Rotation Time

Use value recommended by Coupler/Link manufacturer
— For applications with Class 2 master add 1000 bit times
— The value in milliseconds is shown below

GAP Actualization Use value recommended by Coupler/Link manufacturer

Factor

Max Retry Limit Use value recommended by Coupler/Link manufacturer
Highest Station Enter highest address used by a master (or use default value)
Address — Ensure that masters are assigned the lowest possible addresses
Tid1/Tid2 Displays

Auto Clear Default Off

Poll Timeout

Use value recommended by Coupler/Link manufacturer

Data Control Time

Use value recommended by Coupler/Link manufacturer

Min Slave Interval

Use value recommended by Coupler/Link manufacturer

Watchdog Control Use value recommended by Coupler/Link manufacturer
OK - Closes dialog and saves changes
Cancel - Closes dialog and discards changes
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6.5.7 Group Assignment

Group Assignment

Group Assignment E

Device

PROMAG 53 P
D000,

2

K x|
[Addr.[Gr:F 5 [Gi2F 5 [Gi3F.S [GidF.5 [Gi5F.S [GiEF.S [GrrF S [Grd:S [ B
CEERETE G s e s lorpalaes o] [ g6 (]

LCancel

Property/Button Attribute/Subfolder |Function/Action

Group Assignment Device Lists devices on PROFIBUS DP segment
Address Displays device address
GrN:F, S Click to add device to selected group

— Devices not supporting function cannot be assigned to a group

OK

Closes dialog and saves changes

Cancel

Closes dialog and discards changes

6.5.8 Group Membership

Group Membership 3 x|

ok
Cancel

Group Membership

[Gowi M Feee M oSme
[z W Fees W Sme
[ops W Fees W Sme
[Gowd W Feee W oSme
[Gows W Feee M oSme
[Gows W Feee M oSme
[owz W Fee W Sme
[Gowps W Fees W Sme

Property/Button

Attribute/Subfolder

Function/Action

Group n

Name

Enter Group name

Freeze

Tick if Freeze to be used

Sync

Always used

Group Assignment

Calls Group Assignment dialog

OK

Closes dialog and saves changes

Cancel

Closes dialog and discards changes
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6.5.9 GSD Viewer

GSD Viewer is called from the Tools menu of PROFIBUS Configurator. The GSD files are named
according to their PROFIBUS identifier.

GSD Viewer
Wendar name Endiess + Hauser
Model name: PROMASS 83 PA
Ident number Ox1524
i~ Device Revision:
Revision Prafile 3.0
Hardware Revision A2
Software Revision a2

|

ok

More
_iwer |

Lapout

r~Baudrat

I 96 kBytess
IV 9375 kByte/s
™ 1500 kEyte/s
™ 12000 kByte/s

I~ 19.2KBytess
™ 187.5kBpte/s
™ 3000 kBytess

I 4545 KByte/s
™ 500 kByte/s
™ G000 kByte/s

GSD-Revision

[ESD Revision 4
Property/Button Attribute/Subfolder | Function/Action
General Vendor name General information on manufacturer and device
Model name
Ident No
Device Revision Revision Information on device revision for which the GSD file is valid

Hardware revision
Software revision

Baudrate - Shows baudrates supported by the device. For PA devices:
— 45.45 kB/s means Siemens coupler support
— 03.75 kB/s means P+F SK1 support
— Separate GSD files exist for P+F SK2 support
GSD Revision GSD Revision
More 1/0 data Information on maximum length of I/O data
User parameter data Information on user parameter data
OK Returns to main dialog
Layout Device Bitmaps Shows appearance of device bitmaps in various operational phases
OK Returns to main dialog
Identifier Identification bytes Indicates modules available for data transfer with length and
identifiers
OK Returns to main dialog
OK - Closes viewer

6.5.10 Select Language

Select Language

Fiench —

German e
Property/Button Attribute/Subfolder |Function/Action
Select Language Select language
OK - Closes dialog and saves change

— A message informs you that the change is only effective after the
program has been restarted

Cancel Closes dialog and discards change
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6.5.11 Master Configuration

Master Configuration

x|
BE'S'C:'}“U" Gateway SFC173 2
Snatiu: addess [ 1 i |
Device ControlCare SFC173
{%&I ¥ Auto addiessing ‘
i~ FMS Support
ES Sl | CRL.. |
T
Property/Button Attribute/Subfolder | Function/Action
General Description Enter Tag name (spaces are not allowed)
Station address Enter PROFIBUS DP address (SFC173 default = 1)
Device Device name
DP Support Master Settings Calls Master Settings dialog
Auto addressing When ticked, automatically calculates slave address offsets
FMS Support - Not used for Field Controller SEC173
Actual Master - Press to apply settings to current master
OK - Closes dialog and saves changes
Cancel - Closes dialog and discards changes

6.5.12 Parameter Data

Parameter Data

Parameter Data i x|

Description &l Parameter Data in hex deseription K

Eyle |Desciplion [Value - e

0 1 parameter data byte 000 —

1 |2 parametsr data byte 0<00

2 |3 parametsr data byte 0<00 e
Common
hiodule

Property/Button Attribute/Subfolder |Function/Action

Parameter Data Byte Byte number
Description Description of parameter
Value Value of parameter

— A double-click on the value allows it to be changed

Common - Displays data common to slave device
— Must be configured for remote 1/Os

OK - Closes dialog and saves changes

Cancel - Closes dialog and discards changes
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6.5.13 Parameter Attributes

Parameter Attributes

Parameter Attributes x|

Status types

Profibus data types

Intcgeid
Unsigneds

Parameter Tag

5TA]
M58 BYTE STATUS 1_G0OD

Status valus

“ Bad
" Uncentain

' Good [Non cascade]
 Good [cascade]

Cancel | Hep
Property/Button Attribute/Subfolder | Function/Action
Status types - Select status type for input data
— For input with status, select Standard PA
— For input without status, select an option
Status Value - For status type "Slave without Status" select staus value

Profibus Data Type

Enter the data type as per manufacturer’s instructions

Parameter Tag - Enter a tag for the parameter

OK - Close dialog and saves changes

Cancel - Close dialog and discards changes

Help - Open the corresponding online help page
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6.5.14 PROFIBUS 1/0 Mapping
For further information see Application Designer: Profibus Tutorial, BA0O36S/04/en or press Help.

PROFIBUS 170 Mapping
=l
0 \ - D D D D Dl Ol i | e e 3

4-byte analog with status

32 [ ot values V| obgteenabguinatats (I (IR 63
64 [ paiked Digital values ||| 1:bjte analog with status EEEE ooy 95

9 N ey LI
128l o ot ook wihidt stcris, R NN 159
Paste .
evige/ e adule/Sub-module View
B8 atrbutes,, [ Module3 - Display Value -
C — B @ Frofibus_Device_3
e _PA_AI 2 W Moduket - 1734162
) Profibus_Deviee_1_FA_Al_2 - ) 1-8yte Input
) Proflbus_Deviee_1_FA_A0_1 € Paameter - 0UT_1
2 & Fuofibus_Device_2 2 @ Modue2- 173412
; T} Profibus_Deviee_2_FA_AI_1 B ) 18yte Input
) Proflbus_Deviee_2_FA_Al_2 € Paameter-0UT_3
T Proflbus_Deviee_2_FA_A0_1 2 W Modue3- 1734182
B Profibus_Device_3 - f) 1-Bte Input
B4 Frofibus_Device_3_DP_MAI_1 € Paameter-0UT_D1
! € 0UT_1 - Farameter 2 @ Modues - 1734184
€ 0UT_2-Parameter - f) 1-Bte Input
€ 0UT_3-Farameter € Paameter-0UT_2
£ 43 Frofibus_Deviee_3_DP_MDI_1
€ 0UT_D1 - Farameter =

0K | Cancel Help

110

Property/Button Attribute/Subfolder  |Function/Action
PROFIBUS 170 Telegram Select input node (with "?") to display (empty) telegram bytes
Mapping — PROFIBUS PA devices and some PROFIBUS DP devices are

preconfigured, and the telegram is not displayed

Byte => Analog Values

Select type of output as per manufacturer’s instructions
4-byte analog with status

2-byte analog with status

1-byte analog with status

4-byte analog without status

2-byte analog without status

1-byte analog without status

Node Parameter_OUT _1 is added to the tree

Byte => Digital Values

Select type of output as per manufacturer’s instructions
m Digital with status

m Digital without status

Node Parameter_OUT_D1 is added to the tree

Byte => Packed Digital
Values

Select type of output as per manufacturer’s instructions

m Packed digital with status

m packed digital without status

Nodes Parameter OUT_D1 to OUT_D8 are added to the tree

Byte => Cut

Deletes the selected byte(s) and pastes them to the clipboard

Byte => Copy

Copies the selected byte(s) to the clipboard

Byte => Paste

Pastes the selected byte(s) at the selected position

Byte => Delete

Deletes the selected byte(s)

Byte => Attibutes

Opens the Parameter Attributes dialog for the Parameter node

Byte => Detach/Attach

Detach: Allows the status byte to be dragged to a different position

Attach: Attaches the status byte to the data byte
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PROFIBUS 1/0 Mapping (cont)

i PROFIBUS 1/0 Mapping =1m1]

FT1 {15, PROMAG 50 PA}

evice/Function Blocks Wiew

Module/Sub-module i

= B FC_O1
I PN
-
= Attributes, .
| pelete
Disable:
#Assign to PROFIBUS

Edit IEC ¥ariable Tags...

Changs Hybrid Function Elock Assignment...

;l (=& FT1{15 PROMAG 50 P4} -l
| Moduls2 - SETTOT_TOTAL J

FT2{ 16, PROMAG 50 P4 }

Moduls2 - SETTOT_TOTAL

LT1 {12, Liquiphant M/5 }

- [l Module? - Discrete In

LT2 {13, Liquiphant M/5 }

=l Resactor
@ IN-Totalizsr T2

-8 LT {12, Liquiphant M/5 }
B Reactor

M
L

= B3 1T2117 Lininhant M/S

-
0

€ IN-Totalizsr_FT2 Status
B OUT-Reset_Totalizer_FT2

€ IN-Dry_Run_Protestion_LT1
€ IN-Dry_Run_Protection_LT1_S

- [l Module? - Discrete In

LT3{ 14, Liquiphant M/5 }

- [l Module? - Discrete In

ROI_0T {21, 1794:4P8/8 }

T Module? - 1794-4PB/B Status

- ) 1:word Input

.. @ Parameter1-0UT_D1
@ Parameter_2-0UT_D2

= L@ Paameter 3007 N3 T
BT [

0K | Cancel | Heb |

Property/Button

Attribute/Subfolder

Function/Action

Device/Function Block
View

Pane

Shows Profibus with mapping to function blocks

Attrinbutes

Allows attribures of selected object to be vieewed/changed
= For device node, shows attributes of device
= For parameter node, opens Parameter Attributes dialogue
— Change the status byte (for outputs) and parameter name as
required

Delete

For non-standard mappings, allows a wrongly mapped parameter to
be deleted
— The parameter must then be remapped

Disable/Enable

Allows unused bits in a packed byte to be disabled/enabled

— Right click on the parameter assigned to the bit to be disabled
— Select diabled: the parameter is greyed

— Disabled parameters are not mapped to the function blocks

Assign to PROFIBUS

For a device node with parameters already assigned to a hybrid
block, reassigns the parameters to PROFIBUS

Assign all devices to
Hybrid function block

Opens the Assign to Hybid Block dialog from the controller node

— Select the desired function block displayed and press OK

— To create a new hybrid function blcok enter a name in Ad... field
then press Add HBF

— The [/Os of all devices in the list are assigned to the HFB

Assign device to Hybrid
function block

Opens the Assign to Hybid Block dialog from a device node
— See above: the I/Os of the device are assigned to the HFB

Change Hybrid Function
Block assignment

Opens the Assign to Hybid Block dialog from a device node
— See above: the I/Os of the device are assigned to the HFB

Edit [EC variable tags

Opens up the IEC Variables dialog for a device or controller (all)
— Type or copy and paste the required aliases
— Press OK to quit the dialog and register the changes

Module/Submodule
View

Pane

Shows Profibus with cyclic data configuration

— A question mark means that the module must be manually
configured in the PROFIBUS /0O Mapping space

— When the module is selected an empty telegram appears

Attributes

Allows attribures of selected object to be vieewed/changed
= For device node, shows attributes of device
= For parameter node, opens Parameter Attributes dialogue
— Allows status byte (for outputs) and parameter name to be
configured

Delete

For non-standard mappings, allows a wrongly mapped parameter to
be deleted
— The parameter must then be remapped

Disable/Enable

Allows unused bits in a packed byte to be disabled/enabled

— Right click on the parameter assigned to the bit to be disabled
— Select diabled: the parameter is greyed

— Disabled parameters are not mapped to the function blocks

111



6 Dialogs ControlCare Application Designer: Overview

6.5.15 Project Information

Project Information
|
Design name PROFIBLIS new network [T |
Wersion number 1.000 ot
Company —
Producer
Creation date 02.11.2005
Last altemation by
Last alternation at 02.11.2005
Remark
Property/Button Attribute/Subfolder | Function/Action
Project Information Fill out the appropriate information
OK - Closes dialog and saves changes
Cancel - Closes dialog and discards changes
6.5.16 Path
Path
orectary
GSD Director il
55D File diectory ID'\ADDS\Endlass+Hausel\Enr\tm\Eale\Tnn\s\F‘mflhus J —
Extension [G5-fie ~gvAllles = ot |
’7::,22:?;,:3;.“ [o-\ips\Endress +Hausert ContiaCare' T aols\Profibus J‘
Property/Button Attribute/Subfolder |Function/Action
GSD Directory GSD File Directory Default path for GSD files (set for Application Designer)
Browse to another directory
Extension GSD extension
— Use drop-down menu to filter language version files
Project Directory Project File Directory Default path for Project files (set for Application Designer)
Browse to another directory
OK - Closes dialog and saves changes
Cancel - Closes dialog and discards changes
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6.5.17 Slave Configuration

Slave Configuration

Slave Configuration x|
Devics PROMAG 53 P4 Station addisss |3 K |
Desciiption  [Frafibus_Device_1 Cancel
[¥ Activate devics in actual configurstion
o B nebie e ot o ool GSOfls  EHII527.GSD F arames Coonic

Max length of in-/output data 37 Byle  Lenghhofinfoulputdata 5 Byte DPY1 Settings.

Max_ length of input data 25 Byts  Length of input data R

Ma_ length of oLtput data 12 Byl Length of output data 0 Byte | Station addiess |

Max. nurber of modules 7 Numbes of madules 1 Bateway, SFCIT3

[Module Inputs |Jutputs|In/Out Identifier ot 1/ ControlCare SFC173 -
EMPTY MODULE 0x00

|AT 5 Byte 0x4Z, 0Ox84, -~ Actual slave

roTAL 5 Bye 0z41, 0x04, Station address 3
SETTOT_TOTAL 5 Byte 1 Byte 0xCl, DxE0, Profbus Daviea ]
SETTOT_MODETOT _TOTAL £ Byte Z Byte 0oxzCl, Ox8l

[DISPLAY WALUE

= S 3/ PROMAG 53 P& B
5 Byte 0x82, 0x84, |v

ioftax [Module [syabol [rype[T addr [T ten [rypefo acde o Len | ol W e
0 1 ar Modulel IE 0 5 =

Bemove Module
Insert Module
Predefined Modules

<[ SymbalcNames |

Property/Button Attribute/Subfolder | Function/Action
General Device Displays device name
Station address Enter PROFIBUS DP address of slave
Description Enter Tag name, spaces not allowed (use underscores)
Activate device... When ticked, activates device with current configuration
Enable Watchdog...1 When ticked, enables watchdog
GSD file Displays GSD file name (display contents with GSD Viewer)
Input/Output Data Displays input/output data information
Data Modules Displays data modules available for cyclic communication
Cyclic Data List Append Module Appends selected module to cyclic data list
Remove Module Removes selected module from cyclic data list: click "Module"
Insert Module Inserts selected module above selected list position: click "Module"
Predefined Modules Inserts a predefined modules in the list
— Browse to and select the file in the Open dialog
— Press Open to insert the modules
Symbolic Names Opens input tag editor: not required for ControlCare
Assigned Master - Master to which the slave is assigned

Actual slave

Slave for which the settings apply

Parameter Data

Opens Parameter Data dialog
— Required for Remote /0 only

DPV1 Settings

Opens DPV1 Extended Settings dialog
— Check that box DPV1 Activated is not ticked

OK

Closes dialog and saves changes

Cancel

Closes dialog and discards changes
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6.6 Function blocks

6.6.1 Attach Block

The Attach Block dialog has two used cases:

m Attaches a device function block from the HSE Network, Fieldbus or Profibus window to the
Control Module node in the Process Cell window or

m Attaches a function block from a Control Module node in the Process Cell window to a FB VFD
node in the HSE Network, Fieldbus or Profibus (Gateway only) window: the question mark in
the block disappears and the name changes in accordance with the tag policy.

Blocks can also be attached by drag&drop from one node to the other, or from a device, bridge or
gateway node to the Control Module window and vice versa.

Attach Block
Tag:
I -
K Cancel Help
Property/Button Attribute/Subfolder | Function/Action
Tag - Select the block to be attached from the drop-down menu
OK - Close dialog and attach new block
Cancel - Close dialog without attaching new block
Help - Open the the corresponding online help page
6.6.2 Block Attributes
Block Attributes

Block Attributes

Manufacturer : |Er\dress+Hauser GmbH

Device Typs : |SFC1 E2

Device Rev. . 02 DD Rev. : 02 CF Rev.: [

Block Type |F\D Contral

Profie : [Standard [

Elock Tag:

0K | Cancel | Help

Property/Button Attribute/Subfolder |Function/Action

Manufacturer - Shows manufacturer of device

Device Type - Shows device type

Device Revision - Shows the DD and CF revisions of the device
Block Type - Shows the block type

Profile - Shows the profile (if any) associated with the block
Block Tag - Change the Block Tag

OK - Close the dialog and accept changes

Cancel - Close the dialog and discard changes

Help - Open the the corresponding online help page
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6.6.3 Block Info

Block Info

Manutacturer ‘EndleshHausel GmbH

Dievice Type: [SFCTT3

Device Rlev.: 02 DD Fiev.; [02 CF Fiew.

Black Type - ‘Hesnuma Block

Frofile [Standard oo
Property/Button Attribute/Subfolder | Function/Action
Manufacturer - Shows manufacturer of device
Device Type - Shows device type
Device Revision - Shows the DD and CF revisions of the device
Block Type - Shows the block type
Profile - Shows the profile (if any) associated with the block
Close - Close the dialog
Help - Open the the corresponding online help page

6.6.4 Block List

Right-click the block icon on the Block List dialog to activate the context menu

Block List
=10/
Tag Type ODIndex Profile Prof Rey, DDItemId
Gateway_1_R5_1 Resource Block 1200 0x0108 Ox0001 0x80020310
[ Gateway_1_PBTRD_1 Profibus Transducer 1380 0=8660 0001 0=0002049C
[ Gateway_1_DIAG_1 Diagnastics Transducer 1560 028611 ox0101 0x000201EA
O Gateway_1_HC_1 Hardware Configuration... 17401 0xB615 heninng 0x000202AC
[ Gateway_1_TEMP_1 Temperature Transducer 1920 0x8616 Ox0001 0x0002027E
LD tmass_DP_MAT_1 DF Mulkiple Analog Tnput 2100 OxBE62 Dheninn 0x00020404
T tmass_DP_MAG_L DP Multiple Analeg Output 2280 08863 Ox0001 0x000204DE
Property/Button Attribute/Subfolder | Function/Action
Block List Tag Shows characteristics of the blocks attached to the device, bridge or
Type gateway.
ODIndex — The blocks are executed in the order in the list
Profile — The order can be changed by detaching and reattaching the
Profile Revision blocks
DDlItemID
Assign Tag - For field devices, assign the tag entered in the dialog to the block
— Press OK to confirm the changes
Attributes - Display the block attributes
Characterization - Open the On Line Characterization dialog and displays the online
values of the parameters.
Upload Block - Upload the block for the selected device.
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6.6.5 Customization: <Block>

The Customization <Block> dialog allows the customization of the parameters presented by the
Characterization buttons DEF(ault), TYPE and TAG. These buttons act as filters showing a specific
set of parameters with a particular area of validity:

m DEF is predefined by Application Designer on the basis of the parameters usually required for
characterization and online monitoring for the particular block type, but can be customized,
if required. A change affects all projects opened with this configuration.

m TYPE can be used to define a set of parameters valid for a particular block type. A change affects
the current project only.

m TAG can be used to define a set of parameters valid for the selected block only. A change affects
the current tag only.

Customization: <Block>

Customization: PID Control

Delau\tlType | Teg |

Available Parameters:

Selected Parameters:

Cancel |zl | |

Property/Button

Attribute/Subfolder

Function/Action

Default

Select parameters to be displayed with the DEF button in the Off
Line Characterization and On Line Characterization dialogs

Type

Select parameters to be displayed with the TYPE button in the Off
Line Characterization and On Line Characterization dialogs

Tag

Select parameters to be displayed with the TAG button in the Off
Line Characterization and On Line Characterization dialogs

>>

Move selected parameter(s) from the Avaliable to the Selected
parameter windows

<<

Remove selected parameter(s) from the Selected to the Available
parameter windows

OK

Close the dialog and apply the changes

Cancel

Close the dialog and discard any changes

Apply

Apply the changes

Help

Open the the corresponding online help page
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6.6.6 New Block

New Block
Manufacturer : [Eniess sHaser GmbH I
Device Type:: [T =

Device Rev. ©

Block Type :

[ ] BoRew: [ =] CFRev: [ <]

[tandard [

Profile
Black Tag: |
0K | Cancel | Heb
Property/Button Attribute/Subfolder | Function/Action
Manufacturer - Shows manufacturer of device
Device Type - Shows device type

Device Revision

Shows the DD and CF revisions of the device

Block Type - Select a block type from the drop-down menu
Profile - Shows the profile (if any) associated with the block
Block Tag - Enter tag name for block
— If no tag is entered, the Block is created with its generic tag
according to the settings of the Block Preferences, Chapter 3.1.6
OK - Close dialog and create new block
Cancel - Close dialog without creating new block
Help - Open the the corresponding online help page
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6.6.7 Off Line Characterization

Off Line Characterization

il
R I B = R P N o = e R e e oY s S R

BLOCK_ALM

ConcelEdit | [ EndEdt | geer | Close Help

| Parameter Value Offset_ | Handling Relative Index
MODE_BLK. |- MODE_BLK.
+BLOCK_ERR [ RO BLOCK_ERR
P 7 Pv
Temperature_T100 8 ouT
SIMULATE 9 SIMULATE
*D_SCALE 10 *D_SCALE
OUT_SCALE 1 OUT_SCALE
- CHANNEL 15 R CHANNEL
L _TYPE 16 R L_TYPE

BLOCK_ALM

Property/Button

Attribute/Subfolder

Function/Action

Toolbar

See Chapter 4.3

Off Line
Characterization

Parameter

Displays the parameter

— Click on "+" to expand the parameter tree
— Click on "-" to contract the parameter tree

When the alias function is activated in Preferences, see Chapter 6.2,
a parameter name can be changed as follows:

Select the parameter

Right-click on the parameter name

Enter the alias name

— Press End Edit to register the change

Value

Displays the current parameter value

— Double click on the "Value" space or press Edit to change
— Enter the parameter or select it from the drop-down menu
— Press End Edit or Enter to save the change

Offset

Displays the offset from the parameter address

Handling

Displays parameter type: RO = read-only, RW = read-write

Relative index

Displays the relative index of the parameter when the column is not
hidden

Standard Parameter
Name

Displays the name of the standard parameter when the column is
not hidden

Cancel Edit

Cancel the current edit process

Edit

Open the parameter for editing

End Edit

Confirm the current edit

Clear

Clear the entry from the value space

Close

Close the dialog

Help

Open the the corresponding online help page
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6.6.8 On Line Characterization

In general, MODE_BLK.TARGET must be set to OOS (Out of Service) before a parameter can be
changed online. After the changes, MODE_BLK.TARGET is reset to its original value.

There are exceptions to this rule, however, for specific operational parameters, e.g. the setpoint SP

of a PID block.
On Line Characterization
On Line: FC_01 - Hybrid with Mixed 1/0's - FC_01_HY_MAD [0 1 =] 5
[« [>[o @l le @@ [« =L [5Blals] v =
Parameter [ Walue [ Quaity [Cha. [OK~
ST_REY 1] GoodHon Speciic ]
TaG_DESC Good:Non Specific 2
STRATEGY o Good:Non Specific 3
BLERT_KEY a Good:Mon Specific 4 =
M 5
GE i 1
ACTUAL Auto Good:Non Specific 2
= PERMITTED AutoMan00S Good:Non 5 pecific 3
- NORMAL oos Good:Non Specific 4
BLOCK_ERR <MNonex Good:Mon Specific -]
FI_POINTER a Good:Mon Specific 7
CONTENTS_REY a Good:Non 5 pecific 8
EXEC_TIME_TARGET i} Good:Non Specific ¥ 3
EXEC_TIME_ACTUAL a Good:Non Specific 10
HYB_STATUS_OPTS <MNonex Good:Mon Specific ¥ il
[-EXEC_DETAILS 12 =
4 ol
CancolEd. | Ceer | tkse | Hep |
Property/Button Attribute/Subfolder | Function/Action
Toolbar - See Chapter 4.3
Off Line Parameter Displays the parameter
Characterization — Click on "+" to expand the parameter tree
— Click on "-" to contract the parameter tree
Value Displays the current parameter value
— Double click on the "Value" space or press Edit to change
— Enter the parameter or select it from the drop-down menu
— Press End Edit or Enter to save the change
Quality Displays the quality of the signal, i.e. Good, Bad, Uncertain etc.
Changed A "V" in this column indicates that the value has been changed
Offset Displays the offset from the parameter address
Handling Displays parameter type: RO = read-only, RW = read-write
Relative index Displays the relative index of the parameter when the column is not
hidden
Standard Parameter Displays the name of the standard parameter when the column is
Name not hidden
Cancel Edit - Cancel the current edit process
Edit - Open the parameter for editing
End Edit - Confirm the current edit
Clear - Clear the entry from the value space
Close - Close the dialog
Help - Open the the corresponding online help page
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6.7 Going online

Before the project can be tested online, a number of preconditions must be met:

= All function blocks in the control strategy must be connected and downloaded to a field device
(the strategy can be modified later, in which case the project must be downloaded again)

m All tags must be exported to the OPC Server either automatically through the preferences or
manually through Export Tags

m The PC and Field Controller IP addresses must be set to the same subnet by using HSE Network
Setup and integrated Field Controller Web Server.

Once IP connection has been established via the Field Controller Web-server, see Chapter 6.7.3,
the project developed offline must be aligned with the real installation in the plant.

The project is put online with the Online button

The HSE live list is called

The Device ID of the Field Controller is set in the Bridge or Gateway Attributes dialog

The Device Tag of the bridges and/or gateways is downloaded with Assign Tag/Assign All Tags
The Fieldbus and/or Profibus live list is called

The Device ID of every device is set in the appropriate Device Attributes dialog

The Device Tag of every device is download with Assign Tag/Assign All Tags

For projects containing Hybrid function blocks, a download must be performed from OpenPCS,
see BA038S/04/en, Application Designer: [EC-61131-3 Tutorial.

When these actions have been performed, the offline project can be downloaded to the Field
Controller, and the project starts to run.

6.7.1 Assign All Tags

Assign All Tagss

Tag | Status

@t Bridge_1 Pending

Device_1 ‘Waiting for completion. .

Device_2 Pending

R Gateway_1 Pending...

B Gateway_2 Pending

[ | 6%

E fate) Elapsed Time: 0002
Property/Button Attribute/Subfolder | Function/Action
Assign All Tags Tag List of device tags to be assigned

Status Status of the tag download

Progress bar

Progress of download in %

Elasped Time

Time elapsed since start of download

Abort

Aborts download at next opportunity
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6.7.2 Assign Tag

Assign Tag

New Tag
[Device 3

Property/Button Attribute/Subfolder |Function/Action

Assign Tag New Tag Enter new tag of the device

OK - Close dialog and sstart dsownload

Cancel - Close dialog and discard changes

Help - Open the the corresponding online help page

6.7.3 Assign Tag and Download

Assign Tag and Download

Assign Tag and Download

Elapsed Time : | 00:00

0%

Network:
Device:
WFD:
Obiject

Number.
Address:
Reference:
0D Index:

- Option:

™ | Propagate downstream
I~ Incremzntal downioad

I™ | Gompare parameters

st [[[ Akt ] Hel

Property/Button

Attribute/Subfolder

Function/Action

See 6.7.5, Download

6.7.4 Communication Settings

Communication Settings

Communication Settings

Server d

ok | canca | Hep |

Property/Button Attribute/Subfolder | Function/Action

Server ID - Type in or select server from drop-down menu
OK - Close dialog and save changes

Cancel - Close dialog and discard changes

Help - Open the the corresponding online help page

Endress+Hauser
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6.7.5 Download

The download dialog is generic for all configuration objects, the context being indicated in the
headline, e.g. Download - Fieldbus Networks.

Download - Fieldbus Networks

Download in progress. Please, wait ...

Download

Elapsed Time : | 00:01

[ s
Network: HSE Network 1 Number. 0
Device: CO104 Address: 100

YD
Object

Reference:
0D Index:

- Option:

I~ Ineremzntal downioad

I™ | GCompare parameters

¥ | Propagate downstream

G | st | Hel

Property/Button Attribute/Subfolder  |Function/Action
Download in Progess | Progress Indicates progress of download
Elapsed Time Indicates time that has elapsed since start of download

Information box

General and dynamic information on download

Options

Propagate downstream

For bridge downloads, the download for the bridge is run, and then
propagated to the fieldbus segments located below the bridge in the
topology tree in the Project window.

Incremental download

Compares the project configuration with the plant configuration.
» A message box will appear if there is any discrepancy in the
configuration:
— Click Yes to open the Incremental Download dialog box and
check the differences in the configuration.
— Click No to execute the download without checking the
discrepancy between the configurations.
— Click Cancel to abort the download and return to the project
configuration.

Compare parameters

Compares the parameters in the plant configuration with the
parameters in the project configuration. If the user do not select this
option, any parameters already existing in the device will be
overwritten!

Start - Start download
Abort - Stop download and close dialog
Help - Open the the corresponding online help page
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6.7.6 HSE Network Setup

HSE Network Setup locates all HSE devices connected to the host computer. Before connection, the
Host PC should be given an [P address in the domain to be used for the network (Start => Settings
=> Network Connections etc.). HSE Network Setup can then be started:

Start=>Programs=>Endress+Hauser=>ControlCare=>Tools=>HSE Network Setup.

The tool then scans the network and displays all HSE devices it finds. A click on the Device IP
Address connects to the device and opens the FC Web Server. This can then be used to configure
the desired domain [P address.

Note!

m FieldControllers are shipped from the factory with a default IP address.
SFC162 = 192.168.164.100 and SFC173 = 192.168.164.101.

m [t is possible that HSE Network Setup locates Field Controllers with identical addresses on the
network, but it is not possible to connect to the associated web servers. In this case, the controllers
should be added to the network one at a time.

m [f the Web page cannot be opened, switch off the proxy server in your Internet browser or
unblock the computer’s firewall.

HSE Network Setup Tool
[t netmorksetptonl =
H .|
Endress+Hauser
10.125.35.200 l— People for Process Automation
HSE Device connected to NICIP 10.125.35.200
[DevicelPAddiess  [DeviceTag  Deviceld [ [DeviceAdive |
1012535176 CC_DP_02 452B4R2030E +H-5FC173:76000F 24039 g v
10.125.35.174 CC_OP_M 4528 482030E+H-5FC173: 76001024039 gl
1012535180 1003024030 452B482010E+H-5FC162: 71003024030 gV
Property/Button Attribute/Subfolder | Function/Action
I E Save Saves the current network configuration (active/inactive devices)
I Print Preview Opens web page showing printing template
- |
B About Opens a dialog with details of program version
L
Computer Name Name of host computer
NIC IP Address [P address of host computer
Active NIC m Checked = Active: Device appears in the HSE live list
m Unchecked = Inactive: Device not shown in the HSE live list
HSE Device Device [P address [P address of connected HSE device
Device Tag Tag assigned to the HSE device
— If no tag has been assigned, the factory setting is shown
Device ID Full device identifier as per FF specification
Device Active m Checked = Active: Device appears in the HSE live list
m Unchecked = Inactive: Device not in the HSE live list
(useful when the project comprises subprojects in which only a
particular field controller should be visible)
Context Menu Device IP address Click on Device IP Address or any other field opens FC Web Server
— If FC Web Server does not open check your Internet browser and
firewall settings
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6.8 Field Controller Web Server

The Field Controller Web Server can be used for a number of purposes:

Provision of information on the device
Device setup, including [P address
Information on connected devices

|
|
|
m Diagnosis

The functions offered depend on the type of field controller, see Chapters 6.81 and 6.8.2. Chapter
6.8.3 onwards shows the content of the various pages in alphabetical order.

6.8.1 SFC162 home page

Field Controller SFC162 Web Server

Peagie far Prozess Autormation

ControlCare
Field Controller

Navigation: Electronic Name Plate
& Home Device Tag
-3 Information
- setup Order Code
0 Live List H1
[ Function Black List Serial Number

| Diagnostic
Firmware Yersion

ENP ¥ersion

Operating Mode

Copyright @2010 Endress + Hauser Pro lutions A, &l rights r

Endress+Hauser (=]

Welcome to ControlCare Field Controller SFC162 Webserver (Controller Mode)

Co104

70103455

71003024030

1.05.00

2.00.00

Current Mode Controller Change |

Property/Button Attribute/Subfolder |Function/Action
Home Electronic Name Plate | Shows ENP datta of the current measuring point
Operating Mode Current operating mode
— Possible modes are Controller (default) and Visitor
— To change mode press Change, then restart with appropriate
settings
Information - Shows technical data of the Field Controller
Setup Network Allows the network settings to be configured
— Access via password (User Name: pcps; Password: pcps)
RTC Allows the real time clock to be set

— Access via password (User Name: pcps; Password: pcps)

Firmware Update

Allows a firmware update to be downloaded from a FTP server
— Access via password (User Name: pcps; Password: pcps)
— There is currently no FTP server available for this function

Restart

Restarts the Field Controller
— Access via password (User Name: pcps; Password: pcps)

Live List H1

Lists all devices connected to the controller according to the
selected H1 channel

Function Block List

Lists all function blocks connected to the controller

Diagnosis

Tasks

Lists the tasks currently being performed by the Field Controller
— Access via password (User Name: pcps; Password: pcps)

Heap

Lists the current usage of the various Field Controller memories
— Access via password (User Name: pcps; Password: pcps)

Traceback

Lists all severe failures that have occured since the last firmware
download
— Access via password (User Name: pcps; Password: pcps)

Free CPU Load

Shows the average free CPU resources based on 10 measurements
— Access via password (User Name: pcps; Password: pcps)

Battery

Shows battery status

The following sections show the various pages in alphabetical order.
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6.8.2 SFC173 home page

Field Controller SFC173 Web Server

Mavigation:

SHome
O setup

{0 Diagrostic

2010

ControlCare
Field Controller

Endress-+Hauser

Peogie for Prcass Aseomation

Welcome to ControlCare Field Controller SFC173 Webserver

Electronic Name Plate

Device Tag
[ 1rformation
Drder Code
) Function Block List
Serial Number

Firmware Yersion

ENP Yersion

Endress + Hauser

tions AG. All rights reserved.

SFC173_¥105

70103456

84002224039

1.05.00

2.00.00

Property/Button

Attribute/Subfolder

Function/Action

Home

Electronic Name Plate

Shows ENP datta of the current measuring point

Information

Shows technical data of the Field Controller

Setup

Network

Allows the network settings to be configured
— Access via password (User Name: pcps; Password: pcps)

RTC

Allows the real time clock to be set

Access via password (User Name: pcps; Password: pcps)

Restart

Restarts the Field Controller

Access via password (User Name: pcps; Password: pcps)

Function Block List

Contains the following lists:

Function Block Schedule Overview (macro-cycle)
Function Block Schedule
Function Block List

Diagnosis

Tasks

Lists the tasks currently being performed by the Field Controller
— Access via password (User Name: pcps; Password: pcps)

Heap

Lists the current usage of the various Field Controller memories

Access via password (User Name: pcps; Password: pcps)

Traceback

Lists all severe failures that have occured since the last firmware
download

Access via password (User Name: pcps; Password: pcps)

Free CPU Load

Shows the average free CPU resources based on 10 measurements

Access via password (User Name: pcps; Password: pcps)

Battery

Shows battery status

Communication

Shows various PROFIBUS settings

Bus parameters
Process Image Input
Process Image Output
Profibus Live List
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6.8.3 Device Info: Block list

Block list

Block List

Blocks are listed one per line:

[00] T+FE = 01 TAG =" :
[01] TYPE = 08 TAG =" :
[02] TYPE =18 TAG =" :

Block Schedule
Macrocycle[ms]: 130

Property/Button Attribute/Subfolder |Function/Action
Block List - Lists the current blocks connected to the Field Controller
Block Schedule - Shows the macrocycle time for the current project

6.8.4 Device Info: Live List

Live List

Live List

Devices entries are isted one per ins and organized as follows:

Node Address, Device TAG, Device ID.

MNA, Bridge_1. 4528482010E+H-5FC162:71003024030
018, Device_1 . 452B48100F-63012001080

0x19, Device_2 . 452B48100%-82178401BCC

022, TT101, 452645810CC-82005F04223

0xF3, TAG DEFAULT 138, 4528481007-50Y1146
0xF7, 1203, 452B481057-78061802000

Transducer Information

Live List Revision: &
Macrocycls Execdtions: 0
PDU Sent: 363968

DU Received: 233960

i
Property/Button Attribute/Subfolder | Function/Action
Live List - Lists devices connected to the Field Controller
Transducer - Shows information on the communication between controller and
Information devices

6.8.5 Diagnosis: Free CPU load

Free CPU Load

Free CPU Load

10 measurements and the average are listed below:

01 Measurement = 71 186607
02 Measurement = 71 633954
03 Measurement = 71 478965
04 Measurement = 71 603970
05 Measurement = 71707474
0B Measurement = 71750603
07 Measurement = 70 404587
05 Measurement = 70 553436
04 Measurement = 70 BEEN77

Property/Button

Attribute/Subfolder Function/Action

Free CPU Load

Shows 10 measurements and average free CPU resources in %

Endress+Hauser



ControlCare Application Designer: Overview

6 Dialogs

Endress+Hauser

6.8.6 Diagnosis: Heap

Heap

Heap

Heap entries are listed one per line and organized as Follows:

Mame, Size (kbytes), Start Address, Current Pointer, End Address, Free (%), Never Used.

RTOS Heap, 2048kh, 0x0049E200, 000605200, 0x0069E200, 2%, 29%
Mon Vaolatile Heap, 384kh, 0x020250EC, na 0x020850EC, 99%, na
System Memaory Pool, 1063kk, (x0048C3CC na. 0x005981CC, 41%, na
IEC memary: 12 bytes of 2097152 (0%%) used

Property/Button

Attribute/Subfolder | Function/Action

Heap

Lists the current usage of the various Field Controller memories
— For service purposes only

6.8.7 Diagnosis: Tasks

Tasks

Running tasks

Tasks are listed one per line and organized as fallows:

[Mum] Name, Pointer, Status, Priority Level, Preemption Level, Schedule Counter, Time Slice.

04EDAIS, READY 16, 16, 43116, 1

[2] ApShellChangeMacroln, 0x0048CH38, EVENT_FLAG. 8.6,1.1
[3] H1VerMaintTask, 0xD04BC794, EVENT_FLAG . 6, 8, 4498, 1

[4] APShell Task. 1x0048CA24, SLEEP. 6,8, 11899, 0

[5] O Task, 0xD046CODC, EVENT_FLAG. 6.8, 19,1

[6]LZS Command Task, (x0048CFES, SLEEP. 8, 8, 114999, 1
[71LZS Interpreter Task, 00048008, SEMAPHORE_SUSF, 4.4.1.0
[6]1DS Task, 0x0048CACE, SLEEP. B, 8, 565295, 1

[9] Datalink, 0xD048C380, SLEEP . 5, 5, 291306, 0

[10] Redundlancy. 0x0048COFC, SLEEP, 6, 8, 28599, 1 =

Property/Button

Attribute/Subfolder | Function/Action

Running Tasks

Lists task currently running in the Field Controller
— For development purposes only

6.8.8 Diagnosis: Traceback

Traceback

Traceback

Traceback entries are listed one per line and organized as follows:

[Num] Code, Program Counter, Task ID, Time, Date, Line, File Name.

I 315, Trace

. -2, 0x0025DESC, 010000000, 02:45:38, 13730315, 359, Power ON
. 31, x0024DDFC, 0x0038BE2C, 02:45:38, 19730315, 160, Erased by 02
. 41, 00266224, 0x0038BE2C, 02:45:38 18730315, 945, M.IF Magic F
. 30, 0027501 C, Ix0N38BRE0, 02:47:44, 19730315, 0. RST REQ

. -2, 0xN025DESC, 010000000, 02:47°55, 13730315, 359, Power ON

. -2, 0xN025DESC, 010000000, 16:4358, 13730315, 359, Power ON

. 28, x00250CAC, k004E0ASE, 01:16:39, 19730316, 236, LowLine ISR

. -2, 0x0025DESC, 010000000, 01:17:00, 13730316, 359, Power ON

. 27, 0x001D27FD, 0x0048A368, 01:17:03, 19730316, 3408, lanred.cpp =

Property/Button

Attribute/Subfolder | Function/Action

Traceback

Provides a history of severe failures in the Field Controller
— For service purposes only

6.8.9 Diagnosis: Battery

Traceback
Battery Status

Hardware

status bit: 1 = battery okay and switched on

Property/Button

Attribute/Subfolder | Function/Action

Battery Status

— Indicates status of batter
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6.8.10 Function Block List

Funtion block listt
Function Block Schedule Overview
Macro cycle [ms]: 358
Function Block Schedule Function Block List
Index Block tag 0D index Start time offset Index Block tag
oo SFC173_W105_RS_1 - - o0 SFC173_W105_RS_1
o1 SFC173_¥105_DIAG_1 - - o1 SFC173_¥105_DIAG_1
0z SFC173_Y105_PBTRD_1 - - i3 SFC173_Y105_PBTRD_1
03 SFC173_W105_HC_1 - - i} SFC173_W105_HC_1
04 SFC173_W105_MBCF_1 1920 o 04 SFC173_W105_MBCF_1
05 SFC173_¥10S_HY_EME_IO_1 2100 6 05 SFC173_¥105_HY_EME_1O_1
Property/Button Attribute/Subfolder | Function/Action
Function Block Macrocycle Macrocycle time in milliseconds
Schedule Overview
Function Block Index Block index
Schedule Block tag Block designation
OD index Index in object directory
Start time offset Delay relative to start of macrocycle for execution of block
Function Block List Index Block index
Block tag Block designation

6.8.11 Live List H1 (Channels 0...3)

FOUNDATION fieldbus H1 live listt

Bus Settings

Slot Time Max Response Delay Min Inter PDU Time
10 6 16
Live List

Devices entries are listed one per line and organized as follows:

:“d:f_ Device Tag Device ID Connection Status
- . w

(nglﬁ) TT_102 4528481 0CC-BCO0BFI4223 OK. Field device connected.
(205x19) LT_101 4528451 00F-6A00010108D OK. Field device connected.
(ngm) cv_103 00DEQS2328NDI0000430004230 OK. Field device connected.

Transducer Information
Live List Revision: 4
Macracycle Executions: 2283
FDL Sert: 75766
PDU Received: 771

wirong FCS: 01
Claim LAS: 1
Property/Button Attribute/Subfolder | Function/Action
Bus settings Slot time Time during which the transmitting node retains control of the bus
Max Response Delay No. of seconds may pass without receiving a message from a partner

device before the sender assumes that connection has failed
Min Inter PDU Time Time required for a scheduled communicatioin transaction

Live List Node Address Address of H1 node

Device Tag Measuring point tag of H1 device

Device ID Identifier of H1 device

Connection Status Current status of the fieldbus connection to H1 device
Transducer - Information about the state of communication
Information
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6.8.12 PROFIBUS: Bus parameters

Profibus Live List

Bus parameters

Master Mode Address: 1
Baudrate: 500.0 kBitfs
Slat Time: 200 tBit
Min. Station Delay of Responders (MinTsdr): 11 thit
Mazx. Station Delay of Responders (MaxTsdr): 100 tBit
Quist Tirme: 0 tBit
Setup Time: 1 tBit
Target Rotation Time: 3501 tBit
GAP Actualization Factor: 10
Mas Retry Limit: 1
Highest Station Address: 30

Pall Timeout: 10 ms
Data Control Time: 240 ms
Min Slave Interwal: 25.0 ms

Property/Button Attribute/Subfolder | Function/Action

Bus parameters

Profibus bus parameters set in SFC173 Field Controller

6.8.13 PROFIBUS: Process Image Input

Process Image Input

Process Image Input
First: 16 values of Process Image Input:
000 000 05200 0x00 0x00 000 000 000
000 0x00 000 0x00 000 0:<00 000 0D

Property/Button

Attribute/Subfolder

Function/Action

Process Image Input

Hexadecimal values of first 16 objects input to process image

6.8.14 PROFIBUS: Process Image Output

Process Image Input

Process Image Input

First 16 values of Process Image Input:
0%00 000 000 000 000 000 0x00 0x00
000 0500 0200 000 000 D200 0z00 0x00

Property/Button

Attribute/Subfolder

Function/Action

Process Image Output

Hexadecimal values of first 16 objects output by process image

6.8.15 PROFIBUS: Bus parameters

Profibus Live List

Profibus live list

[Addr] Devid DevTag turer dell DevClass:
[000]: - Nodevice
[001]:  PROFIBUS Master SFC173:Adri001 Endress + Hauser SFCI73 Active PB Master
[002]: - Nodevice
[003]: - Nodevice
[004]: - Nodevice
[005]: - Nodevice
[006]: - MNodevice
[007]: - Nodevice
[008]: - Nodevice
[009]: - Nodevice
[010]: - Nodevice
Property/Button Attribute/Subfolder | Function/Action
Profibus Live List Address Profibus address
Device ID Identifier of PROFIBUS device
Device Tag Measuring point tag of PROFIBUS device

Device Manufacturer

Manufacturer of the PROFIBUS device

Device Model Name

Model name of the PROFIBUS device

Device Class

Role of the PROFIBUS device (master, slave etc.)
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6.8.16 Setup: Network

DHCP:

1P address:
Metmask:
MAC address:

Default gateway:

Network Configuration

Network

™ Enabled

1012535180
265.265.266.0

00:07:05:43:00:C5

10125351
Update

Property/Button Attribute/Subfolder | Function/Action

DHCP - Check if you want the [P address to be automatically assigned by a
DHCP server
— Not recommended for industrial applications

IP Address - For fixed address, enter IP address of Field Controller

Netmask Enter netmask (normally 255.255.255.0

MAC address Read only: MAC address of Field Controller

Default Gateway Enter default gateway (Normally address 1 on domain)

Update Press to update the IP address of the Field Controller
— The Web Server has to be closed and restarted after the update is

complete

6.8.17 Setup: Real Time Clock

Real Time ClockConfiguration

Real Time Clock

Month: |1 Day: 1 vear: (2000
Hours: (1 Minutes: |1 Seconds: |[1
Set RTC to entered valuss Set Set RTC to PC systemtime Set
Current time of RTC
Current time: 05,27,2010; 14:41:03 Refresh
Property/Button Attribute/Subfolder |Function/Action
RTC Date - Enter date in form YYYYMMDD
RTC Time - Enter time in form HH:MM:SS
Set RTC Press to reset the real time clock

6.8.18 Setup: Restart

Firmware restart options

Chonss one restart option and press restart bottom:

Restart

Mo additional options j

Mo additional options
Factory initin controller mode
Factory initin visitor mode (H1 address 0xFC)
Factory initin wisitor mode (H1 address 0xFD)
Factory initin visitor mode (H1 address 0xFE)
Factory initin wisitor mode (H1 address 0xFF)

Property/Button Attribute/Subfolder |Function/Action
Drop-down menu No additional options Field Controller restarts only
Factory Init SFC173 Field Controller performs a factory initialization
Factory Init in Controller |SFC162 Field Controller performs a factory initialization and is
Mode restarted as a controller
Factory Init in Visitor SEC162 Field Controller performs a factory initialization and is
Mode (H1 address OxFC) |restarted as a visitor with the selectted address
Hold Field Controller restarts but remains in Hold
— Do not use unless instructed to do so by our service department
Restart - Press to restart the Field Controller with the selected option
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6.9 Drawing Tool

The Drawing Tool is used to create the strategy in the Control Module window. The dialogs
described here are concerned with the configuration of the workspace and the design of the objects
that can be created therein.

6.9.1 Drawing Properties

The drawing properties configure the Control Module workspace itself.

Drawing Properties

Drawing Properties

General | Colors | Helper Taoks | Background Image |
Logical Uit per Pieel Relationship

¥ Hame ¥ and ¥ Relationship
%[ = unitsequaks|l =] pikeks
v = unitsequaks [T =] pikeks

Taotal Extents

@ InUnits

| 2500 3: units. ¥ | 2500 3: units.
" In Printable Pages

Horz |1 3: pages. Vert |1 3: pages.

R
Property/Button Attribute/Subfolder | Function/Action
General Logical units per pixel Sets/displays scaling of workspace
— Same X and Y relationship: Ticked X scaling = Y scaling
— X: a units = n Pixels: X scaling
— Y: a units = n Pixels: Y scaling
Total extent Sets/displays size of workspace
— In Units: X and Y dimensions in pixels
— In Printed pages: X and Y dimensions in pages
Colors Backgroud Sets/displays thickness of workspace background
Grid Sets/displays color of workspace grid
Helper Tools Grid operation Sets/displays operation of grid

— Show Grid: grid visible when ticked
— Snap to Grip: objects snap to gris when ticked
— Show Page Breaks: page breaks shown in workspace when ticked

Grid spacing

Sets/displays grid spacing in set units

Zoom Factor

Sets/displays the magnification of the workspace view

Background Image

Image properties

Sets/displays the background inmage properties

— Select New Image: causes image to be imported when ticked
— Delete Current Image: causes image to be deleted when ticked
— Uses Transparency: uses transparent background when ticked
— Color: background color when "Uses Transparency" unticked

Size and positioin

Sets/displays the size and position of the image

— Center Image

— Stretch Image to Window Size

— Stretch Window to Image Size

— Place Image At: X units and Y units from top corner of window

Settings above for

Sets/displays the validiy of the background image settings
— Whole drawing: image imported once
— Each printable page: image imported on each page

OK

Close dialog and save changes

Cancel

Close dialog and discard changes

Apply

Save changes, but do not close dialog

Help

Open the the corresponding online help page

Endress+Hauser
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6.9.2 Object Properties
The object properties apply to the objects drawn within the Control Module workspace.

Object Properties

Dbject Properties - Dne Dbject is Selected

General | Line | Fil | TestAtibutes |

Prosition

Size

x|IE =
vfE =

wfidthe 117 3:
Height: |63 3:

o1

Concel | appb | Hep |

Property/Button

Attribute/Subfolder

Function/Action

General

Position

Sets/displays position (X,Y) of the top lefthand corner of the object

— For default setting, 10 units = one dot on the grid

Size

Sets/displays the dimensions (width, height) of the top lefthand
corner of the object
— For default setting, 10 units = one dot on the grid

Line

Thickness

Sets/displays thickness of object outline
— For default setting, 10 units = one dot on the grid

Style

Sets/displays style of object outline
— Solid, Dash, Dot, Dash-Dot, Dash-Dot-Dot

Color

Sets/displays color of object outline

Inherit

Causes the object to inherit the default line properties

Revert

Causes changes made to settings to revert to the last set values
— Works even after Apply has been pressed

Set as Default

Stores the set parameters as default values for new objects

Fill

Fill type

Sets/displays the object fill
— Hollow, Solid, Hatched

Fill style

For a hatched fill, sets/Displays style of hatching

— Horizontal, Vertical, Falling Diagonal (FDIAGONAL),
Rising Diagonal (BDIAGONAL), Square (CROSS),
Diamond (DIAGCROSS)

Fill Color

Sets/Displays color of object fill

Inherit

Causes the object to inherit the default fill properties

Revert

Causes changes made to settings to revert to the last set values
— Works even after Apply has been pressed

Set as Default

Stores the set parameters as default values for new objects

Text Attributes

Text type

Sets/displays the text type
— Full Quality: full black characters
— Fully Resizable: character with default object attributes

Text box style

Sets/displays the text and text box style
— Background: Transparent or Opaque
— Background color

— Font

Fill Color

Sets/displays color of the text box background

Justification

Sets/displays the justification of the text within the box
— Left, Center, Right

Inherit

Causes the object to inherit the default text properties

Revert

Causes changes made to settings to revert to the last set values
— Works even after Apply has been pressed

Set as Default

Stores the set parameters as default values for new objects

OK

Close dialog and save changes

Cancel

Close dialog and discard changes

Apply

Save changes, but do not close dialog

Help

Open the the corresponding online help page
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6.10 Miscellaneous

6.10.1 Consolidate OPC Database

Consolidate OPC Database

|
Carfiguration:
{ Remove ]
Clear All

LClose Help
Property/Button Attribute/Subfolder | Function/Action
Configurations - Lists of projects which are contributing to the OPC database
Add This - Add the tags of the current project to the OPC database

— Answer Yes to the confirm action message
Update This - Update the tags of the current project in OPC database

— Answer Yes to the confirm action message
Remove Remove the tags of the selected project from the OPC database

— Answer Yes to the confirm action message
Clear All Remove all tags from the OPC database

— Answer Yes to the confirm action message
Close - Close dialog and perform consolidation

— Answer Yes to the confirm action message
Help - Open the the corresponding online help page

6.10.2 Create New Data Source

Create New Data Source

Create New Data Source x|

Select a type of data source:

€ User Data Source [Appliss to this machine only]

Selscting System Dats Source creates 5 data source
which is specific ta this machine, and usable by any
user who logs onta this machine

< Back I Mext > I Cancel

Property/Button Attribute/Subfolder | Function/Action
XXXX XXXX Microsoft Windows Wizard to create a new data source.
The controls displayed depend upon the starting point (file or
machine data source)
Back Go back to previous step
Next Go on to next step
Finish Finish application and call data base setup
Cancel Cancel the creation of a new data source
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6.10.3 ControlCare FC Tools

ControlCare FC Tools is a program provided for loading firmware from a host computer to a Field

Controller in a Local Area Network. It is called as follows:

Start=>Programs=>Endress+Hauser=>ControlCare=>Tools=>FC Tools.

Computer firewalls must be configured to allow the use of the program and the proxy servers of

your Internet browser must be switched off. The download is invoked by selecting one or more Field
Controllers of the same type and pressing = After the firmware has been selected in the Select a
Firmware dialog, see Chapter 6.9.5, the program downloads the software and reports back with a

download successful message.

ControlCare FC Tools

ol
Eile Tools Help
2, g
| e | L2
|Currently selected network, card [MICE 10.125.35.200
DawcelPAddressl Device Model | Device Serial HNumber I Firmware Yersion | Firmnware Date | Manitor Yersion | Statug
10.126.35.180 SFC1E2 71003024020 1.03.00.iters 06.04.2007 11:29:36  Mv1.01.02 Run
10.125.35.176 SFCI72 TE000F 24039 1.03.00.iterd 02042007 15:10:40  MY1.01.02 Run
10.125.35.174 SFC173 TEOOT 024039 '1.03.00.iterd 02.04.2007 15:10:40  MV1.01.02 Run
Operation in progress:
[ Endress+Hauser [=-]
Peopie for Process Autemation

=

Property/Button Attribute/Subfolder |Function/Action

File History Opens web page showing history of downloads since tool opened
Exit Closes

Tools Download Starts firmware download procedure for selected device(s)

About About Opens a dialog with details of program version

I Download Starts firmware download procedure for selected device(s)

m Select the firmware in the dialog Select a Firmware
= Press Open to start download

S

Print Preview

Opens web page showing history of downloads since tool opened

2

About

Opens a dialog with details of program version

Computer

NIC IP Address

[P address of host computer

HSE Device

Device IP address

IP address of connected HSE device

Device Model

Commercial ID of device

Device Serial No.

Serial number of device

Firmware Version

Firmware version of the device

Firmware Date

Date and time firmware installed

Monitor Version Version of Field Controller monitor
Status Operating status of Field Controller
Operation in Progress |— Progress bar for firmwarre download
Context Menu Device IP Address Click on Device IP Address to open FC Web Server

— If FC Web Server does not open diable the proxy server in your
Internet browser and/or unblock the computer’s firewall
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6.10.4 Find Tags

Find Tags

Device | Black |

Find Tags

Tag Selection

Tag to Find:
Fieldbus Networks Location:
HSE HOST 1:HSE Network 1
[ ok | concel Lol
Property/Button Attribute/Subfolder |Function/Action
Device Tag Selection Select tag to be found:
m Tag to find: Enter tag name manually
m Tag: Click on required tag
Fieldbus Networks Location within fiedbus network
Location
Block Tag Selection Select tag to be found:
» Tag to find: Enter tag name manually
n Tag: Click on required tag
Fieldbus Networks Location within fieldbus network
Location
Physical Location Shows to which process cell and control module the block is
attached.
OK - Close dialog and find device
Cancel - Close dialog and cancel search
Apply - Not used

6.10.5 Select a Firmware

Select a Firmware

21X
Lookin: [ 5 Hse - «EckE-

File pame [SFC17341.03. 00.ter. abs | Open |

Files of type: [SFC173 firmuare files =] Cancel )
Property/Button Attribute/Subfolder |Function/Action
Look in - Browse to folder in which firmware file is to be found
File name - Enter name of file

= A double-click on the file located in look in fills this property

Files of type - Accept default setting
Open - Imports the selected configuration and starts download
Cancel - Close dialog without downloading selected configuration
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6.10.6 Select Data Source

This dialog appears when the Export Configuration... context menu is selected from the Plant
node of the project window.

Select Data Source

Select Data Source 2lx|

File Dats Sourcs | Machine Dats Sourcs |

Look i | Diata Sources

HIE

{BIMy FF project.dsn
{BIMy Profibus projsct dsn

DSN Name:

Hew...

on your machine.

Select the file data source that describes the diiver that pou wish to connect to,
“fou can use any file data source that refers to an ODBC drives which is installed

0K | Cancel | Help

Property/Button

Attribute/Subfolder

Function/Action

File Data Source

File Data Source

Displays all file DSNs and subdirectories of the directory indicated in
the Look in box. Double-clicking a DSN connects to the data
source.

Look in: Indicates the directory for which the subdirectories and file DSNs
are listed in the window below. Clicking the down arrow alongside
this text box displays the entire directory structure.

Up One Level Replace the directory indicated in the Look in box with the
directory located one level up.

DSN Name Displays the file DSN name, which is either selected in the File Data
Sources list or entered manually

New... Click to add a new file data source.

= In the Create New Data Source dialog box that appears
— Choose the driver for which you are adding a file DSN
— Click Next to specify the name or location of the new file
DSN.
— Click Next again to view a summary of the new information.
— Click Finish to display the driver-specific setup dialog box.
m The program returns to the Select Data Source dialog

Machine Data Source

Machine Data Source

Lists all user and system DSNs, including the name and type of each
DSN. Double-clicking a DSN connects to the data source.

New...

Click to add a new file data source.
m In the Create New Data Source dialog box that appears
— Choose the driver for which you are adding a file DSN
— Click Next to specify the name or location of the new file
DSN.
— Click Next again to view a summary of the new information.
— Click Finish to display the driver-specific setup dialog box.
m The program returns to the Select Data Source dialog

OK

Close the Select Data Source dialog box and connect to the selected
data source. Clicking OK does not accept changes to the Machine or
File Data Sources list. Changes to the list are accepted when you
click OK in the Data Source Setup dialog box.

Cancel

Close the Select Data Source dialog box without connecting to the
file data source and without undoing changes made via other dialog
box controls

Help

Open the the corresponding online help page
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6.11 I/0 Mapping Tool

6.11.1 I/0 Mapping

Local I/0 Tab 1/0 Mapping (Local I/0 tab)
omapang 1ol
Local O | PROFIBUS 1/0: | Modbus Master | Madbus Siave |
Rack/SlotMadule Type Paint: TEC Variable Data Type | Size | Direction |Map ko Madbus Master | Map ko Madbus Slave | =
A0 Gateway_1_Hr_EMB_IO_1_1 REAL 4 |Input [m]
a1 Gateway_1_HY_EME_IO_1_2 REAL 4 |Input ]
a2 Gateway_1_HY_EME_IO_1_3 REAL 4 |Input ]
Gateway_1_HY_EME_IO_1_4 REAL 4 |Input ]
Rack:1 Slot:0 Madule:8-Analag Input e e | T RS o & line o
a5 Gateway_1_HY_EME_IO_1_& REAL 4 |Input ]
26 Gateway_1_HY_EME_IO_1_7 REAL 4 |Input ]
a7 Gateway_1_HY_EME_IO_1_8 REAL 4 |Input ]
40 Gateway_1_HY_EME_IO_1_9 BOOL 1 |Input ]
a1 Gateway_1_HY_EME_I0_1_10 BOOL 1 |Input ]
a2 Gateway_1_HY_EME_I0_1_11 BOOL 1 |Input ]
a3 Gateway_1_HY_EME_I0_1_12 BOOL 1 |Input ]
a4 Gateway_1_HY_EMB_I0_1_13 BOOL 1 |Input ]
) Gateway_1_HY_EME_I0_1_14 BOOL 1 |Input ]
Rack:1 Slot:2 Module: &-DiscIn 4-DiscOut
26 Gateway_1_HY_EME_I0_1_15 BOOL 1 |Input ]
a7 Gateway_1_HY_EME_I0_1_16 BOOL 1 |Input ]
40 Gateway_1_HY_EMB_I0_1_17 BOOL 1 |Oubput O
a1 Gateway_1_HY_EME_I0_1_18 BOOL 1 |Output ]
a2 Gateway_1_HY_EME_I0_1_19 BOOL 1 |Oubput O
43 Gateway_1_HY_EME_I0_1_20 BOOL 1 |Output O
40 Gateway_1_HY_EME_I0_1_21 REAL 4 |Qutput O
R Gy Gateway_1_HY_EME_I0_1_z2 REAL 4 |Qutput ]
’ ) : Az Gakeway_1_HY_EMB_IO_1_23 REAL 4 |Output O
a3 Gateway_1_HY_EME_I0_1_24 REAL 4 |Qutput O
0 [H] =
Export
Property/Button Attribute/Subfolder |Function/Action
Local I/0 Rack/Slot/Module/Type | After configuration in the controller hardware configuration block
(HC), indicates position and type of local I/O module
Point Indicates the connection point of the signal in the local [/O module
[EC Variable Name of the IEC variable:
» To add alias names:
— Left-click to select the parameter
— Overwrite with the alias name
— Editing functions Cut, Copy, Paste, Delete, Undo and
Select All are available by right-clicking on the parameter
name
Data Type Indicates the format in which the signal data are exchanged
Size Indicates the size of the signal data in bytes
Direction Indicates whether the signal is input or output
Map to Modbus Master | Selects which signals are to be mapped to a Modbus master
m To map local [/0O signals to Modbus
— Create and configure a Modbus Configuration block for the
bridge or gateway: the Map to Modbus column will now be
activated
— Either tick the individual signals that are to be mapped or
— Select the column head and right-click to open the contect
menu: activate Select All
— The context menu can also be used to deselect all I/Os
Map to Modbus Slave Selects which signals are to be mapped to a Modbus slave
PROFIBUS tab - Opens the view of the PROFIBUS I/0O mapping
Modbus Master tab - Opens the view of the Modbus master /O mapping
Modbus Slave tab - Opens the view of the Modbus slave I/O mapping
Export - Exports the Local I/O mapping as a .csv file to the project folder
OK - Closes the I/0 Mapping dialog box and registers all changes
Cancel - Closes the I/0O Mapping dialog box and discards all changes
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PROFIBUS I/0 Tab 1/0 Mapping (PROFIBUS 1/0 tab)
/omapang =10l x|
Local 1jo PROFIBUS 1/0r | Madbus Master | Modbus Siave |
FROFIBLS Device Tag | Slave Address Madule Info IEC Wariable Data Type | Size | Direction |Map ko Modbus Master |1ap to Modbus Slavd
El Madulel { AT & - Yalue |FT101_PA_AT 1 _1 REAL 4 |Tnput O
B El Madulel { AT b - Status|FT101_PA_AT_1_1_stake BYTE 1 |Input O
B El Modulez { AT} - Yalue |[FT101_PA_AT 2 1 REAL 4 |Tnput O
B El Madulez { AT } - Status|FT101_PA_AT_2_1_stake BYTE 1 |Input O
:an El Madulef { TOTAL } - We|FT101_PA_TO_1_1 REAL 4 |Tnput O
El Madulef { TOTAL } - 5t|FT101_PA_TO_1_1_state BYTE 1 |Input O
B El Maduled { SETTOT_TO|FT101_PA_TO 2 1 REAL 4 |Tnput O
B El Maduled { SETTOT_TO|FT101_PA_TO_2_1_state BYTE 1 |Input O
B El Madule? { SETTOT_TO|FT101_PA_TO 2 2 BYTE 1 |Output O
4 Madule1 { SP+READEA|CV201_PA_AO_1_1 REAL 4 Output O
B 4 Module1 { SP+READEA|CV201_PA_AO 1_1_state  |BYTE 1 |[Output O
B i Modulel { SP+READBA|CV201_PA_AO_1_2 REAL 4 Input O
:CVZUI 4 Module1 { SP+READEA|CV201_PA_AD 1 2 state  |BYTE 1 |Input O
4 Modulel { SP+READEA|CY201_PA_AOD_1_3 BYTE 1 |Input O
B 4 Modulel { SP+READEA|CV201_PA_AO 1 3 state  |BYTE 1 |Input O
oK Cancel
Property/Button Attribute/Subfolder | Function/Action
PROFIBUS I/0 PROFIBUS Device Tag | After configuration in PROFIBUS Configurator, indicates the
PROFIBUS device tag
Slave address Indicates the slave address configured in PROFIBUS configurator
Module Info Indicates the PROFIBUS slave from which the signal originates
[EC Variable Indicates the name of the IEC variable configured in the PROFIBUS
/0 mapping dialog
Data Type Indicates the format in which the signal data are exchanged
— The data type is determined during the PROFIBUS /O mapping
Size Indicates the size of the signal data in bytes
Direction Indicates whether the signal is input or output
Map to Modbus Master | Selects which signals are to be mapped to a Modbus master
= To map PROFIBUS I/0 signals to Modbus
— Create and configure a Modbus Configuration block for the
bridge or gateway: the Map to Modbus column will now be
activated
— Either tick the individual signals that are to be mapped or
— Select the column head and right-click to open the contect
menu: activate Select All
— The contect menu can also be used to deselect all [/Os
Map to Modbus Slave Selects which signals are to be mapped to a Modbus slave
Local 1/0 tab - Opens the view of the Local I/O mapping
Modbus Master tab - Opens the view of the Modbus master [/O mapping
Modbus Slave tab - Opens the view of the Modbus slave [/O mapping
Export - Exports the profibus I/O mapping as a .csv file to the project folder
OK - Closes the [/0 Mapping dialog box and registers all changes
Cancel - Closes the [/0 Mapping dialog box and discards all changes
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Modbus Master Tab 170 Mapping (Modbus Master tab)
/oMapeing =loix|
Local O | PROFIBUS 1jo  Modbus Master |Mndhus Slave |
Slave Mumber  |Modbus Register| Reqister Typs IEC Wariahle Data Type | Size | Diraction
1 40001 Holding Reqisters | MEM_FT101_PA_AT_1_1 REAL 4 |output
1 400073 Holding Reqisters  |MEM_FT101_PA_AT_1_1_state EVTE 1 |output
1 40004 Holding Reqisters  |MEM_FT101_PA_AT Z_1 REAL 4 |Gutput
1 40006 Holding Reqisters  |MEM_FT101_PA_AT_Z_1_state EVTE 1 |output
1 40007 Holding Reqisters  |MEM_FT101_PA_TO_1 1 REAL 4 |output
1 400015 Holding Reqgisters  |MBM_FT101_PA_TO_1_1_skate EVTE 1 |output
1 40010 Holding Reqisters  |MEM_FT101_PA_TO_2_1 REAL 4 |Gutput
1 40012 Holding Reqgisters  |MEM_FT101_PA_TO_2_1_skate EVTE 1 |output
1 A0001 Tnput Reqisters MEM_FTI01_PA_TO 2 2 EVTE 1 |input
1 30002 Tnput Reqisters MEM_CW201_PA_AG_1_1 REAL 4 |Input
1 40017 Holding Reqisters  |MEM_CY201_PA_AD_1_3_stake EVTE 1 |output
1 40015 Holding Reqisters | MBM_Gateway_1_HY_EME_T0_1_1 REAL 4 |Gutput
1 40020 Holding Reqisters  |MEM_Gatewsy _1_HY_EME_TO_1_2 REAL 4 |Gutput
1 40022 Holding Reqgisters  |MBM_Gatewsy _1_HY_EME_TO_1_3 REAL 4 |Gutput
1 400124 Holding Reqisters  |MEM_Gatewsy _1_HY_EME_TO_1_4 REAL 4 |Gutput
1 40026 Holding Reqisters  |MBM_Gatewsy _1_HY_EME_TO_1_5 REAL 4 |Gutput
Export
Cancel
Property/Button Attribute/Subfolder  |Function/Action
Modbus I/0 Slave Number Selects/indicates the Modbus Slave to which IEC variables will be/
have been mapped
Modbus Register Indicates the Modbus register to which Local I/O or PROFIBUS I/O
signals have been mapped
» To map local I/0O or PROFIBUS 1/0 signals to Modbus
— Proceed as decribed in the previous Local I/O Tab and
PROFIBUS I/0 Tab descriptions
— The registers are automatically assigned
— The registers can be changed to one of a similar type should
this be necessary
» To map other fieldbus signals use the master and slave blocks as
described in the Modbus Tutorial, BAO375/04/en
m More information is to be found in the I/O Mapping Tool
Tutorial, BA032S/04/en
Register Type Indicates the type of Modbus register to which the signal has been
mapped
[EC Variable Indicates the name of the IEC variable configured in the PROFIBUS
/0 mapping dialog or the Local 1/0 tab
— The prefix MB_ is automatically added to the mapped parameter
name
— The names can be changed if required
Data Type Indicates the format in which the signal data are exchanged
— The data type is determined during the PROFIBUS I/0 mapping
Size Indicates the size of the signal data in bytes
Direction Indicates whether the signal is input or output
Local 170 tab - Opens the view of the Local [/O mapping
PROFIBUS tab - Opens the view of the PROFIBUS 1/0 mapping
Modbus Slave tab - Opens the view of the Modbus slave [/O mapping
Export - Exports the Modbus 1/0 mapping as a .csv file to the project folder
OK - Closes the [/0O Mapping dialog box and registers all changes
Cancel - Closes the [/0O Mapping dialog box and discards all changes
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Modbus Slave Tab 1/0 Mapping (Modbus Slave tab)
riomopning R

Endress+Hauser

Local 10 | PROFIEUS 10 | Modbus Master Medbus slave |

Modbus Register

Register Type

IEC ¥ariable

Daka Type | Size

Cails

MES_Gateway_1_HY_EME_IO_1_17

BOOL

Cails

MES_Gateway_1_HY_EME_IO_I_13

BOOL

Q=

Coils

MES_Gateway_1_HY_EME_IO_1_19

BOOL

Coils

MES_Gateway_1_HY_EME_IO_1_20

BOOL

40015

Halding Registers

MES_Gateway_1_HV_EME_IO_1_21

REAL

<0020

Halding Registers

MES_Gateway_1_HY_EME_IO_1_22

REAL

40022

Halding Registers

MES_Gateway_1_HY_EME_IO_1_23

REAL

40024

Halding Registers

MES_Gateway _1_HV_EME_IO_1_24

REAL

40026

Halding Registers

MES_FT101_PA_TO_2_2

EVTE

40027

Halding Registers

MES_CY201_PA_AC_L_1

REAL

40029

Halding Registers

MES_Cwz01_PA_AD_1_1_state

R ra e g e e ey e

EVTE

Export

Property/Button

Attribute/Subfolder

Function/Action

Modbus I/0

Modbus Register

Indicates the Modbus register to which IEC variables have been
mapped
= To map local I/0 or PROFIBUS /0 signals to Modbus
— Proceed as decribed in the previous Local [/O Tab and
PROFIBUS 1/0 Tab descriptions
— The registers are automatically assigned
— The registers can be changed to one of a similar type should
this be necessary
m To map other fieldbus signals use the master and slave blocks as
described in the Modbus Tutorial, BAO37S/04/en
= More information is to be found in the I/O Mapping Tool
Tutorial, BA032S/04/en

Register Type

Indicates the type of Modbus register to which the signal has been
mapped

IEC Variable

Indicates the name of the IEC variable configured in the PROFIBUS

/0 mapping dialog or the Local I/O tab

— The prefix MB_ is automatically added to the mapped parameter
name

— The names can be changed if required

Data Type

Indicates the format in which the signal data are exchanged
— The data type is determined during the PROFIBUS 1/0O mapping

Size

Indicates the size of the signal data in bytes

Local I/0 tab

Opens the view of the Local I/O mapping

PROFIBUS tab

Opens the view of the PROFIBUS 1/0 mapping

Modbus Master tab

Opens the view of the Modbus master [/O mapping

Export

Exports the Modbus [/O mapping as a .csv file to the project folder

OK

Closes the [/0O Mapping dialog box and registers all changes

Cancel

Closes the [/0 Mapping dialog box and discards all changes
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6.11.2 Assign to Hybrid Function Block

Assign to Hybrid Function Block

Assign to Hybrid Function Block i x|

Please select an available hybrid black from the list below and confirmn
the dialog. By canceling this dialog no assignment will be done.

"Add anew hybrid block tag to the existing list

Add Mew HFB

Cancel

Property/Button Attribute/Subfolder | Function/Action
Select Hybrid Block - Displays all available hybrid blocks in the project
— Select the block required and press OK
Add New Hybrid Block |- Allows a new hybrid block to be added to the project
m To add a new hybrid block to a project
— Enter the name of the block in the entry field
— Press the Add New HB button
— Select the block in the upper field
— Press OK to assign the [/Os to the new block
OK - Closes the dialog and assigns the 1/Os to the selected hybrid block
Cancel - Closes the dialog without assigning the 1/Os to the selected hybrid

block

6.11.3 IEC Variables

IEC Variables
[Becvanables x|
Hybrid Block Tag_| Device Info Madule Info TEC Variable a

Reactor FT1 4 15, PROMAG 50 PA - Module2 { SETTOT_TOTAL } - Value - Byke Offset: 0 Totalizer FT1 j
Reactor FT1 4 15, PROMAG 50 PA 1 Module2 { SETTOT_TOTAL } - Status - Byte Offset: 4 Totalizer FT1_Status
Reactor FT1 4 15, PROMAG 50 PA 1 Module2 { SETTOT_TOTAL } - Value - Byke Offset: 0 Resst_Totalizer FT1
Reactor FT2 4 16, PROMAG 50 PA 1 Module2 { SETTOT_TOTAL } - Value - Bybe Offset: 5 Totalizer_FT2
Reactor FT2 4 16, PROMAG 50 PA Module2 { SETTOT_TOTAL } - Status - Byte Offset: @ Totalizer FTZ_Status
Reactor FT2 4 16, PROMAG 50 PA 1 Module2 { SETTOT_TOTAL } - Value - Byte Offset: 1 Resst_Totalizer FTZ
Reactor LT1 { 12, Liquiphant /5 + Moduled { Discrete In » - Yalus - Byte OFfsat: 10 Dry_Run_Proteckion_LT1
Reactor LT1 { 12, Liquiphant /5 + Moduled { Discrete In b - Skatus - Byts OFFsat: 11 Dry_Run_Proteckion_LT1_Status
Reactar LT2 { 13, Liquiphant /5 + Moduled { Discrete In b - Valus - Byte OFfsat: 12 Stirver_Pratection_LT2
Reactor LT2 { 13, Liquiphant /5 + Moduled { Discrete In } - Status - Byts OFFsst: 13 Stirver_Pratection_LT2_Status
Reactor LT3 { 14, Liquiphant /5 + Moduled { Discrete In b - Yalus - Byte OFfsat: 14 Cverspill_Pratection_LT3
Reactor LT3 { 14, Liquiphant /5 - Moduled { Discrete In b - Status - Byts OFFsst: 15 Crverspill_Pratection_LT3_Stakus
Reactor ROL_01 { 21, 1794-AFB(B } Moduled - 1794-APE(E Status - 1-Ward Input - Y¥alue - Byl Parsmeter_1
Relactnr ROI 01 {21, 1794-APEBIE } Modulel - 1794-?PBJ’B Status - 1-Word Input - Walue - Byl Parameter 2 _'j
4 »

Cancel

Property/Button Attribute/Subfolder  |Function/Action
IEC Variables Hybrid Block Tag Indicates the hybrid block to which the [/Os are assigned
Device Info Indicates the tag of the device from which the signal originates
Module Info Indicates the Local [/O module or PROFIBUS slave from which the
signal originates
[EC Variable Name of the IEC variable:
m To change alias names:
— Left-click to select the parameter
— Overwrite with the alias name
— Editing functions Cut, Copy, Paste, Delete, Undo and
Select All are available by right-clicking on the parameter
name
OK - Closes the IEC Variables dialog box and registers all changes
Cancel - Closes the IEC Variables dialog box and discards all changes
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7 Trouble-Shooting

This section contains trouble-shooting tables for the most common operator errors that occur when
using Application Designer and ControlCare Configurator. You should also consult the "ReadMe"
file supplied on the Application Designer PC for other program exceptions which may be due to the
configuration of your computer.

7.1  Opening a project

When a project is opened, ControlCare Application Designer verifies whether the configuration file
was generated by the current version of the program. The following messages/exceptions may

appear:

Message/Exception

Meaning/Action

Project File Format Changed

The user is trying to open a configuration file which was generated by an older

version of ControlCare.

m OK: Pressing OK accepts the upgrade. The configuration is converted to a new
file format and can no longer be opened in the old tool.

m To discard, close without saving.

Project File Format Changed
Unable to open a newer
configuration version.

The user is trying to open a configuration file which was generated by an newer
version of ControlCare.
— There is no version downgrade.

DD Exception
Standard Dictionary Not Found!

The Standard.dct file is missing in the Device Support folder.
m This usually happens when there are problems during the installation of the
system. The software should be re-installed

There are missing DD/ CF files
Would you like to see details or
locate the files?

A block type could not be recognized. Either the CF indicated is not present or, if it

is present, the CF is inconsistent. This message might occur when a configuration is

generated on a source machine and moved to a target machiine that maintains a

different set of DDs and CFs.

m Press Yes to see details of the files

m Press Generate DSM to generate a Missing Device Support file for the source
machine, see Page 16

m Use the DSM to generate the required files on the source machine

m Use the Import Device Support function to import the missing files on the target
machine (also appears as button in missing file overview), se page 16.

Maximum number of Blocks has
been exceeded.
License Violation

The user is trying to open a configuration which has more blocks than the software

license allows.

» Normally happens if the configuration was generated by using a copy of
ControlCare that had a license for more blocks.

m The number of blocks allowed can be checked with the About item in the Help
menu

Unable to open...

Hard key not inserted in host computer
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7.2 Field Controller

Problem

Remedy

1 |HSE Network Setup/FC Tools does not find any
Field Controller

m Disable the Windows firewall (normally a message
appears ask whether you should unbock the program)

m Disable the proxy server for your Internet browser

m Check that you are using the correct Ethernet cables,
see ETH LINK below

m Check that all etehrnet switches are powered up

m Check that the network adapter is on and OK: Execute a
PING command to its own IP, via DOS PROMPT.

m Check if the Ethernet connection is OK: Execute a PING
command to the Field Controller.

2 | Feld Controller appears intermittently in FC Tools

Host and Field Controller are in different subnets.
= Normal behaviour, but for firmware download both host
and Field Controller must be in the same subnet

3 |HSE Network Setup/FC Tools does not show all the
Field Controllers that are in the network

There is probably an IP address conflict in the network.

m Disconnect all the Field Controllers except one from the
from the sub-network

m [f necessary, change its IP address

m Now reconnect the other Field Controllers one after the
other, if necessary changing their [P addresses

4 |Field Controller Web Server does not open

No Ethernet connection
m Disable the Windows firewall
m Disable the proxy server for your Internet browse
» Wrong subnet [P address
Host and Field Controller must be in same subnet
» Wrong subnet mask
Host and Field Controller must have same subnet mask

5 |Firmware begins to execute but after a certain time it
stops

[t might be a configuration problem.

m Use the Factory Init procedure and configure the Field
Controller again.

m [f the problem persists, see the relevant chapter in
Operating Instructions BA035S/04/en, Field Controller,
Commissioning and Configuration

6 |HOLD LED remains lit

If the HOLD LED remains lit after the Field Controller has

been turned on, the firmware may be invalid.

m Update the firmware, see the relevant chapter in
Operating Instructions BA035S/04/en, Field Controller,
Commissioning and Configuration

7 |ETH LNK LED does not light

Check if the cable is connected correctly, or that the cable is

not damaged. Check the specification of the cables:

m SFC 954 - Cable Standard. To be used in a network
between the Field Controller and a Switch/Hub.
(preferred configuration)

m SFC 955 - Crossed Cable (Cross). To be used point to
point between a PC and the Field Controller
(some PCs/laptops may have problems with crossed
cable)

8 |FRC LED is flashing (Force)

Field Controller is in reset mode
= Complete the RESET procedure

9 |ERRLED lit (SFC173)

At least one slave is not delivering cyclic data

— Slave not connected to Profibus

— Slave not switched on

— Slave not correctly configured (PROFIBUS Configurator)
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7.3  Application Designer

Problem

Remedy

1 |Field Controller does not appear in HSE live list

No connection to Field Controller

m See Remedies for Items 1, 2 and 4, Chapter 7.2

m Field Controller is on HOLD, set it to RUN mode

m [P address is not configured correctly, use PING to check

2 |Field Controller appears but always stays grey in HSE
Live List

No connection to Field Controller
m Check that host and Field Controller are in same subnet

3 |Red cross appears on the Field Controller

No communication with Field Controller

m No Ethernet connection with Field Controller,
check connection, IP address etc, see above

= No Device ID set in the Field Controller (Attributes)

4 | Red cross appears on Fieldbus/Profibus

No communication with fieldbus/Profibus

» No communicaton with Field Controller, see above
m Feldbus/Profibus not connected to controller

m DP bus parameter mismatch (Profibus)

5 |Red cross appears on field device

No communication with fieldbus device

No communicaton with Field Controller, see above

No communicaton with fieldbus/Profibus, see above
No Device ID set (Attributes)

Tag not assigned (Assign Tag)

DP address is not unique (Profibus)

DP address at device not the same as that configured in
PROFIBUS configurator (Profibus)

6 | A device does not appear in the live list

Communication error

m The device is not powered up

m The project has been updated but no download has been
made yet

7 | Configuration will not download

You have either a communication problem or the
configuration is not complete
Check that you are on-line - press the On-line button
Check that your computer is in the same address subnet
Check that you have assigned the Field Controller tag
Check that you have exported all tags OPC server
Check that the parameters are in the recommended order
Check that the OPC server is running (look for icon in
bottom line)
» Try "Update" from the Field Controller node (SFC162
only, takes several minutes) and download again

8 |PROFIBUS configuration will not download

You have either a communication problem or the
configuration is not complete
m Try downloading from HSE Network node, see above, if
this does not work, check points below
m Configuration mismatch between PROFIBUS Configurator
and Application Designer
— Have PROFIBUS device blocks been deleted?
— If so, reconfigure project in PROFIBUS Configurator

9 |Parameter appears red in the on-line control strategy

The parameter has a bad status

m Check that the Block Mode is Auto (or Cas)

m Check that the block has been correctly configured

m Check that the device is still live (live list)

m Check that the device address is the same as that you
have in your configuration (live list)

m Check that the parameter has been correctly configured

m Check that the tags were exported (Export Tags)

10 | FB links do not work

Project not downloaded correctly, e.g. partial download
when bridge has HSE links
m Repeat full download from the HSE Network node

11 | The parameters in a open offline characterization
window do not change after an upload with chan ged
parameters

Normal behaviour
m Close the window and open it again
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7.4  PROFIBUS Configurator

Problem/Question

Remedy

1 |Error message on trying to leave the configuration
dialog

Configuration not correct
= Device name has spaces instead of underscores

2 |How are the cyclic [/O data configured?

m For Endress+Hauser devices each parameter has a fixed
position in the configuration list, see the manuals. If you
want to see Parameters 1 and 5 only, for example, free
spaces/empty modules must be appended at slots 2, 3 and
4.

m For other devices, see operators instructions

3 | What baudrates are supported?

The SFC173 Field Controller supports all baudrates with the
exception of 31.25 kBit

4 | What baudrate should I use?

Only baudrates supported by all devices can be used:

m For a P+F SK1 coupler = 93.75kbit/s

m For a Siemens coupler = 45.45 kbit/s

m For a P+F or Siemens link, check what baudrates are
supported by all DP devices

5 |Where do [ set the device baudrates?

Only PROFIBUS DP devices must be set

= Most PROFIBUS DP slaves sense the baudrate and do not
need to be set up

m For others, check the manufacturer’s instructions

6 | What bus parameters should I use?

Use the parameters recommended by the coupler/link

manufacturer or those in this manual

m For the P+F SK2, the parameters are automatically set
according to the rate selected in the Configurator

m For the P+F SK1 use the ones in the PROFIBUS tutorial
BA036S/04/en

7 |Can I go on-line in PROFIBUS Configurator?

Yes.
m Select the appropriate menu, enter the IP address of the
Field Controller and generate a live list
Beware of timeout: if there is no activity after 2 min:
— Select Settings => Device Assignment...
— Driver Select (if TCP/IP driver)
— Select requested IP address
— Press OK

8 |Can I change a bus address in the PROFIBUS
configurator?

Yes.

® You can go online and change a bus address by selecting
the device followed by the the appropriate menu and
typing in the old, then the new address

m The device must support software address setting

m Software address setting must be enabled

m The address must be unique to the bus

9 | A device does not appear in the live list

Communication error

m Another device has the same address

m The device is not powered up

= Device does not support autosense of baudrate
— Set correct baudrate
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